COMPUTERS VOIP

stfvar]es SPA303 3-Line IP Phone with
CISCO Dual Switched Ethernet Ports
» 3-Line IP Phone with Display

» Dual Switched Ethernet Ports

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Supports SIP/SPCP with Cisco 500 Series

(CISPA30361)

$89.95

T MT505 Spider USB
EN and SIP/IP Telephone

» Supports Audio & Video Conferencing
» 4 Microphone Beamforming Array
» Full Duplex

» USB & SIP/IP Bridging

» LED Lit Control Buttons

» Daisy Chainable up to 14 Units

PHMTH05

$764.95

UVP uniFi VolIP Phone

» 5" Full Color, Multi-Touch Display

» Powered by Android

» 1.2 GHz Dual-Core Cortex A9 Processor

» 4GB Storage / 1 6B RAM

» UniFi Phone App Communication Software
» Auto-Provisioning Management Feature

(UBUVP)

148.95

(J  UniFiEnterprise VolIP Phone

» 7" High-Definition, Multi-Touch Display
» Powered by Android

» Bluetooth Support

» Built-in 1.0MP Camera
» Wi-Fi Capability

» 1.2 GHz Dual-Core Cortex A9 Processor
(UBUVPEXE)

$399.00

stfver]ee SPAS04G 4-Line IP Phone with
CISCO 2-Port Switch PoE & LCD Display
» k-Line Business Class IP Phone with PoE
» Features 2-Port & LCD Display

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Great Voice Clarity by Wideband Audio

(CISPABD4G)

$129.95

T MT304 Quattro3 usB conference
EN Speakerphone (Silver)
» Full-Duplex Conferencing
» USB Port for VOIP, Skype, Microsoft Lync =
» Four Microphone Beam Array ( S
» Excellent Noise Suppression . i
» De-Reverb & Automatic Gain Control 2
» Daisy-Chainable Powering
$539.96

PHMT30403, PHMT304BLK (BLACK)

Jabra Speak510+ Bluetooth & USB
Speakerphone (Microsoft Lync Compatible)
» Unified Communications Compatible
» Supports up to 8 Trusted Devices

» Bluetooth Class 1 &2 Compatible

» Bluetooth AZDP Support

(JAS10BTUSPMS) 179.95

FLXUC500

revo USB Conference Phone

» Built-In Tweeter and Mid-Woofer Speakers
» Integrated Echo Cancellation

» Full Duplex Technology

» For Conference Rooms and Small Offices
» For Meetings and Online Collaboration

» Extended Response For Foreign Languages

(RETOFLXUC500)

Call or Log-on

stfver]es SPAS08G 8-Line IP Phone with
CISCO 2-Port Switch PoE and LCD Display
» 8-Line Business Class IP Phone with PoE
» Features 2-Port & LCD Display

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning

» Great Voice Clarity by Wideband Audio

(CISPA5086)

$155.95

7 Duet Executive Desktop Speaker-
EN phone for VoIP and Telephone

» Compact and Discrete
‘ i ’

» Integrated Mic and Speaker
» Echo Cancellation and
Noise Suppression  USB Connection
» 3.omm Speaker Output
» RJ-11 Jack for Phone and Bridging
Call or Log-on

PHMT202EXE

Jabra Speak 410MS Speakerphone

» Portable and Compact Design

» Jabra PC Suite Digital Signal Processing
» Omni Directional/Noise Filter Microphone
» Standard (E-STD) Microphone Sensitivity
» LED and Audio Indicators

» Certified by Microsoft

(JA4100CSPM) $89.95

/] SENNHEISER SP20ML

USB Speakerphone with Microsoft Lync
» Compact, Portable, and Discrete Design .
» Dual Talk Feature

» Intuitive User Interface

» Talk Time up to 20 Hours

» Visual LED Battery Status

» Sound-Enhancement Profile

(SE506050)

$130.95

(o- H3%0
Logitech Headset

» USB Interface
» Noise-Cancelling Microphone

» Padded Headband and -
Plush Earpads ~
» In-Line Volume and
Mute Controls
(Loccu) $25.26

plantronics CT14 DECT 6.0
Cordless Headset Phone
» DECT 6.0 for Interference
Free Wireless
» Up to 10 Hours of Talk Time
» Hands-Free Convenience
» Up to 300 ft. Range from
Charge Base

[PLCT14RHS) $91.07
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VXi BlueParrott B350-XT Noise-

Canceling Bluetooth Headset

» Flexible Boom Microphone
» Cuts 96% of Background 1
Noise Bluetooth 4.0 with
Multipoint Technology
» NFC One-Tap Pairing
» Wideband Audio and 128-Bit Encryption

(VX203475)....oo ... Call or Log-on

plantronics SaviW740
Multi Device Wireless Headset

» Manages PC, Mobile & Desk Phone Calls .
» Headset to Mabile Phone Audio Transfer
Hands-free Operation
to 350 ft (100 m)
» Three Customizable
Wearing Styles

(PLW740) $219.99

VXiB250-XT+ BlueParrott
B250-XT+ Headset

» Noise Cancellation with
95% Noise Cut
» Wideband Audio
» 20+ Hours Talk Time
» Up to 150 Hours Standby Time
» Audio Streaming via Bluetooth Devices

(VX203100)........ Call or Log-on

plantronics SaviW720
Multi-Device Wireless Headset

» Qver-the-Head (Binaural)
» 350" Wireless Range
» Up to 9 Hours Talk Time
» SoundGuard DIGITAL
» One-Touch Call Controls

(PLW720) $235.00

Micresoft LifeChat LX-3000
Digital USB 2.0 Connectivity

» Binaural Headset with
Stereo Audio

» Noise-Cancelling
Boom Microphone

» Comfortable Leatherette
Padded Ear Cups

(MILCLX3000) ..o $24.95

plantronics M214C
Phone Headset

» Stable Adjustable Headband
» Over the Head Design
» Single Earpiece
» Easy Hands-Free
Conversation Noise-Canceling Microphone
» In-Line Volume Control

(PLHSCMP) $14.95

800-947-5534 + 212-444-6740




GAMING CONSOLES AND ACCESSORIES

L erra
SONY PlayStation 4

Gaming Console

Sony PlayStation 4 Gaming Console ushers in an era of next generation gaming. Providing dynamic and
connected gaming, powerful performance, high definition graphics, deeply integrated social capabili-
ties, and innovative second-screen features, the PlayStation 4 allows you to game as you see fit. With
immersive game play, access to your favorite digital entertainment apps, and PlayStation exclusives,
the PlayStation 4 centers around you, the gamer. Play when, where, and how you want.

» AMD Radeon Graphics Core Next Engine » 86B of GODRb RAM

» AMD Jaguar Eight-Core Processor » 10/100/1000 Mbps Gigabit Ethernet

» 802.11b/g/n Wi-Fi, Bluetooth 2.1+EDR » Blu-Ray Disc Player » Play as You Download
» DualShack 4 Wireless Controller » Remote Play with PlayStation Vita » PlayStation Plus Membership Support

PS4 Console only (SOPS46C) $399.99
PS4 kit w/ PS4 Camera (SOPS4GCCAK) $442.95
PS4 kit w/ PS4 Camera, Headset, Charging station (SOPSA6CPSACK) . 544,95
SONY PlayStation 4 NYKO PS4

Camera Intercooler
_ —

» Broadcast Support I

» 3D Depth-Sensing Technology » Power Pass-Through Technology

» Login & Navigate » Pushes Hot Air Away from Console

» Voice Commands & Face Recognition
» Realistic Gaming Experience

» Matches the PlayStation 4
» User-Friendly, Clip-On Installation
» Sony PlayStation 4 Compatible

[SOPSAC) . 94496 (NYINPSAB) . 919,10

NYKO DataBank
for PS4

NYKO TypePad

) ﬁ

» QWERTY Keyboard
» Bluetooth Connectivity

» Fitsa 3.5” Hard Drive
» LED Indicators

» Includes Screwdriver » Attaches to the DualShock 4 Controller

» Sony PlayStation 4 Compatible » Sony PlayStation 4 Compatible

(NYPSADB) o $34.95 (NYFOKBDSA) o $34.99
CIEo%aa DualShock 4 NYIKO Power Pak

Charging Station for PS4 DualShock 4 Controller

v

» 1000 mAh Rechargeable Battery

» Rechargeable via micro-USB Cable

» Fits the DualShock 4 Controller

» Works with the Internal Battery

» Sony PlayStation 4 Compatible

(NYPPPSADSAC) oo $13.99

» Charges 2 DualShock 4 Controllers
» Sony PlayStation 4 Compatible
(POPSACS) o $20.99

www.BandH.com

COMPUTERS

S ONY DualShock 4

Wireless Controller

» Share Button, PS Button

» Built-in Mono Speaker

» Light Bar, Vibration Support

» Six-Axis Motion Sensor System
» Built-in Rechargeable Battery
» Clickable 2-Point Capacitive Touch Pad ' o ‘
» Dual Analog Sticks, D-Pad, Game Buttons

» Micro USB Port, Stereo Headset Jack ‘
» Bluetooth 2.1+EDR Wireless Connectivity

» Compatible with PlayStation 4

» Available in Multiple Colors

(S010037) $59.99

THRUSTMASTER"® T300RS
Racing Wheel

» Fully Adjustable Metal Pedals

» Detachable Racing Wheel -

» 1080° Force Feedback 4

» Thrustmaster Quick
Release System

» Robust & Versatile
Attachment System

» Features Official PlayStation 4 Buttons

» Auto Recognition for Sony PlayStation 4

» Also Compatible with PC & Sony PS3

[THT300RSRW). ..o 39900

THRUSTMASTER"® T80
Racing Wheel -

» Central Clamping System
» Officially Licensed by PlayStation
» Wheel and Pedal Set » Rubber Texture Grip

» Two Sequential Gear Shift Paddles » 11 Action Buttons + D-Pad
» Adjustable Inclination Angle for Pedals

» Brake Pedal Has Progressive Resistance

» For PlayStation 3 / 4 Racing Games

(THTBORW).. . $88.99

To view a full listing
of all gaming accessories

or visit our website
BandH.com/w1545
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COMPUTERS

Microsoft Xhox One

Gaming Console

One Gaming Console from Microsoft delivers a next-gen experience in bath gaming and multimedia.
With high-res graphics and fast performance, the Xbox One allows you to game on your own terms.

You can snap two windows together on the same screen so you can watch TV while you play your game.
Xbox Live allows you to test your skills against other players around the world. Xbox SmartGlass allows
you to connect your smartphone or tablet to your Xbox One for intuitive access and control.

GAMING CONSOLES AND ACCESSORIES

2% XBOXONE

» AMD Radeon Graphics Core Next Engine » Custom 8-Core x86 AMD Processor » 86B of RAM + 32MB of ESRAM » 10/100/1000 Mbps Gigabit Ethernet
» 802.11n Wi-Fi » Blu-ray Optical Drive » Xbox SmartGlass Support » Xbox One Wireless Controller Included » Xbox Live Gold Subscription Support

..§349.95
..$399.00

Xbox One Console only (MIXBONE)....
FIFA 16 Bundle (MIXB11TBF168).........

Limited Edition Halo 5: Guardians Bundle (MIXB1TBCGB) .........ooos oo
Ultimate Gaming Kit Includes Headsets, Cooler, Minecraft and Forza Motorsport 5 (SOPSAGCPSACK) ..o

Microsoft Xhox One Wireless Controller
2015 Version

» Built-in Stereo Headset Jack

» Refined Bumpers

» Wireless Firmware
Updates

» 18" Wireless Range

» Xbox One/Windows 7, 8,
and 10 Compatible

[MILWLCKBOBK)......occs

.$57.75

Arcade FightStick

weewe Tournament Edition 2 for Xbox One

» Arcade-Quality Sanwa Denshi Parts
» 8-Button Vewlix-Style Layout
» Sanwa 0BSF-30 Action Buttons
» Allow Access ta Inner
Storage/Components
» Removable Bezel
& Clear Top Panel
» Lock/Unlock Button
» Non-Slip Foam Padding

[MAAFSXBOX1) .. 9199.99

Microsoft Arcade FightStick

Tournament Edition 2 for Xbox One

» Dance Central Spotlight Digital Download
» Microsoft Xbox One Compatible

[MIBLBOOOOT) . 9137.93

NFL 16 Bundle (MIXBTMNFL16) $399.00
Forza Motorsport 6 Bundle (MIXBIFOLETTB) .........occcvercn $399.00
1$499.00
$544.95

Microsoft Xbox One Special Edition

Covert Forces Wireless Controller

» Impulse Triggers

» 3.5mm Headphone Jack

» Up to a 30-Foot
Wireless Range

» Infrared LEDs for
Kinect Support

» Microsoft Xbox One
Compatible

(MIBAKOD0O) -

e S5T.49

Razer Atrox Arcade Stick
Gaming Controller for Xbox One

» 1 x Precision 8-Way Joystick
» Internal Storage Compartments
» Fully Mod Capable Construction
» Additional Bat Top Included
» For Use with Xbox One
Gaming Console
» Premium Quality Sanwa Components
» § x Tournament-Grade Sanwa Buttons
» One-Touch Access to Internals & Storage
» 13" Detachable Screw-Lock USB Cable

(RARASKBONE) ... $189.95

NYIKO Intercooler

for Xbox One

» Matches the Xbox One
» Allows Access to AUl Ports

» Pushes Hot Air Away from Console

» USB Powered (Turns on with Console)
» Microsoft Xbox One Compatible

(NYICXBOXONEB) ... 922,80

Microsoft Xhox One Wireless Controller
With Play & Charge Kit

» Up to a 30-Foot Wireless Range

» Proprietary Expansion Port

» Included Charging Cable

» Rechargeable Battery Pack

» Up to 30 Hours Per Charge

» Infrared LEDs for Kinect
Support

» Play & Charge at the Same Time

» Compatible with Xbox One

[MIXBONEWCPCK]......occcc

. §99.45

THRUSTMASTER" TX Racing Wheel
Ferrari 458 Italia Edition

» Detachable Wheel with Driving Controls

» Ferrari-Style Pedal Set

» Force
Feedback
Base

» Dual-Belt
Mechanism

» USB Connector

» Central Clamping System

» Xbox One and PC Compatible

» Hall Effect AccuRate Technology

[THTXRW

—......Call or Log-on

THRUSTMASTER' Racing Wheel
Ferrari 458 Spider Edition

» For Xbox One

» Wheel and Pedal Set
» Metal Paddle Shifters
» Adjustable Sensitivity
» Kinect Detection LED
» Central Clamping System
» Two Red Rubber-Textured Grips

» Officially Licensed by Ferrari/Xbox One

(THSRW) oo Call or Log-on

Pro Racing Force Feedback Wheel & Pedals

weewe for Xbox One

» Aluminum Steering Wheel
» Force Feedback

» Removable Cowling

» Includes Lap Rests

» Solid Aluminum Paddles
» Adjustable Wheel Rake Angle

» Anti-Slip Bracket on Gas Pedal

» Retractable Non-Slip Carpet Gripper

» Non-Contact Position Sensing Technology
» Versatile Mounting Options

[MAFFBIWXBOJ ...occcc

- $338.99

800-947-5534 - 212-444-6740




3DS XL

Handheld Gaming System

Achieve total immersion with dual large screens and 3D graphics with the black 2015 version of
the 3DS XL Handheld Gaming System from Nintendo. The Nintendo 30S is compatible with all
3DS and eShop games, as well as most DS and DSi games. Also, certain future releases will only
be available on this Nintendo 3DS XL 2015 model. Designed for the family, the Nintendo 3DS XL
has a 3D depth slider, a 3D camera, face-tracking 3D capabilities, StreetPass, SpotPass, wireless

connectivity, and even access to the Miiverse online community.

» Face-Tracking 3D » Compatible with Most DS Games » Access to the Nintendo eShop
» 488" Top 3D Widescreen LCD Display » 4.18” Bottom LCD Touchscreen

GAMING CONSOLES AND ACCESSORIES

» MicroSDHC Media Card Slot » Built-in amiibo Support » C-Stick, ZL & ZR Buttons
» Includes Stylus & 4GB SDHC Card » Wireless Connectivity for Multiplayer

3DS XL Handheld Gaming System (NIREDSVAAA)

$196.99

Red Version (NIREDSRAAA)

$199.99

Q Gamebang Redstone
3 Minecraft Wearable

» Take Your Worlds with You
» PixelFurnace App Included
» Preloaded with Minecraft Maps
» Minecraft Demo Included
» PC/Mac/Linux Compatible
» Play Minecraft from
Any Computer
» Back Up Worlds to
Gameband's Cloud

$79.99
$§79.99

Large (GAMCO801L)
Small (GAMC0801S)

THRUSTMASTER® TH8A
Add-On Shifter

» H-Pattern or Sequen-
tial Shift-Plates

» Hall Effect AccuRate
Technology

» Metal Gear Stick and
Construction

» 360° Adjustable
Clamping System

» PC/PS3/PSk [ Xbox
One Compatible

(THTHBAAOGBSH) $148.99

€<- Logitech 627

Racing Wheel

» Six-Speed Shifter

» 900° Wheel
Rotation

» RPM LED Indicators

» 16 Programmable
Buttons

» Dual-Motor Force Feedback

» Gas, Brake, and Clutch Pedals

» Compatible with PlayStation 2 &3

» Also Compatible with Windows PCs

(L0G276C) $249.95

THRUSTMASTER® T3PA-PRO
Add-On Gaming Pedal Set

» Suspended Position (6T Style)

» Floor-Mounted Position (F1 Style)

» Concial Rubber Brake Mod
Included

» Pedals with Individual
Pressure Settings

» All-Metal Pedals

» Fully Adjustable Pedals

» Spring Brake Mod Included

» Supports T-Series Racing Wheels

» Compatible with PC, Xbox One, PS3, PS4

(THT3PAPRO)

$149.99

COMPUTERS

- MARIO KART 8

DELUXE SET FOR Wii U

Mario Kart 8 (NIWUPSKAGP)

$299.99

THRUSTMASTER® T.16000M
Joystick

» 16 Buttons & 4 Axes (Fully Programmable)
» Fully Ambidextrous Joystick
» 3 Adjustable Components

» 3D Magnetic Sensors

» Multidirectional Hat Switch
» Weighted Base

» Wide Hand Rest

» Plug & Play

» PC Compatible

» Hall Effect Accurate Technology (HEART)

(THTFS) $43.99

THRUSTMASTER"® T300RS
Racing Wheel

» 1080° Force Feedback

» Detachable Racing
Wheel

» Fully Adjustable
Metal Pedals

» Thrustmaster Quick
Release System

» Robust & Versatile Attachment System

» Features Official PlayStation 4 Buttons

» Auto Recognition for Sony PlayStation 4

» Also Compatible with PC & Sony PS3

(THT300RSRW)

Call or Log-on

B&H carries a wide assortment of con-
sole and PC games, compatible with
Sony, Xbox, Nintendo and Windows based
titles for every serious gamer. Games in-
cluding Minecraft, MLB 15, Madden NFL,
Guitar Hero, FIFA 16, NBA 2K16, PGA Tour,
Dragonbakk Xenoverse, Need for Speed,
Star Wars Battlefront, Duck Dynasty and
many more. Check out the B&H Gaming
page for the latest available titles.

J’, —_A. B XBOXONE (Nintendo) [

Toviewa
full listing
of all games

SCAN THIS CODE

or visit our website
BandH.com/w1547

www.BandH.com




COMPUTERS IPADS & ACCESSORIES
@ Authorized Reseller |Pad Pro I.
The iPad Pra from Apple now has an expansive 12.9” Retina
display, double the CPU power of the iPad Air 2, improved Multi-
Touch technology and access to over 850,000 apps. With up to 5.6

million pixels, the iPad Pro makes it easier to work in professional
environments including editing 4k video.

» 12.9" Retina Display with 2732 x 2048 Native Resolution

» Fingerprint identity sensor built into the Home button

» Apple A9X CPU with 64-bit architecture-2.5x faster than iPad Air
» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2

» Touch ID Fingerprint Reader » iSight Camera with 8MP photos
» Video Recording with Slo-mo, stabilization & time lapse

» i0S 8 and iCloud » Front 1.2-Megapixel FaceTime HD Camera
» Rear 5-Megapixel iSight Camera

@& Authorized Reseller Pad Mini 4 ( . )
The iPad mini 4 from Apple is just 6.Tmm thin and weighs less than 1 |
pound. Its smaller form factor makes it easier to hold in one hand. This
iPad mini 4 comes in a space gray, silver and gold finishes. The tablet's
7.9" Retina Display features a native resolution of 2048 x 1536 at 326
ppi. The Retina Display’s capacitive touchscreen lets you utilize all the /7 ik
multi-touch gestures of i0S 8. s

1

l\;

» 7.9" IPS LCD Multi-Touch Retina Display

» 2048 x 1536 Native Resolution

» Fingerprint identity sensor built into the Home button

» Apple A8 CPU with 64-bit architecture-1.3x faster than iPad mini 2
» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2 » Touch ID Fingerprint Reader » iSight Camera with 8MP photos
» Video Recording now includes Slo-mo function » i0S 8 and iCloud » Lightning Connector, AirPlay Mirroring

» Lightning Connector, AirPlay Mirroring Wi-Fi Only i Wi-Fi + 4G LTE Wi-Fi Only
59 S Colr APIPSSG 90 Storage  Color SKU Price Storage  Color SKU Price
- pace Gray . 12868 _ | Space Gray | APIPM4128UGR | 729.00 12868 | Space Gray [APIPMAW12856] 594.00
Wi-Fi + 4G LTE . 12668 | Silver | APIPP126S | 949.00 12868 | Silver | APIPP126CS | 729.00 1286 | Silver | APIPMAW128S | 594.00
Storage__Color SKU Price 12668 | Gold | APIPP126G | 949.00 12868 | Gold | APIPP128CG | 729.00 1286 | Gold | APIPMAW128G | 594.00
12668 | Space Gray | APIPP126CS6 | 1,079.00 326B | Space bray| APIPP37SG | 799.00 646B | Space Gray | APIPMA464UGR | 624.00 646B | Space Gray | APIPMAWG4SG | 494.00
1286B Silver APIPP128CS | 1,079.00 3268 Silver APIPP32S 799.00 4GB Silver APIPM&64US | 624.00 646B Silver | APIPM4WG4S | 494.00
12868 Gold APIPP128CG | 1,079.00 3268 Gold APIPP326 799.00 4GB Gold APIPM464UG | 624.00 6468 Gold APIPMAWG4G | 494.00
166B | Space Gray | APIPMA416UGR | 524.00 166B | Space Gray | APIPM4W16SG | 394.00
P . . . 1668 | Silver | APIPMA16US | 524.00 1668 | Silver | APIPM4W16S | 394.00
& Authorized Reseller iPad Air 2 1668 | Gold | APIPMATOUG | 529.00 1668 | Gold | APIPMAWIGG | 394.00

Work and play faster, thinner, and lighter with the iPad Air 2 from Apple.
The LED-backlit 9.7" 2048 x 1536 Retina IPS LCD display’s anti-reflective
coating reduces glare by 56% and uses a single-layer design to eliminate
internal reflectance for richer colors, greater contrast, and sharper
images. The Air 2 features Apple Touch ID technology, which uses your
fingerprint to unlock your device as well as make secure purchases in
iTunes, iBoaks, and the App Store. The 1.2MP front and 8MP rear camera
let you take high-resolution photos and videos as well as videochat in HD
while dual microphones reduce background noise. The iPad Air 2 runs i0S
8, featuring Siri, iCloud, and Spotlight Search.

@@ Authorized Reseller Apple Pencil

» Designed for the iPad Pro » Scans its signal at 240 times per second

» Two tilt sensors calculate the exact orientation and angle of your hand.

» Highly responsive » Create shading effects by tilting Apple Pencil like a
charcoal or conventional pencil » 12 hours of battery life

» 15 seconds charge = 30 minutes of battery life

@@ Authorized Reseller Apple Smart Keyboard -\

» 9.7"IPS LCD Multi-Touch Retina Display » 2048 x 1536 Native Resolution » Top layer is crafted from a sheet of highly durable ,
» Tri-Core Apple ABX CPU with M8 Chip » 0.98 b and 0.24” Thick custom-woven fabric that's laser ablated to form the shape of each key. N
» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.0 » Touch ID Fingerprint Sensor » 64 seamless keys » Smart Connector allows seamless two-way
» Front 1.2-Megapixel FaceTime HD Camera » Rear 8-Megapixel 1080p iSight Camera exchange of power and data between the Smart Keyboard and iPad Pro \
» Lightning Connector, AirPlay, AirDrop » Gyro, Accelerator, Ambient Light Sensor » Designed for the iPad Pro
Wi-Fi + 4G LTE Wi-Fi Only $169
Storage  Color SKU Price Storage Color SKU Price 2 .
1286B | Space Gray | APIPAZAT2856 | $799.00 12868 | Space Gray | APIPAZWI28SG | $659.00 & Authorized Reseller Apple Care _ F
12868 Silver | APIPAZAT28S | $799.00 12868 Silver APIPAZW128S | $659.00 AppleCare service provides unlimited support for Apple products such as iPad,
12868 Gold | APIPAZA1286 | $789.00 12668 Gold APIPAZWF128G | $659.00 iPhone, iPod, and Mac computers, i0S and 0S X operating systems. There's also
646B | Space Gray| APIPAZAGASG | $699.00 6468 | Space Gray | APIPAIWF6ASG | $9559.00 support for most Apple tools and applications including Apple Configurator, iPhone AppleCare
6GB | Siter | APIPAZAGAS | 9669.00 4GB Sver | APIPAZWFAS | $559.00 Configuration Utility, Apple Remote Desktop, Aperture, Compressor, Final Cut Pro -
64GB | Gold | APIPAZAGLG | $689.00 646B | Gold | APIPADWFGAG | $549.00 “onhg M. Appe P. ApErUIE, LOMpressor. '
1668 | Space bray | APIPAZATESG | §629.00 1668 | Space bray | APIPAZWF16SG | $469.00 iLife, iWork, Logic Pro, MainStage, and Mation. Additionally, this AppleCare Help
1668 Silver | APIPAZA16S | $579.99 1668 Silver APIPAZWF16S | $469.00 Desk Support plan provides support for the graphical user interface tools in 0S X Server. AppleCare techni-
1668 Gold | APIPAZAT6G | $599.00 1668 Gold APIPAWFT66 | $469.00 cian Training is also included - the Apple-approved online service certification training tool.

ACCESSORIES

" hesenr< Smart Case Apple Lightning to Micro USB Adapter Apple Lightning to SD Card Camera Reader
for iPad Air 2 & iPad mini (APLMUSB) $18.99 [APMLSDCR) $29.00
» Protects All Sides of Your iPad Air 2 Apple Lightning to 30-pin Adapter Apple Lightning To USB Charge & Sync Cable
» Leather Exterior (APL30P) $25.21 3.3 (APLUSBE) $17.43
) gﬁmf':'a‘éhed M‘Cvf\;’beEFCLli"i”Q Q 8 (APLIOPAD) oo $34.99 6.5 (APMOBIOZMA) ... $29.00
» Open the Cover to Wake, Close to Sleep U -
» Falds into Typing or Viewing Stand Apple Lightning Digital AV Adapter Apple Lightning to VGA Adapter

(APMDBZOAMA) .. $43.37 (APMLVADP) .. $45.99
Available in: iPad Air 2 Smart Case ... Apple Lightning to USB Camera Adapter Apple EarPods with Remote and Mic
Black, Midnight Blue, Olive Brown, Red, Pink iPad mini Smart Case [APMLUCADP) ... $29.00 (APIPODEP) $25.99

800-947-5534 + 212-444-6740




@0 Authorized Reseller Wireless Keyboard

3

» Bluetooth Wireless » Anodized Aluminum Enclosure
» Works With Mac & iPad » Compact Design » One-Touch Access

(APMC184LLB) $65.99

ClamCase Pro
Keyboard Case

» Bluetooth Keyboard Cas

» Polycarbonate Shell

» Aluminum Enclosure

» Rechargeable Battery / :

[PAD mini (CLCM1001WS)

$129.00

Kensington KeyFolio Pro 2
Keyboard Case

» Detachable Keyboard
» Bluetooth Wireless
» Tactile Keys

» Optimized For Touch Typing
» Leather-Like Case
IPAD mini (KEK39755U)
IPAD Air 2 (KEK97408US)

$59.99

BIEEBE .
LiFePprooF hiiiid Case
for iPad Air 2

» Sealed from Water, Dirt, Dust and Snow
» Screenless Technology

» Works with iPad Air 2 Touch 1D

» Fully Submersible to 6.6 for One Hour
» Withstands Drops from 4.0°
AVALANCHE (LINCIPAZAV)
BLACK (LINCIPAZBK)

Defender Series

» Built-in Screen Protector
» Polycarbonate Shell for Protection
» Synthetic Rubber Cover with Part Plugs
» Internal Foam for Cushioning
» Stand for Watching Movies or Typing
IPAD Air 2 Black (0TDSCIPA2BK), GLACIER (OTDSCIPAZGLC),
CRUSHED DAMSON (0TDCIPAZCD)

$80.95
[PAD mini Black (0TDSIPM123B), GLACIER (OTDCIPM1236L)......... $62.96

¥ Rotatable Case -~

Bumn for iPad Air

» Molded Hardshell Snap-In Design
» Access All Ports,

Buttons and Cameras
» Magnetic Cover » Secure Elastic Strap
» Automatic Wake and Sleep » Rotates for Landscape/Portrait Us
BLACK (xUIPARB) $§24.99
WHITE (XUIPARW) $§24.99

www.BandH.com

IPAD ACCESSORIES

s~~~k =~~= Universal Tablet Mount
» Mount Any Tablet or iPad

» Adjustable Length & Thickness
» Teflon Coated

» Adjustable Steel Bracket

BASIC (MAUTMB) $57.95
DESK Kit (MAUTMDK) $149.95
MASTER Kit (MAUTMMK) $189.95

- Digital Kitchen Mount
‘b For All iPad Models/Tablets 6-8.5” Wide

» Mounts to Walls or Under Kitchen Cabinet .

» Two Mounting Bases Included

» Also Works as a Tabletop Stand =
» Quick Release Buttons

» Portrait / Landscape Mode

(CTPADKMS) o

iOttie EasySmart Tap
Car & Desk Mount

» One Touch Mounting

» Gel Suction Cup Attachment
» Adjustable Viewing Angle

» Portrait/Landscape Viewing

IPAD Car & Desk Mount (IOHLCRI0107)
IPAD mini Car & Desk Mount (IOHLCRIO108)......................... $29.95

# Clear Screen Protector
KumaA for Apple iPad Air 1/2

» Scratch-Resistant Protective Film

» 4H Hardness

» Doesn't Interfere with Touchscreen
» Glue-Free / Static Application

» Maintains Image Clarity

» Includes Accessories for Application
CLEAR (XUPSCIPA) $9.99

=SS ikip __
wonmenn > Attaches to Mic Stands up to 1.2
» Quick-Snap Clips

» Thermoplastic Construction

» Sure-Grip Touch Points

» Multi-Angle Viewing Adjustment

» Access All Parts & Controls

» 360° Rotation » Portrait/Landscape Mode

(IKLIPZIPDIN)

Stylus

ruma for Tablets and Smartphones

» Works with Many Tablets, Smartphones

» Supple Rubber Tip

» Metal Construction » Integrated Pocket Clip
» Helps Eliminate Smears, Fingerprints

RED (XUSP11R), BLUE (XUSP11BL
WHITE (XUSP11W)
SILVER (XUSP11S), BLACK (XUSPTTB) ...ccccc $3.95

COMPUTERS

iStudio iS202
vehringer Professional iPad Docking Station
» Dock for iPad & iPad 2
» Supports Powering/Charging
» USB-to-Host Connectors
» Standard MIDI 1/0
» Video Output » Ergonomic Layout

(BEIS202) $99.99
=M1 e

Stereo X/Y Microphone for iOS

» Same Condenser Mics Found in H&n & 5

» Up to 16-bit/48KkHz resolution " ] "f._“?\_
» Angle X/Y Mics at 90 or 120 Degrees v 4
» Large Mic Gain Wheel ] ‘G/

» Monitor Input with 3-Segment LED
» 3.5mm Headphone Jack Doubles as Line
(20106) $99.99

&% maavana Movie Mount
for iPad Air 1/2

» Allows iPad to Stand Upright
» Two Cold Shoe Mounts

» 1/4"-20 Tripod Connection

» Free Movie Mount iPad App
» Fully Compatible With Smart Cover » 9° Working Angle
» Works with Some 37mm Conversion Lenses

(MAMMAIR)

$69.95

iXZ Mic & Instrument Interface

Professional iPad Docking Station

» Switchable Mic / Line Input

» Phantom Power for Condenser Mics

» XLR Mic Input & Gain Control

» High-Impedance Guitar Input

» Headphone 1/8” Output for Monitoring
» Mic Input Powered by 7 AA Batteries
(TAIX2) $49.99

E

'O, Great Harbor Software

aiseet iIPAd to Computer Transfer

» Transfer Content From iPad to Computer
» Backs Up Music, Videos, Podcasts

» Supports iPod & iPhone

» Transfers SMS/MMS & Contacts

» Search Function
WINDOWS (GRAISEIFU)
MAC (GRAISEIMU)

@ ebroot SecureAnywhere
Internet Security Plus

» Virus and Spyware Protection

» Real-Time Anti-Phishing

» One Master Password to Access Websites

» Windows, Mac, Android & i0S Compatible

» |dentity Protection » Lost Device Protection

1 Year (WESAISP) $59.99
2 Years (WEISP3D2Y) §57.49
49




COMPUTERS 7-8” TABLETS

W Galaxy Tab 4 7.0"
The 86B Galaxy Tab 4 Multi-Touch 7.0" Wi-Fi Tablet

from Samsung allows you to experience powerful on-the-go performance. For
power and multi-tasking, this system features a microSD slot for additional
storage; the microSD slot supports microSDHC cards up to 32GB. This device
also features GPS with GLONASS, which allows you to use Google's location
based services included turn-by-turn GPS navigation.

» 1.26Hz Quad-Core Processor » 86B Storage

» 1280 x 800 Touchscreen resolution

» 801.11 a/b/g/n & Bluetooth 4.0 » Android KitKat 4.4

Cellular Network Color SKU Price
None Black SAGT47B $179.99
None White SAGT4TW $179.99

26 &3.56 Unlocked Black SASMT231BLK $229.00

26 &3.56 Unlocked White SASMT231WHT $229.00

@ LG GPad7.0”
The LG G Pad 7.0 Wi-Fi Tablet offers powerful

performance and wireless content sharing. This tablet is powered by a
quad-core 1.2 GHz Qualcomm Snapdragon processor and has 168 of
RAM. This system features 8GB of built-in storage and also has a microSD
slot for added storage capacity; the microSD slot supports microSDHC
cards up to 32GB.

» 1.26Hz Quad-Core Processor » 8GB Storage

» 1280 x 800 Touchscreen resolution

» 801.11 a/b/g/n &Bluetooth 4.0 » Android Lollipop 5.0

Black (LGV400B)
White (LGV400W)

/1SS Google Nexus 7 FHD Tablet (2013)

» FHD 1920 x 1200 Multi-Touch 7" Display

» Qualcomm Snapdragon S4 Pro Quad-Core CPU

» Adreno 320 - 400 MHz Graphics

» Internal 2GB RAM & 16GB Flash Storage

» Bluetooth 4.0 & 802.11 a/b/g/n Wi-Fi

» Front 1.2MP Camera & Rear bBMP Camera

» Micro-USB Supports Slimport HOMI Output

» G-Sensor, Gyroscope & E-Compass Sensor

» Tablet Equipped with Stereo Speakers » Android 4.4 Kit-Kat Operating System

166B (ASN72816)

$129.00
$129.00

$149.00

/15US IenPad 8.0”

The black ASUS ZenPad S 8.0" Wi-Fi Tablet features a vivid display, enhanced optics,
and powerful processing. This tablet is powered by a 64-bit Intel Atom 23580 quad-
core processor, and has 4GB of LPDDR3 1066 MHz RAM. This processor features a
burst speed of up to 2.3 GHz. This system features a microSD slot for added storage
capacity; the microSD slot supports microSDXC cards up to 12868.

» 2.36Hz Intel Atom Quad-Core Precessor

» 2048 x 1536 Touchcreen resolution

» 801.11b/g/n & Bluetooth 4.0 » Android Lollipop 5.0

64GB (ASZPZ580CAC1)
326B (ASZP8SZ580C)

$299.00
$199.00

lenovo M8.0”

Stay entertained and informed with the midnight blue 16GB TAB 2 AB 8" Wi-Fi Tablet
from Lenovo. This tablet is powered by a 32-bit quad-core 1.3 GHz MediaTek MT8161
chipset and has 16B of RAM. This tablet has a microSD slot for added storage capacity;
the microSD slot supports microSDHC cards up to 32GB.

» 1.36Hz Quad-Core Precessor » 16GB » Android Lollipop 5.0

» 1280 X 800 Touchcreen resolution » 801.11b/g/n & Bluetooth 4.0

(LETAB2AB) $129.49

w Samsung Galaxy Tab S2 Multi-Touch 8.0”
Combine powerful performance and wireless

connectivity with the black 326B Galaxy Tab S2 Multi-Touch 8.0 Wi-Fi Tablet
from Samsung. This tablet features a Samsung octa-core chipset, which
consists of 1.9 GHz and 1.3 GHz quad-core processors, and has 3GB of RAM.

» 8.0" Super AMOLED Multi-Touch Display

» (IXGA (2048 x 1536) Native Resolution

» Quad-Core 1.9 GHz and 1.3 GHz Processors » 3GB of RAM & 32GB of Onboard Storage

» Fingerprint Scanner » Dual-Band Wi-Fi + Bluetooth 4.1 » 2.1MP Front Camera + 8MP Rear Camera

Cellular Network Color SKU Price
None Black SAGTS28B $399.99
None Gold SAGTS28CB $399.99
None White SAGTS28W $399.99

2
nview SupraPad

The SupraPad i-700QW 7" Windows Tablet from iView is powered by a 1.33 GHz Intel

Atom 237356 Quad-Core processor featuring a burst speed up to 1.83 GHz and the

system also has 16B of RAM and 16GB of flash storage. In addition, there is also a

microSD card reader that affords users up to 32GB of storage expansion when using

amicroSDHC card. When combined with the 16GB on built-in storage, users will

have up to 48GB of storage.

» 1.33GHz Intel Atom Quad-Core Processor

» 16GB Storage » 1024 x 600 Touchscreen resolution

» 801.11 a/b/g/n & Bluetooth 4.0 » Windows 8.1 » Free Upgrade To Windows 10 valid until 07/29/16

(IVI7000W) $69.99

w Galaxy Tab 8.0”
Stay informed and entertained with the titanium

Samsung 8.0" Galaxy Tab A Tablet. It features a 16GB storage capacity and
also has a microSD slot foradditional storage; the microSD slot supports
microSDXC cards up to 1286B. This device also features GPS with GLONASS,
which allows you to use Googles location-based services.

» 1.26Hz Quad-Core Processor » 1024 x 768 Touchscreen resolution

» 1668 » 801.11a/b/g/n & Bluetooth » 4.1Android Lollipop 5.0

Titanium (SAGTA8165T) $229.99
White (SAGTABT6W) $227.99
Blue (SAGTAB16SB) $229.99

<CEYT IconiaOne 8

The Acer Iconia Tab 8.0" Wi-Fi Tablet offers a quad-core Intel Atom

137356 processor and 16B of RAM to deliver power as well as multitasking
capabilities to all these features. You can store all your apps and files on

the 3268 flash drive and use a microSD or microSDXC memory card in the
card reader slot for additional storage space. In addition, this tablet provides
two 2ZMP cameras and integrated speakers as well as a built-in a microphone
to stay in touch with friends and family.

» 1.33 GHz Intel Atom Quad-Core Processo

» 1280 x 800 Touchcreen resolution » 802.11b/g/n & Bluetooth 4.0

Storage 0S Color SKU Price
1668 Android Kitkat 4.4 Black ACB181011TV $109.00
3268 | Windows81 | White | Aowigtongs | $129.00

To view a full listing of all Tablets

or visit our website BandH.com/w1550

800-947-5534 + 212-444-6740




w Samsung Galaxy Tab S2 Multi-Touch 9.7”
Combine powerful performance and wireless connectivity
with the black 32GB Galaxy Tab S2 Multi-Touch 9.7" Wi-Fi Tablet from Samsung. This
tablet features a Samsung octa-core chipset, which consists of 1.9 GHz and 1.3 GHz
quad-core pracessors, and has 36B of RAM. This system also has 32GB of built-in
storage and adds a microSD slot for additional storage; the microSD slot supports
microSDXC cards up to 1286B.

» OXGA (2048 x 1536) Native Resolution » Quad-Core 1.9 GHz and 1.3 GHz Processors
» 36B of RAM & 326B of Onboard Storage » Dual-Band Wi-Fi + Bluetooth 4.1

» 2.1MP Front Camera + 8MP Rear Camera » Fingerprint Scanner

Cellular Network Color SKU Price
None Black SAGTS297B $499.99
None Gold SAGTS297CB $499.99
None White SAGTS297W $499.99

W Galaxy Tab 4
The 16GB Galaxy Tab 4 Multi-Touch 10.1” Tablet

from Samsung features GPS with GLONASS, which allows you to use Google's
location based services, including turn-by-turn GPS navigation. The onboard A
front facing 1.3-megapixel and rear 3-megapixel cameras allow you take pictures of yourself and the
world around you. Additionally, integrated S-Voice technology utilizes the device’s built-in microphone for
interacting with the tablet via voice commands.

» 10.17" Display » 1.26Hz Cortex-A7 Quad-Core Processor » Android KitKat 4.4

» 1280 x 800 Touchcreen resolution » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0

Color Cellular SKU Price
Black 26 & 3.56 Unlocked SASMTB31BLK $299.99
White | 26&35GUnlocked | SASMTB3IWHT | $299.99

w Galaxy TabA9.7"
Stay informed and entertained with the Samsung 9.7"

Galaxy Tab A Tablet. For power and multi-tasking, this tablet has 1.56B of RAM.
It features a 16GB storage capacity and also has a microSD slot for additional
storage; the microSD slot supports microSDXC cards up to 1286B.

» 9.7" Display » 1.26Hz Quad-Core Processor » Android Lollipop

» 1024 x 768 Touchcreen resolution » 802.11a/b/g/n Wi-Fi & Bluetooth 4.1 S
$279.99

Titanium (SAGTA9716ST)
White (SAGTAI716W) $279.99
Blue (SAGTA97165B) $279.99

FiSLI= 1300C-A1ZenPad 10.1"
The black ASUS ZenPad Tablet offers powerful performance in a slim, modern
design. This system features 166B of built-in storage and also has a microSD slot
for added storage capacity; the microSD slot supports microSDXC cards up to 64GB.
» 10.17" Display » 1.26Hz Intel Atom Quad-Core Processor » Android Lollipop
» 1280 x 800 Touchcreen resolution » 802.11b/g/n Wi-Fi & Bluetooth 4.0

(ASZP102300C) $179.00

(@ mnabi XD10.1"

The nabi XD 10.1" Tablet features a protective rubber bumper that's easy to
grip with a fifth battery-saver core and 1GB of RAM.

» 10.1" Display » 1.6GHz NVIDIA Tegra 3 Quad-Core Pracessor

» 1366 x 768 Touchcreen resolution » 802.11b/g/n Wi-Fi & Bluetooth 3.0 » Android Jelly Bean 4.1
32GB (NABIXDNV1OC) $273.99
16GB (NABIXDNV10B) $249.99

I~

nview Magnus

» 101" Display » 1.33 GHz Intel Atom Z3735F (Bay Trail)

» 268 of DDRI RAM » 32GB of Flash Storage » 10.1" IPS LCD Touchscreen
» HD 1280 x 800 Native Resolution » 802.11b/g/n Wi-Fi, Bluetooth 4.0

(IVIVIEWMAGNS) $179.00

www.BandH.com

9-10” TABLETS = COMPUTERS

@ LG G Pad 10.1
The black LG 1668  Pad 10.1" Wi-Fi Tablet offers

powerful performance and wireless content sharing. The microSD slot
supports microSDHC cards up to 32GB.

» 10.1 Display » 1.2GHz Snapdragon Quad-Core Pracessor » 16GB
» 1280 x 800 Touchscreen resolution » 801.11a/b/g/n & Bluetooth 4.0 » Android Lollipop 5.0

(L6V7008)

$179.00

Microsoft Surface 310.8”

Microsoft combines the portability of a tablet and the performance of a
laptop with the Surface 3 10.8” Multi-Touch Tablet. Weighing just 1.37
pounds and measuring just 0.34” thin, the Surface 3 packs Intel Atom x7
processing power into a magnesium casing with a silver finish.

» 10.8" Display » 1.2GHz Intel Atom Quad-Core Processor » 1920 x 1080 Touchcreen resolution
» 802.17ac Wi-Fi &Bluetooth 4.0 » USB 3.0 & Mini DisplayPort » Windows 10

RAM Storage SKU Price
46B 12868 MI7G500014 $699.00
268 \ 646B \ MI76500015 \ $499.00

Ilenowvo Tah2A1010.17

Stay entertained and informed with the midnight blue 1668 TAB 2 A10 10.1"
Wi-Fi Tablet from Lenovo. The TAB 2 A10 is equipped with a 10.1" 10-point
multi-touch IPS LCD display and features 1920 x 1200 native resolution for
viewing detailed high-definition images. The front-facing fixed-focus
5-megapixel and rear-facing auto-focus 8-megapixel cameras allow you take
pictures of yourself and the things around you.

» 10.1" Display » 1.5GHz ARM Cortex Ab3 Quad-Core Processor » 1920 x 1080 Touchcreen resolution
» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Android KitKat 4.4

(LETAB2A10)

$198.00

Ienowo ThinkPad 10

The ThinkPad 10 Tablet from Lenovo has a WUXGA touchscreen, which is made

of Corning Glass for durability. With support for ten-finger gestures, the display
features a 1920 x 1200 native resolution and a 16:10 aspect ratio.

» 10.1" Display » 1.59GHz Intel Atom » 1920 x 1200 Touchscreen resolution
» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1

RAM Storage SKU Price
46B 12668 LETP1020C1AD $878.99
268 \ 6468 \ LETP1020C100 | $709.99

Panasonic. Toughpad FZ-A1

The Toughpad FZ-A1 features a 10.1” daylight-readable display. It offers
flexibility via its microUSB port, vehicle docking capability, and professional-
grade accessories, making it suitable for clipboard replacement and cloud
applications. Engineered with security in mind, this unit comes standard with
hardware encryption and embedded enterprise-grade security and management
to keep data and other sensitive files encrypted and secure.

» 10.1" Display » 1.2GHz ARM > Andraid 4.0

» 1024 x 768 Touchscreen resolution > 802.11b/g/n Wi-Fi

(PAFZATBDAAVT)

$1,539.91

€y ematic EGD21310”

The Ematic EGD213 features a front 0.3-megapixel and rear 2-megapixel
cameras allow you to capture photos and utilize videa chat applications. This
tablet also features a mini-HDMI output, which allows you to display content
on an external display when used with an optional cable. A micro-USB 2.0
interface is also built-in for mass storage connections, a USB cable is included.

» 10" Display » 1024 x 600 Touchscreen resolution » 16Hz Quad-Core Processor » 802.11b/g/n Wi-Fi

(EMEGD213BL) $76.55
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COMPUTERS  11-12” TABLETS

Microsoft Surface Pro312”

Microsoft combines the portability of a tablet and the performance of
a laptop with the Surface Pro 3 12" Multi-Touch Tablet. Weighing just
1.76 pounds and measuring just 0.36" thin, the Surface Pro 3 packs
4th-gen Haswell Intel Core processing power into @ magnesium casing
with a silver finish.

» 2160 x 1440 Touchscreen resolution » 801.11 ac & Bluetooth 4.0 » USB 3.0 & Mini DisplayPort

Processor RAM  Storage Graphics SKU Price
1.7 GHz Intel Core i7-46500 | 126B 51268 | Intel HD Graphics 5000 |  MIPU200017 $1,949.00
1.7 GHz Intel Core i7-4650U |  8GB 25668 | Intel HD Graphics 5000 MI5D200017 $1,549.00
1.9 GHz Intel Core i5-4300U |  86B 25668 | Intel HD Graphics 4400 |  MIPS200017 $1,299.00
1.5 GHz Intel Core i3-4020Y | 4GB 12868 | Intel HD Graphics 4200 |  MIMQ200019 $999.00
1.5 GHz Intel Core i3-4020Y |  8GB 6468 Intel HD Graphics 4200 |  MI4YM00016 $799.00

Microsoft Surface Pro 3 Type Cover

Take your tablet from humdrum to QWERTY while adorning it with an attractive
cover with the red Surface Pro 3 Type Cover from Microsoft. This ultra-thin
cover features a mechanical QWERTY keyboard with a full row of function
keys, window shortcut keys, and media controls. A fingertip-controlled
touchpad allows you easily control the cursor.

» QWERTY Keyboard for a Surface Pro 3 » Full Row of Function Keys F1to F12 » Windows Shortcut
Keys & Media Controls » Fingertip-Controlled Ultra Thin Touchpad » Folio-Style Case for Protection
» Magnets for Stability in Cover Mode » Display Shuts Down When Closed

AVAILABLE IN BLACK, BLUE, RED, CYAN, PURPLE $129.99

» 250 Levels of Pressure Sensitivity » Right-Click & Erase Buttons » Bluetooth 4.0 Connectivity
» Palm Block Technalogy » For the Surface 3 & Surface Pro 3

AVAILABLE IN BLACK, SILVER, DARK BLUE, RED $49.99

Microsoft Surface Pro Accessories

Docking Station (MI30900001) $143.99
Mini DisplayPort HDMI AV Adapter (MIF6U00011)...... $39.99
Surface Pro 3 Screen Protector (MIAS500001) .......... $49.99
Mini DisplayPort to VGA Adapter (MIF700015) ... $39.99
Power Supply for Surface Pro 3 (MIRC200001).......... $64.99
USB 3.0 Ethernet Adapter (MI3U400001) ................... $28.86

fee)

FUJITSU XBUY-Q704-002 STYLISTIC

The Fujitsu 128GB XBUY-Q704-002 STYLISTIC Q704 Tablet delivers robust
on-the-go performance. This tablet is powered by an onboard Intel Turbo
Boost 2.0 technology, processor speed can reach as high as 2.6 GHz. For
long term data storage, this tablet has 12868 mSATA Opal SSD Storage.
Opal drives are optimized for enhanced security.

» 12.5" Display » 1.6 GHz Intel Core i5-4200U

» 1920 x 1080 Touchscreen » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0

» Windows 7 Pro + Windows 8.1 Pro License - FREE Upgrade to Windows 10 valid until 7/29/16

(FUQ704002)

FUjITSU

$1,649.99

Mo{i?)n“ R12
— Designed for mobile workers, the R12 Rugged Tablet
PC from Motion Computing is a fully-featured computer in a durable and
lightweight frame. The rubberized bevel border is wrapped around a 12.5”
Full-HD View Anywhere Display that can be navigated by 10-paint touch or
the included Wacom digitizer stylus.
» 2.9 GHz Intel Core i7-4610Y » 12.5" Full-HD 1920 x 1080 Display » 10-Point Touch & Wacom Digitizer Pen
» 802.11ac Wi-Fi, Bluetooth 4.0 » HDMIand USB 3.0 Ports, SDXC Card Slot

Memory Storage Cellular SKU Price
4GB 128GB WiFi Only MORB3D3A2A2B $2,214.99
4GB 12868 4G LTE Mobile Broadband MORB3A3AZAZB $2,429.48
8GB 12868 4G LTE Mobile Broadband MORC3A3A2A2B $2,564.50
8GB 25668 4G LTE Mobile Broadband MORD4A3AZAZB $3,104.59

w Galaxy Note Pro 12.2"
The Samsung Galaxy Note Pro 12.2" Wi-Fi Tablet

delivers powerful on-the-go performance and enhanced productivity. This
tablet features the Exynos b Octa chipset, 3GB of RAM and can be
expanded by an additional 64GB via the tablet's microSDXC card slot.
The tablet also has a micro-USB 3.0 interface for charging and mass-
storage connections; a USB cable and power adapter are included.

» 1.9 GHz ARM A15 /1.3 GHz ARM A7

» 2560 x 1600 Touchscreen resolution

» 802.11ac Wi-Fi & Bluetooth 4.0 » Android KitKat 4.4

» Intergrated S Pen for Sketching & Notes

Storage Color SKU Price
6468 Black SAGNP122648 $849.99
646B White SAGNP12264W $849.99
3268 Black SAGNP122328 $749.99
3268 White SAGNP12232W §749.99

w Galaxy Bluetooth Keyhoard Cover
Bluetooth Wireless Keyboard
» Doubles as Protective Cover &
» Built-In Hot Keys » Rechargeable via Micro USB

» Works with Galaxy Note & Tab Pro 12.2

WHITE (SAKBCGN12.2W) $65.00

7) SmartBuyPro12.5” Tablet
» 12.5" LED-Backlit Touch Screen

» 1.6 GHz Intel Core i5-4302Y Processor
» B6B 1600 MHz DDR3 SDRAM » 2566B M.2 SSD
» Supports Micro-SD/ SDHC/SDXC Card
» FHD UWVA eDP 1900 x 1200 Display
» 802.11a/b/g/n Wi-Fi, Bluetooth 4.0 » Front 1080p HD Webcam/Rear 5 MP Camera
» Dual Speakers and Integrated Microphone » Windows 8.1 Pro (64-Bit)

TOUCHSCREEN g

Processor Storage SKU Price
1.6 GHz Intel Core ib-4302Y 25668 HEP612J8V93U $1,099.99
1.6 GHz Intel Core ib-4302Y 12868 HEP412J8V86U $905.04
1.5 GHz Intel Core i3-4012Y 128GB HEP§12J8V71U $905.19
1.5 GHz Intel Core i3-4012Y 6468 HEP612J8V68U $647.00

’ Elitex2 101161 L8D65UT
Tablet with Power Keyboard
» Webcam/Rear 5 MP Camera
» Dual Speakers and Integrated Microphone
» Windows 8.1 Pro (64-Bit)

Processor Storage SKU Price
800 MHz Intel Core M-5Y10c 4GB HELBDA5UT $1,015.00

y

o
FUJITSU XBUY-T725-001 LIFEBOOK T72512.5”
Dual Digitizer Multi-Touch Tablet PC

» Bi-Directional LCD Hinge Design

» 12.5" AH-IPS LED Multi-Touch Display

» HD 1366 x 768 Native Resolution

» 2.16Hz Intel Core i3-5010U Dual-Core

» Integrated Intel HD Graphics 5500

» 5006B 7200 rpm HDD + 4GB of RAM

» Intel Dual Band Wireless-AC 7265

» USB 3.0/HDMI/VGA/Ethernet (RJ-45) Port » Windows 7 Pro + Windows 8.1 Pro License

(FUT726001)

$997.80

800-947-5534 + 212-444-6740




Ienowvo Ekdge 15

The silver Edge 15 Multi-Mode FHD 15.6” 2-in-1 Touchscreen Notebook
Computer from Lenovo is a system whose screen can rotate 300° to vary
between laptop mode and stand made. If you are working on tasks that require
the keyboard, such as creating Word documents or editing a spreadsheet,
the Edge 15 is best used in classic laptop mode to help increase productivity.
» 1920 x 1080 Touchscreen resolution » 1600 MHz DDR3 RAM
» 802.17ac Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.06Hz Intel Core i7-4510U | 86B | 178 5.4k NVIDIA GeForce 840M LEET580H1X01 | $649.00
1.76Hz Intel Core i5-4210U | 668 | 178 5.4k | Intel HD Graphics 4400 | LEE1580H1X02 | $549.00

Ilenowvo Fex3

Featuring a unique quad-mode design, the black Flex 3 14" Touchscreen
Notebook Computer from Lenovo is a system whose screen can rotate
360° to vary between laptop, stand, tent, and tablet mode.

» Intel HD 5500 Graphics » 14" Touchscreen

» 802.11ac Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Resolution SKU Price
2.4GHz Intel Core i7-5500U | 8GB 118 1920 x 1080 LEFLEX315 | $849.99
2.2GHz Intel Core i5-5200U | 8GB |  500GB 1920 x 1080 LEFLEX31415 | $729.00
2.2GHz Intel Core i5-5200U | 4GB | 500GB 5.4k 1366 x 768 LEF380JMO0IM| $669.00

Ienowo ThinkPad Yoga 12

The ThinkPad Yoga 12 Multi-Touch Ultrabook Computer from Lenovo is

a system whose screen can rotate 360° to vary between laptop, tent,

stand, and tablet mode.

» 12.5" Touchscreen » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price

2.66Hz Intel Core i7-5600U | 8GB | 25668 SSD | Intel HD Graphics 5500 (1920 x 1080) | LEY12200L03A | $1,661.95
2.36Hz Intel Core 5-5300U | 8GB | 1806B SSD | Intel HD Graphics 5500 (1920 x 1080) | LEY1220DL038 | $1,419.00
2.36Hz Intel Core i5-5300U | 8GB | 500GB 5.4k | Intel HD Graphics 5500 (1920 x 1080) | LEY1220DL032 | $1,197.47
1.96Hz Intel Core 5-4300U | 4GB | 1806B SSD | Intel HD Graphics 4400 (1920 x 1080) | LEY1220DL038 | $1,419.00
2.26Hz Intel Core i5-5200U | 4GB | 5006B 5.4k | Intel HD Graphics 5500 (1366x 768) | LEY1220DL037 | $1,023.99
2.06Hz Intel Core i3-5005U | 4GB | 5006B 7.2k | Intel HD Graphics 5500 (1366x 768) | LEY1220DL036 | $940.99

.............................................. .$349.00
$384.00

isSUsS T100

The ASUS T100 Series Transformer Book is a tablet / notebook combo
device that features a 10.1” display and a detachable keyboard dock with
a touchpad for mouse-like control when using the tablet like a notebook.
» 1.466Hz Intel Baytrail-T 23775 » 26B » 646B MMC

» 1366 x 768 IPS Touchscreen » 1066 MHz DDR3 RAM

» 802.11a/b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

RED (ASTT00TACIRD), WHITE (AST100TACIWH), DARK GRAY (AST100TAMHIM
BLACK/ALUMINUM (AST100CHICTB)

SCES Aspire Switch 11
The Aspire Switch 11 11.6" 2-in-1 Multi-Touch Tablet PC from Acer blends
a notebook and a tablet into one, allowing you to experience increased
functionality. The Acer Snap Hinge provides you with four different modes
and uses magnetism to provide a latch-less docking solution.
» 1920 x 1080 TouchScreen resolution » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price

1.66Hz Intel Core i6-4202Y | 4GB | 1286B SSD Intel HD Graphics 4200 ACSW5171P828] $792.99
1.56Hz Intel Core i3-4012Y | 46B | 12868 SSD | Intel HD Graphics 4200 ACSw5171325N]§599.00

www.BandH.com

2INTNOTEBOOKS  COMPUTERS

@ Inspiron 3000
The Inspiron 3000 11.6” Touch Convertible Notebook

Computer from Dell with a 360° hinge design lets you flip the
keyboard around and lay it flat on your lap to surf social media,
swipe through photas, or pull up your playlists. You can rotate it
from laptop to tablet, tablet stand, or use in tent mode.

» 1366 x 768 Touchscreen resolution

» 4GB 1600 MHz DDR3 RAM

» 5006B 5400rpm Hard Drive » Intel HD Graphics 4400

» 802.11b/g/n Wi-Fi & Bluetooth 4.0

» Windows 10

Processor SKU Price
1.9GHz Intel Core i3-4030U DEI31488841S $529.00
2.166Hz Intel Pentium N3530 \ DE113147 \ $419.00

TOSHIBA Satellite Fusion 15

With its 360° hinge design, the Satellite Fusion 15 2-in 1
Multi-Touch Convertible Notebook Computer from Toshiba
can be experienced in laptop, tabletop, presentation,
audience, and tablet modes.

» 1366 x 768 Touchscreen resolution

» 802.11ac Wi-Fi &Bluetooth 4.0 _
» Windows 10 -

Processor RAM  Storage
2.2 GHz Intel Core i5-5200U | 8GB 118

Graphics SKU Price
Intel HD Graphics 5500 TOLKBWCH256 | $709.99

Ienowvo ThinkPad Yoga 15
» 2.46Hz Intel Core i7-5500U

» 1920 x 1080 Touchscreen resolution

» 86B GB DDR3 RAM » 2566B SSD Storage

» NVIDIA GeForce 840M 2GB RAM

» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10

(LEY152000083) $1,147.00

Pavilion 13

The HP Pavilion x360 13.3" Convertible Touchscreen
Notebook Computer offers multiple viewing options and
enhanced sound quality.
» 1366 x 768 Touchscreen resolution
» 4GB GB DDR3 RAM » 50068 5400rpm Storage
» Bluetooth 4.0 » Windows 8.1
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor Color  WiFi Graphics SKU Price
26Hz AMD AB-6410 | Silver | 802.11b/g/n AMD R5 Graphics HEG6SBBUA | $599.00
2.16Hz Intel Core i3-5010U [ Silver | 802.11ac_| Intel HD Graphics 5500 |HEX360M4C39U] $529.99

/iSUS Transformer Pad

The Transformer Pad 10.1" Wi-Fi Tablet with Keyboard from ASUS
combines a powerful Android tablet and a detachable keyboard dock.
» 1280 x 800 Touchcreen resolution

» 1.33 GHz Intel Atom » 1GB

» 1668 SSD » 802.17a/b/g/n Wi-Fi & Bluetoath 4.0

» Android KitKat 4.4

BLACK (ASTF103CA1B) $219.00

53




COMPUTERS

ULTRABOOKS

/iSUS enBook

The titanium gold ZenBook UX305FA-RBM1-GD 13.3"
Ultrabook Computer from ASUS is a thin and lightweight
notebook with the power and features required for home
and professional use.

» 1920 x 1080 resolution » 1600 MHz DDR3 RAM

» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 8.1
Processor RAM Storage Graphics SKU Price
800MHz Intel Core M-5Y10 | 868 25668 SSD Intel HD Graphics 5300 | ASUX305FARBM | $699.00

Ienowo ThinkPad X1 Carbon

Thin at just 0.7 and featuring a 10-point multi-touch

WQHD display, the ThinkPad X1 Carbon 14" Multi-Touch

Ultrabook Computer from Lenovo is a system designed

for home and business users who need a reliable system

for general use.

» 2.66Hz Intel Core i7-5600U CPU

» 8GB DDR3 RAM » 756GB SSD Storage » 14" Touchscreen LED Display
» Intel HD Graphics 5500 » Windows 10

Processor RAM  Storage
2.66Hz Intel Core i7-4720H0| 16GB | 5126B SSD

Graphics SKU Price
NVIDIA GeForce GTX 960M Graphics | LEX1C20BS003 | $1,955.00

-5

Ienowvo ThinkPad T450s

The slim and lightweight ThinkPad T450s Ultrabook
Computer is designed for business users who require
portability, but is also well suited for general use.

» 14" Antiglare Display

» 802.17ac Wi-Fi » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16
2.66Hz Intel Core i7-5600U | 86B | 5126B SSD | Intel HD Graphics 5500 (1920 x 1080) | LET450S20BXF | $1,579.00
2.66Hz Intel Core i7-5600U | 86B | 2566B SSD | Intel HD Graphics 5500 (1920 x 1080) | LET450SBXOIL | $1,499.00
2.36Hz Intel Core i5-5300U | 8GB | 2566B SSD | Intel HD Graphics 5500 (1600 x 900) | LETA50SBX01A |$1,378.99
2.3GHz Intel Core i5-H300U | 8GB 51668 Intel HD Graphics 5500 (1600 x 900) | LET450S20BXE |$1,099.89
2.26Hz Intel Core ib-5200U | 4GB 516GB Intel HD Graphics 5500 (1600 x 900) | LET450S20BXP | $877.10

Ienowvo ThinkPad T450

Slim and portable at 0.83" thin, the ThinkPad T450 20BV000DUS

14" Ultrabook Computer from Lenovo is built with ports and

connectivity options that are often found on mobile workstations.
» 1600 MHz DDR3 RAM » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 7 Pro + Windows 8.1 License

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM

2.6GHz Intel Core i7-5600U | 8GB
2.3GHz Intel Core i5-5300U | 8GB
2.36Hz Intel Core ib-b300U | 4GB
2.3GHz Intel Core i5-5300U | 4GB
2.26Hz Intel Core i-5200U | 4GB

Storage Graphics SKU Price

25668 SSD | Intel HD Graphics 5500 (1600 x 900) | LET450B000D | $1,317.00
25668 SSD | Intel HD Graphics 5500 (1600 x 900) | LET450BVO00A | $1,281.99
50068 7.2k | Intel HD Graphics 5500 (1600 x 900) | LETA50BV0001 | $998.79
50068 7.2k | Intel HD Graphics 5500 (1366 x 768) | LET45020BV0C | $914.73
50068 7.2k | Intel HD Graphics 5500 (1366 x 768) | LET450BV0005 | $843.26

Ienowo ThinkPad X250 20CM002XUS
» 2.2 GHz Intel Core i5-5200U Dual-Core

» 86B of 1600 MHz PC3-12800 DDR3 RAM

» 5006B 5400 rpm HDD + 16GB SSD

» Integrated Intel HD Graphics 5500

» 12.5” LED-Backlit Anti-Glare Display

» HD 1366 x 768 Native Resolution » Mini DisplayPort / VGA / USB 3.0
» 4-in-1 SD & MMC Media Card Reader » Gigabit Ethernet & 802.11ac Wi-Fi
» Windows 7 Pro + Windows 8.1 License

(LEX25020CM2X)

$1,126.95

@ ATIVBook 9 Plus
The mineral ash black ATIV Book 9 Plus
13.3" Multi-Touch Ultrabook Computer from Samsung features a
13.3" QHD+ LED-backlit display and a large 3200 x 1800 native
resolution, resulting in 275 pixels per inch (ppi).
» 3200 x 1800 Touchscreen resolution » 1600 MHz DDR3 RAM
» 802.11ac Wi-Fi & Bluetooth 4.0 » Windows 10

Processor RAM  Storage Graphics SKU Price

2.46Hz Intel Core i7-55000 | 86B | 25668 SSD | Intel HD Graphics 5500 | SANP940X3KK2 | $Call Or Log-on
2.26Hz Intel Core i5-5200U | 4GB | 1286B.SSD | Intel HD Graphics 5500 | SANPIAON3KK3 |  $1,297.99

@ XPS13
Go beyond Full HD 1080p with the silver anodized

aluminum Dell XPS 13 Multi-Touch Notebook Computer.
Featuring a 13.3" QHD+ infinity display, the XPS 13 has a
3200 x 1800 native resolution.
» 3200 x 1800 13.3" Touchscreen » 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16
Processor RAM Storage Graphics SKU Price

2.46Hz Intel Core i7-55000 | 86B | 25668 SSD_|Intel HD Graphics 5500 DEXPS9343818 |  $1,399.00
2.26Hz Intel Core i5-5200U |  8GB_ | 25668 SSD [Intel HD Graphics 5500]  DEXPS9343636 | $1,249.00

Ienowo ThinkPad X1 Carbon

Thin at just 0.7" and featuring a 10-point multi-touch WQHD
display, the ThinkPad X1 Carbon 14" Multi-Touch Ultrabook
Computer from Lenovo is a system designed for home and
business users who need a reliable system for general use.

» 802.11ac Wi-Fi &Bluetooth 4.0 » Windows 8.1
» Touchcreen Display / 2560 x 1440 resolution » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.6GHz Intel Core i7-5600U 8GB | 51268 SSD | Intel HD Graphics 5500 | LEX1C20BS003 | $1,955.00
2.6GHz Intel Core i7-5600U 86B | 25668 SSD | Intel HD Graphics 5500 | LEX1CTBS003E | $1,729.99

ANTI-GLARE DISPLAY /1920 X 1080 RESOLUTION

Processor RAM Storage Graphics SKU Price
2.66Hz Intel Core i7-5600U 86B | 25668 SSD | Intel HD Graphics 5500 | LEX1CTBS0031] $1,699.99
2.36Hz Intel Core i5-5300U 868 | 25668 SSD | Intel HD Graphics 5500 | LEX1CTBS0032 | $1,359.00
2.2GHz Intel Core i5-5200U 4GB | 1806B SSD | Intel HD Graphics 5500 | LEX1C20BS037 $1,181.00

fenowo ThinkPad T550

Thin at 0.88", the ThinkPad T550 15.6” Ultrabook Computer from
Lenovo is designed for mainstream professionals. The system is
powered by a 2.6 GHz Intel Dual-Core processor, allowing you to
run multiple applications simultaneously.

» 1600 MHz DDR3 RAM  » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 7 Pro + Windows 8.1 License

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.66Hz Intel Core i7-5600U | 8GB | 25668 SSD | Intel HD Graphics 5500 (1920 x 1080) | LET550CK000D| $1,516.99
2.36Hz Intel Core i5-5300U | 8GB | 25668 SSD | Intel HD Graphics 5500 (1920 x 1080) | LETS50CK000K | $1,371.28
2.36Hz Intel Core i5-5300U | 4GB | 51668 | Intel HD Graphics 5500 (1366 x 768) | LETA5020CKOF | $1,025.00
2.26Hz Intel Core i5-5200U | 46B | 51668 | Intel HD Graphics 5500 (1366 x 768) | LETA5020CK0G| $934.22

TOSHIBA KIRAbook 13

The Toshiba KIRAbook 13 13.3" Multi-Touch Ultrabook Computer
features a magnesium alloy enclosure for a durable, ultra-stim and
ultraportable design. Measuring 0.70" thin and weighing just 2.91
pounds, the Toshiba KIRAbook embadies the very definition of an Ultrabook. =
» 2560 x 1600 Touchcreen resolution » 802.11ac Wi-Fi & Bluetooth 4.0 Dl
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.4GHz Intel Core i7-5500U |  8GB | 2566B SSD | Intel HD Graphics 5500 | TOPSUC2U0038 $1,699.99

800-947-5534 + 212-444-6740




TOSHIBA (B35

The silver CB35 Chromebook 13.3" LED-Backlit TFT TruBrite
Display from Toshiba features a textured resin finish in silver.
The 13.3" TruBrite TFT IPS display has a 16:9 aspect ratio and
its resolution can support native 1080p FHD video playback
without upscaling.

» 13.3" LED Display

» 802.11ac Wi-Fi& Bluetooth 4.0 » Chrome 0S

Processor RAM Storage Graphics SKU Price
2.166Hz Intel Celeron N2840 | 4GB | 166B SSD | Intel Graphics (1920 x 1080) | TOCB35B3340 | $299.00

CHROMEBOOKS  COMPUTERS

lenowvo N20P

For a Web-optimized experience, the N20p Chromebook Computer
from Lenovo features a gray finish and a more user-friendly interface
than traditional notebook computers. The Lenovo Chromebook
features a unique computing experience enhanced by the Internet

» 11.6" 1366 x 768 Touchscreen LED Display

» 802.11ac Wi-Fi& Bluetooth 4.0

» Chrome 0S

Processor RAM  Storage Graphics SKU Price
2.16 GHz Intel Celeron N2830] 2GB | 16GB SSD Integrated Intel HD Graphics LE59418460 | $273.52

2.16GHz Intel Celeron N2840 | 26B | 166B.SSD | Intel Graphics (1366 x768) | TOCB35B3330 | $249.00

/iSUS (201
Designed for a Web-optimized experience, the ASUS C201PA-DS02 11.6”
Chromebaok provides a user-friendly interface enhanced by the Internet.
» 11.6" LED Display

» 802.17ac Wi-Fi& Bluetooth 4.0
» Chrome 0S

Processor RAM  Storage Graphics SKU Price
1.8GHz ARM Cortex-A17 | 4GB | 166B SSD | Integrated ARM Mali-T764 Graphics |ASC201PACAT7| $199.00

1.86Hz ARM Cortex-A17 | 2GB | 1668 SSD | Integrated ARM Mali-T764 Graphics |ASC201PADS01] $169.00

acer C1

The €720 11.6" Chromebook Computer from Acer is designed
for a Web-optimized experience. With its user-friendly
interface, the Acer Chromebook offers a unigue computing
experience enhanced by the Internet.

» 11.67 1366 x 768 LED Display

» 802.11a/b/g/n Wi-Fi& Bluetooth 4.0

» Chrome 0S

Processor RAM  Storage Graphics SKU Price
1.706Hz Intel Core i3-4005 | 46B | 326BSSD | Intel HD Graphics 4400 | ACC7203404 $353.48
1.70Hz Intel Core i3-4005 | 46B | 326BSSD | Intel HD Graphics 4400 |  ACC7T203605 | $333.99
acer (B3

The CB3 11.6" Chromebook Computer from Acer is designed
for a Web-optimized experience. With a simpler and more
secure user interface than regular notebook computers, this
Acer Chromebook features a fast and easy online experience.
» 11.6” 1366 x 768 LED Display

» 802.11a/blg/n Wi-Fi

» Chrome 0S

Processor RAM Storage Graphics SKU Price
2.166Hz Intel Celeron N2830 | 26B 1668 SSD Intel HD Graphics | ACCB3111C670 $169.99

acer CBs

» The CB5 13.3" FHD Chromebook Computer from Acer is
designed for a Web-optimized experience. With its user-friendly
interface, the Acer Chromebook offers a unique computing
experience enhanced by the Internet.

» 13.371920 x 1080 LED Display

» 802.11ac Wi-Fi » Chrome 0S

Processor RAM Storage Graphics SKU Price
2.10 GHz NVIDIA Tegra K1 Quad-Core | 4GB | 3268 SSD | Integrated NVIDIA Graphics | ACCB5311T677 | $329.00

2.10 GHz NVIDIA Tegra K1 Quad-Core | 26B | 1668 SSD | Integrated NVIDIA Graphics | ACCBB311T9B0 | $299.00

/iU Chromebook Flip

Designed for a Web-optimized experience, the ASUS Chromebook
Flip 10.1" Multi-Touch Convertible Chromebaok provides a
user-friendly interface enhanced by the Internet.

» 10.1" Touchscreen

» 802.11ac Wi-Fi& Bluetooth 4.0

» Chrome 0S

Processor RAM  Storage Graphics SKU Price
1.86Hz ARM Cortex-A17 | 4GB | 166B SSD |Integrated ARM Mali-T764 Graphics |ASC100PADB0Z| $279.00
1.8GHz ARM Cortex-A17| 26B | 1668 SSD |Integrated ARM Mali-T764 Graphics|ASCT00PADBO1| $234.95

/1SS C300MA 13.3” Chromebook Computer
» Integrated Intel HD Graphics

» 13.3" Matte HD Display

» 1366 x 768 Native Resolution

» Secure Digital Media Card Slot

» 802.11a/b/g/n Wi-Fi & Bluetooth 4.0

» Built-in Webcam, Mic, & Speakers » Chrome 0S

Processor RAM Storage Graphics SKU Price
2.16GHz Intel Celeron N2830 | 26B 1668 SSD Intel Graphics | ASC300MADBO1 $213.99

acer C720p

The Acer C720P 11.6” Touchscreen Chromebook Computer is
designed for both performance and portability. It is only 0.8”
thick for reliable mability and it weighs just 2.98 b.

» 11.6” 1366 x 768 Touchscreen Display

» 802.11a/b/g/n Wi-Fi& Bluetooth 4.0

» Chrome 0S

|

Processor RAM Storage Graphics SKU Price
1.46Hz Intel Celeron 29550 | 4GB | 166BSSD | Intel HD Graphics |  ACC7202625 $327.99
1.46Hz Intel Core 13-40050|  46B | 326BSSD | Intel HD Graphics 4400 | ACC7203605 | $333.99

w XE500C120-K01US

The metallic silver XE5OOC12-K01US
11.6" Chromebook 2 Computer from Samsung is designed for a
Web-optimized experience. With a simpler and more secure user
interface than regular notebook computers, this Samsung Chrome-
book 2 features a fast and easy online experience.

» 11.6" 1366 x 768 LED Display

» 802.11a/b/g/n Wi-Fi

» Chrome 0S

Processor RAM Storage Graphics SKU Price
2.166Hz Intel Celeron N2840 | 26B 1668 SSD Intel HD Graphics | SAXES00C12K0 $230.92

www.BandH.com
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/iSU= K200MA-DS01T

Experience HD visuals and utilize multi-touch gestures with
the black K200MA-DSO1T(S) 11.6” Multi-Touch Notebook
Computer from ASUS. Featuring a 11.6” widescreen touchscreen,
the K200MA has a 16:9 aspect ratio and a 1366 x 768 native
resolution, which is powered by integrated Intel HD Graphics
and has native support for 720p HD content. The screen also has
a glossy finish for vibrant color.

» 1366 x 768 Touchscreen resolution

» 801.11 b/g/n » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
2.16GHz Intel Celeron N2840 | 4GB | 500GB 5.4k

Graphics SKU Price
Intel HD Graphics ASK200MASB | $299.00

/iSUS enBook

The ASUS ZenBook 13.3" Notebook Computer features the signature
concentric-circle pattern that was redesigned with a durable,
scratch-resistant Corning Gorilla Glass finish.

» 13.3" Multi-Touch Display » 1600 MHz DDR3 RAM

» 802.11ac Wi-Fi& Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.46Hz Intel Core i7-5500U | 1268 | 51268 SSD | NVIDIA GeForce GT 940M (3200 x 1800) | ASUX303LBDS7 | $1,249.99
2.26Hz Intel Core 5-5200U | 8GB | 25668 SSD | Intel HD Graphics 5500 (1920 x 1080) |ASUX303LADS5| $849.99
2.26Hz Intel Core 5-5200U | 8GB | 25668 SSD | Intel HD Graphics 5500 (3200 x 1800) | ASUX303LAS1T| $999.00

/NSUS EeeBook

Experience HD visuals with the blue EeeBook 11.6” Notebook
Computer from ASUS, powered by a quad-core Bay Trail-T 1.33 GHz
Intel Atom Z3735F processar.

» 1366 x 768 resolution » 1333MHz DDR3 RAM

» 801.11b/g/n & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage
1.33GHz Intel Atom Z3735F | 26B | 32GB SSD

w ATIV Book 9
Combining a high resolution display and

studio-quality audio into a thin, lightweight design, the Samsung
ATIV Book 9 12.2" Notebook Computer provides quality, performance,
and portability in an imperial black full-aluminum body.

» 900MHz Intel Core M 5Y31

» 2560 x 1600 resolution » 8GB 1600 MHz DDR3 RAM

» Intel Graphics 5300 » 801.17ac & Bluetooth 4.0

Graphics SKU Price
Intel HD Graphics ASX205TADSBL| $199.99

1-13” WINDOWS NOTEBOOKS

Stream 13.3”

The Stream 13.3" 13-c010nr Notebook Computer
from HP features a 13.3" widescreen display featuring LED
backlighting for lower power consumption.

» 1366 x 768 resolution

» hs3114 HSPA+ Mobile Broadband (HEK2L97UA only)

» 801.11 b/g/n & Bluetooth 4.0 » SuperMulti DVD Burner
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.166Hz Intel Celeron N2840 | 26B | 3268 SSD Intel HO Graphics HEK2L97UA | $299.00
2.166Hz Intel Celeron N2840 | 26B | 326BSSD | Intel HD Graphics | HEKZL96UA | $229.00

) Stream 11.6”
The Stream 11.6” 11-d010nr Notebook Computer from

HP has eMMC storage and a fanless design for users who want to
store their content in the cloud so that they may access their
data from almost anywhere.
» 1366 x 768 resolution
» 801.11 b/g/n & Bluetooth 4.0 » Windows 8.1
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
2.16GHz Intel Celeron N2840 | 2GB | 32GB SSD

Graphics SKU Price
Intel HD Graphics HEK2L95UA | $199.00

aCET Aspire E11ES1-111M

The Aspire E 11 EST-111M 11.6” Notebaok Computer from Acer
features an 11.6” Active Matrix TFT color LCD LED backlight display.
» 1366 x 768 resolution » 1600 MHz DDR3 RAM

» 802.11b/g/n » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
2.166Hz Intel Pentium N3540| 2GB | 25068
2.166Hz Intel Celeron N2840 | 26B | 3326B SSD |

Graphics
Intel Graphics
Intel Graphics

|ACESTITIMC40] $189.00

aCES Aspire V3-112P-C2HF

The Aspire V3-112P-C2HF 11.6” Multi-Touch Notebook Computer
from Acer is built to offer a wide variety of features for both
home and office use.

» 1366 x 768 Touchscreen display

» 802.17b/g/n » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

> Windows 10 Processor RAM  Storage Graphics SKU Price
1.836Hz Intel Celeron N2940 | 4GB | 5006B Intel Graphics 5500 ACV3112PC2HF| $309.00
[SANP930X2K4) $1,297.99
Ilenowvo 521e aCES Aspire V3-371
Thin at 0.74" and designed for those with an on-the-go lifestyle, The white Aspire V3-37113.3" Notebook Computer from Acer is
the S21e 11.6” Notebook Computer from Lenovo is powered by a built to offer a wide variety of features for both home
2.16 GHz Intel Celeron N2840 Dual-Core processor that allows you and office use.
to run multiple applications simultaneously. » 1366 x 768 resolution » 801.11 a/b/g/n
» 1366 x 768 resolution » Bluetooth 4.0 (ACV337175UN only)
» §02.11b/g/n Wi-Fi &Bluetooth 4.0 » Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16
» Get A Free Upgrade To Windows 10 valid until 07/29/16
Processor RAM Storage Graphics SKU Price
Processor RAM  Storage Graphics SKU Price 2.46Hz Intel Core i7-5500U | 12GB 118 Intel HD Graphics 5500 ACV3371750N | $799.99
2.166Hz Intel Celeron N2840 | 26B | 326B SSD Intel Graphics LEBOMA00 | $206.95 1.7GHz Intel Core i5-4210U \ 868 \ 118 \ Intel HD Graphics 4400 \ ACV337156R5 \ $639.99

800-947-5534 + 212-444-6740




7 Elitebook Folio

The HP EliteBook Folio 14" computer is a 3.56 Lb notebook
that features allow you to run your applications while on the road, at
home, or at work.
» 1600 MHz DDR3 RAM
» 802.11ac Wi-Fi& Bluetooth 4.0
» Windows 7 Pro

Processor RAM  Storage Graphics SKU Price

2.66Hz Intel Core i7-5600U | 868 | 2566B SSD | Intel HD Graphics 5500 (1920 x 1080) | HEL6LBAUT | $1,779.99

14” WINDOWS NOTEBOOKS

2.16Hz Intel Core i7-4600U | 86B | 25668 SSD | Intel HD Graphics 4400 (1600 x 900) | HEJSPBOUT | $1,486.00

26Hz Intel Core 5-4310U | 4GB | 25668 SSD | Intel HD Graphics 4400 (1366 x 768) | HEJSP78UT | $1,265.00

2.2 GHz Intel Core i5-5200U| 4GB | 1286B SSD | Intel HD Graphics 5500 (1600 x 900) | HELBDATUT | $1,209.19

1.76Hz Intel Core 5-4210U | 4GB | 500GB 7.2k | Intel HD Graphics 4400 (1366 x 768) | HEJSPRIUT |  $947.00

7 Elitebook 840
Stay productive while you travel with the HP Elitebook 840 G2
13275UT#ABA 14" Notebook Computer. he display can playback HD 720p
video without letterboxing. The screen also has an antiglare finish so
you'll be able to use the Elitebook in brightly lit environments.
» 1600 MHz DDR3 RAM » 801.11ac & Bluetooth 4.0
» Windows 7 Pro & Windows 8.1 License

Processor RAM  Storage Graphics SKU Price
2.26Hz Intel Core i5-5200U | 468 | 1286B SSD | Intel HD Graphics 5500 (1600 x 900) | HEL3Z76UT | $914.76

2.26Hz Intel Core i5-5200U | 4GB | 50068 7.2k | Intel HD Graphics 5500 (1366 x 768) | HEL3Z75UT | $879.99

7) ProBook 640
The HP ProBook 640 14" Notebook PC is for use at home,

school, and work. It packs an Intel Core i5-4210M processor with
integrated Intel HD 4600 graphics to offer performance for publishing,
web browsing, and other important tasks.
» 1366 x 768 resolution » 1600 MHz DDR3 RAM
» SuperMulti DVD Burner » 801.11 b/g/n & Bluetooth 4.0
» Windows 7 Pro

Processor RAM Storage Graphics SKU Price
2.66Hz Intel Core i5-4210M 4GB 50068 7.2k Intel Graphics 4600 HEKAL16UT | $778.99

() ProBook 640

7) ProBook 440
Thin at 0.91" and built with soft touch paint on the LCD and

a brushed aluminum keyboard deck, the 14" ProBook 440 62 Notebook
from HP is designed for those who require powerful performance
whether in their office or on the go.
» 1366 x 768 resolution » 8GB 1600 MHz DDR3 RAM
» Intel Graphics 5500 » SuperMulti DVD Burner
» 802.11ac Wi-Fi & Bluetooth 4.0 » Windows 10

Processor Storage SKU Price
2.4 GHz Intel Core i7-5500U 12868 SSD HE440P3E3TUT $869.00

2.2 GHz Intel Core i5-5200U | S00GB5.4k | HEAOPIE3IUT | $749.00

Panasonic. Toughbook 53

The Toughbook 53 14” Lite Notebook from Panasonic features a strong
magnesium alloy case with a hand strap, a shock-mounted flex-connect
hard drive with a quick-release option, and a spill-resistant design to
ensure all your important documents, files, and data are safe and secure.
» 1366 x 768 resolution » 1600 MHz DDR3 RAM

» SuperMulti DVD Burner » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 7 Pro & Windows 8.1 License

Processor RAM  Storage Graphics SKU Price
2.0GHz Intel Core i5-4310U| 4GB | 50068 7.2k | Intel Graphics 4400 (Touchscreen) | PAB3ZSLZYCM | $1,969.99

2.0GHz Intel Core ib-4310U| 4GB | 50068 7.2k Intel Graphics 4400 PACFS32ALZYC | $1,580.81

2.0GHz Intel Core i5-4310U| 4GB | 32068 5.4k Intel Graphics 4400 PACF532JCZYC | $1,205.99

COMPUTERS

Ienowvo ThinkPad T440p

The ThinkPad T440p 14" Notebook Computer from Lenovo is a system
designed for use in home, school, and on-the-go environments. It is well
suited for web browsing, document creation, and multimedia playback.
» 801.11ac (LET440P20ANO only)

» Bluetooth 4.0 » SuperMulti DVD Burner

» Windows 7 Pro & Windows 8.1 License

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.96Hz Intel Core i7-4600M| 868 | 24068 SSD |NVIDIA GeForce GT 730M (1600 x 900)| LET440P20ANO | $1,471.99
2.66Hz Intel Core i5-4210M| 4GB | 5006B 7.2k | Intel HD Graphics 4600 (1366 x 768) | LET440P20AND | $715.00

Ienowvo ThinkPad E455

The ThinkPad E455 14" Notebook Computer from Lenovo is a system designed
for use in home, school, and on-the-go environments. It is well suited for web
browsing, document creation, and multimedia playback.
» 1366 x 768 resolution

» 801.11 b/g/n & Bluetooth 4.0

» Windows 7 Pro & Windows 8.1 License

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.2GHz AMD A6-7000 4GB |5006B 5.4k|  AMD Radeon R4 LEE45520DE00 $354.00

Ilenowvo 54170

Thin at 0.77" and designed for those with an on-the-go lifestyle,
the S41 14" Noteboak from Lenovo is powered by a 2.4 GHz Intel
Core i7-5500U Dual-Core processor that allows you to run multiple
applications simultaneously.

» 1600 MHz DDR3 RAM

» §02.11ac Wi-Fi& Bluetooth 4.0

» Windows 10

Processor RAM Storage Graphics SKU Price
2.4GHz Core i7-5500U |  8GB 118 Intel Graphics 5500 | LESA417080JUD $779.99

Ienowvo ThinkPad E450

The ThinkPad E450 14" Notebook Computer from Lenovo is a
system designed for use in home, school, and on-the-go environ-
ments. It is well suited for web browsing, document creation, and
multimedia playback.

» 1600 MHz DDR3 RAM > 802.11ac Wi-Fi& Bluetoath 4.0

» Windows 7 Pro & Windows 8.1 License

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.26Hz Intel Core i5-5200U| 4GB | 500GB 7.2k | Intel Graphics 5500 | LEE45020DC00 $535.00
1.76Hz Intel Core i3-4005U| 4GB | 5006B7.2k | Intel Graphics 4400 | LEE50DC003W | $479.00

FUJITSU LIFEBOOK E744

The LIFEBOOK E744 14” Notebook Computer from Fujitsu features
a 14" widescreen display that has a 16:9 aspect ratio that allows
720p HD content to be played natively on the LIFEBOOK E744
without upscaling or letterboxing.

» 1600 x 900 resolution » 1600 MHz DDR3 RAM

» 801.11 b/g/n &Bluetooth 4.0 » Windows 8.1

Processor RAM Storage Graphics SKU Price
2.56Hz Intel Core i5-4200M 4GB 50068 5.4k | Intel HD Graphics 4600 | FUE744001 | $1,029.00

www.BandH.com
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Ienowo ThinkPad 540p

The ThinkPad 540p 15.6" Notebook Computer from Lenovo delivers bath in terms

of performance and mobility. The ThinkPad T540p provides a 9-cell Lithium ion

battery for up to 11 hours per charge. The ThinkPad Th40p features a

glass-fiber reinforced plastic body for a portable yet durable design.

» 1920 x 1080 resolution » 802.17ac Wi-Fi » 1600 MHz DDR3 RAM » Windows 7 Pro
» SuperMulti DVD Burner » Get A Free Upgrade To Windows 10 valid until 07/29/16

TOSHIBA 55

The satin gold 15.6” Satellite S55-C5262 Notebook from Toshiba has a
brushed aluminum finish and is designed for multimedia lovers,
gamers, and heavy multitaskers who are looking for a powerful laptop.
» 1920 x 1080 resolution » 1600 MHz DDR3 RAM

» SuperMulti DVD Burner » 802.11n Wi-Fi & Bluetooth 4.1

» Windows 10

Processor RAM  Storage Graphics SKU Price Processor RAM  Storage Graphics SKU Price
2.9GHz Intel Core i7-4600M | 8GB | 240GB SSD | NVIDIA GeForce GT730M | LET540P20BE | $1,432.96 2.4 GHz Intel Core i7-5500U | 12GB | 1TB 5.4k NVIDIA GeForce 950M T0S55C5262 $899.99
2.6GHz Intel Core i5-4300M | 46B | 500GB 7.2k Intel Graphics 4600 LETH40P20BEE | $1,106.99
2.6GHz Intel Core i5-4210M | 468 | 50068 7.2k Intel Graphics 4600 LET540P20BED |  $784.59

Ilenowvo Y5

The Y50 15.6” Notebook from Lenovo features an Ultra HD 4K display. The
screen has a 16:9 aspect ratio and a 3840 x 2160 native resolution, which
can play back 4K content without upscaling or letterboxing.

» 2.66Hz Haswell CPU » 1TB 5400rpm w/ 868 SSD

» NVIDIA GeForce GTX 960 2GB » DVD+/- RW

» 802.17ac Wi-Fi &Bluetooth 4.0 » Windows 10

1668 (LEY505944505)
868 (LEY505944504)

$1,159.99
$1,079.82

Ilenowvo ThinkPad E550 / E555

ThinkPad E550 /E555 15.6” Notebook series from Lenovo has strong mability that is
designed for business use. However, it is also well suited for web browsing, email,
document creation, and multimedia playback.

» DVD+/-RW » 1600 MHz DDR3 RAM

» 802.11ac Wi-Fi & Bluetooth 4.0 » DVD+/- RW
» Windows 7 Pro & Windows 8.1 License » Get A Free Upgrade To Windows 10 valid until 07/29/16
E550

Processor RAM  Storage Graphics SKU Price

TOSHIBA $55T
The satin gold Satellite ST 15.6” Touchscreen Notebook series from
Toshiba contains a powerful processor and discrete graphics, despite
being less than 1" thin. If you need more power, the CPU can be
overclocked to 3.5 GHz, and the system’s 1600 MHz DDR3L RAM allows
the computer to quickly access frequently-used files and programs.
» 1366 x 768 Touchcreen resolution
» 802.11ac Wi-Fi & Bluetooth 4.0
» 1600 MHz DDR3 RAM » Windows 10
Processor RAM Storage SKU Price
2.86Hz Intel Core i7-4720HQ 1268 118 T0S55TCH250 $1,129.00

TOSHIBA L55WH

The Satellite L65W 15.6" Touchscreen Notebook series from Toshiba is an
affordable go-to system for those looking for a full-featured PC for
everyday tasks, such as Internet browsing, email, document creation

and editing, and multimedia playback.

» 1366 x 768 Touchcreen resolution

» 802.11b/g/n Wi-Fi & Bluetooth 4.0

» 1600 MHz DDR3 RAM

2.46Hz Intel Core i7-5500U | 8GB | 50068 7.2k | AMD Radeon R7 M620 (1920x1080) | LEES50200F40 | $755.00 > Windows 10 » DVD+/- RW
2.26Hz Intel Core i5-5200U | 468 | 50068 7.2k | Intel Graphics 500 (1366x768) | LEES5020DF30 | $599.00 Processor RAM Storage SKU Price
1.76Hz Intel Core i3-4005U | 468 | 50068 7.2k | _Intel Graphics 4400 (1366x768) | LEES5020DF00 | $459.00 2.26Hz Intel Core i5-5200U 88 1TB 5.4k TOLBEWC5256 $709.99
E555

Processor RAM  Storage Graphics SKU Price TOSHIBA C5

1.96HzAMDATD | 46B | 5006B5.4k | AMD Radeon R7 M260DX (1366x768) | LEESG520DH2T | $486.00

2.26HZAMD A6-7000 | 4GB | 500GB5.4k | AMD Radeon R4 (1366x768) | LEE55520DH00 | $369.00

Ilenowo ThinkPad E550 / E555

The black ThinkPad E550 / E555 series 15.6” Notebook Computer
from Lenovo is designed for small business, enterprise, and education
users. Itis well suited for web browsing, email, document creation,
and multimedia playback.

» 4GB RAM » 15.6” 1366x768 LED Display » 500GB » Bluetooth 4.0 » Windows 10

802.11ac Wi-Fi
802.11b/g/n

ThinkPad E550 | 2.2 GHz Intel i5 5200U | Intel Graphics 5500
ThinkPad E555 | 3 GHz AMD A6-7000 | AMD Radeon HD R |

LEE56020DFC4 | $683.02
| LEEB5520DH3C | $524.83

CES Aspire V3

Power your gaming and entertainment needs with the Aspire V3 from Acer that
features the Intel Core Broadwell processor. When you need additional storage,
connect an optional external storage drive to one of the three USB ports.

» 1920 x 1080 resolution » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

The Satellite 55 15.6” Notebook Computer from Toshiba features a
textured resin design with a jet black finish. The 15.6" TruBrite LED-
backlit display has a 16:9 aspect ratio with native support for 720p

HD content. You can also output video to an external display via the
HDMI port.

» 1600 MHz DDR3 RAM > 802.11ac Wi-Fi & Bluetooth 4.0

» 366 x 768 Touchcreen resolution » 802.11b/g/n Wi-Fi & Bluetooth 4.0
» 1600 MHz DOR3 RAM » Windows 10 » DVD+/- RW

Processor RAM Storage SKU Price
2.2GHz Intel Core i5-5200U 868 118 T0C55CH246 $599.99
2.2GHz AMD A8-7410 66B 118 T0CH5DTCH245 $499.99
2.16GHz Pentium N3540 4GB 75068 5.4k T0CH5B5242X $329.00
2.16GHz Celeron N2840 4GB 50068 5.4k TOCh5BH240X $299.99

SCEr Aspire VNitro

The Aspire V Nitro 15.6” Notebook from Acer is a system designed to
handle graphics-intensive and multimedia applications. If you need more
power, the processor can be overclocked to 3.6 GHz.

» 1366 x 768 resolution

» 802.11ac Wi-Fi &Bluetooth 4.0 » Windows 8.1

Processor RAM _ Storage Graphics SKU Price . S
2.2 GHz Intel Core i5-5200U | 86B | 118 Intel Graphics 5500 ACVIST2PS94C | $679.00 » Get A Free Upgrade To Windows 10 valid until 07/29/16
2.4 Gz Intel Core i7-55000 | 1668 | 1TB | NVIDIA GeForce GTX840M | ACV357267308 | $999.99 Processor RAM  Storage Graphics SKU Price
2.4 GHz Intel Core i7-55000_| 1268 | 178 Intel Graphics 5500 ACV35727502 | $769.00 2.2 6Hz Intel Core i5-52000 | 86B | 17B5.4k | NVIDIA GeForce GTX950M | ACVNTSTIG756 | $979.99
2.2 GHa Intel Core 5-52000_| 1268 | 178 Intel Graphics 5500 ACVISTISIRA | $644.49 2. GHzIntel Core i5-52000 | 66B_| 11B5.4k | NVIDIA GeForce GTX950M | ACVNTS71G5IN | $799.99
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/iS50 Ienbook

The silver/aluminum Zenbook NX500JK-XH72T 15.6” 4K Notebook
Computer from ASUS is designed for high-performance graphics
applications as well general use, including Internet browsing,
document creation, and multimedia playback.

» 3840 x 2160 Touchcreen resolution » 1600 MHz DDR3 RAM

» 802.11ac Wi-Fi » Windows 8.1 Pro

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
2.3 GHz Intel Core i7-4712HQ | 8G6B | 512GB SSD

Graphics SKU Price
NVIDIA GeForce GT 850M |  ASNXG00JKXH7 | $2,649.00

15”7 WINDOWS NOTEBOOKS

/iSU=S Nb50JX

Experience Full HD with the silver ASUS N550JX-DS71T
15.6” Multi-Touch Notebook. The display has a 16:9 aspect
ratio and a 1920 x 1080 native resolution, which can play
back 1080p content without upscaling or letterboxing.

» 1920 x 1080 Touchcreen resolution

» 1600 MHz DDR3 RAM » SuperMulti DVD Burner

» 802.11ac Wi-Fi& Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.6GHz Intel Core i7-4720H0 | 166GB | 240B SSD | NVIDIA GeForce GTX 950M | ASN550JDS74T | $1,264.00

2.66Hz Intel Core i7-4720H0 | 868 | 1TB5.4k | NVIDIA GeForce GTX 950M | ASNS50UDSTIT | $949.00

Ienowvo Fex

Featuring a unique dual-mode design, the black Flex 2-15 59418262 Dual-
Mode 15.6" Touchscreen Notebook Computer from Lenovo is a system whose
screen can rotate 300° to vary between laptop mode and stand mode.

» 1600 MHz DDR3 RAM » 802.11ac Wi-Fi & Bluetooth 4.0

» DVD+/- RW » Windows 8.1E550

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
1.76Hz Intel Core i5-42100 | 6GB | 500GB 5.4k | Intel Graphics 4400 (1920x1080) | LEFLEX218262 | $659.00

1.9GHz Intel Core i3-4030U_| 46B_| 500GB 5.4k | Intel Graphics 4400 [1366x768) | LEF215594400 | $529.99

lenowvo 650

» 2.4 GHz Intel Core i7-5500U Dual-Core
» 86B DDR3 RAM

» 1TB Hard Drive

» Intel HD Graphics 5500

» 15.6” 1366 x 768 LED-Backlit Display
» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10 Home

(LEG508080E50)

$699.99

msi CXol

The MSI CX61 2QC-1654US 15.6” Notebook comes outfitted with a
dedicated NVIDIA GeForce GT920M graphics card and an Intel Core
i5-4210M processor. These features make it suitable for use as a |
ight gaming system, multimedia entertainment center, and more.
» 1366 x 768 resolution

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
2.6GHz Intel Core i5-4210M | 86B | 75068 5.4k

Graphics SKU Price
NVIDIA GeForce GT920M | MSCX61201654 | $671.66

COMPUTERS

Beats Special Edition

The Beats Special Edition 15-p030nr 15.6” Multi-Touch Notebook
Computer from HP is designed to provide an immersive audio experience.
HP teams up with Beats Audio to provide built-in stereo speakers and an
integrated subwoofer for added bass.
» 1366 x 768 Touchscreen resolution » SuperMulti DVD Burner
» 80111 b/g/n &Bluetooth 4.0 » Windows 8.1
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
1.7GHz AMD A8-5545M 8GB 178 5.4k

Graphics SKU Price
AMD Radeon HD 8510G | HEG6RT4UA $574.00

Pro Book 455 62
Thin at 0.92" and built with soft touch paint on the LCD and a

brushed aluminum keyhoard deck, the 15.6” ProBook 455 62 Notebook @m@

from HP is designed for those who require powerful performance and

reliability for their workday.

» 2.0 GHz AMD A10-7300 Quad-Core AP

» AMD Radeon Ré Graphics » 15.6 1366 x 768 LED Display

» 802.17n Wi-Fi& Bluetooth 4.0 » Windows 10
RAM Storage SKU Price
8GB 500GB 7.2k HE455P3E33UT $615.99
W 12868 55D | HE455P3E34UT \ $570.00
7 Envy 15

The HP Envy 15-k081nr TouchSmart 15.6” Multi-Touch Notebook
Computer offers powerful processing, audio, and video performance.
» 1920 x 1080 Touchscreen resolution
» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage
2.5GHz Intel Core i7-4710HQ | 8GB | 1TBb.4k

Graphics SKU Price
Intel HD Graphics 4600 | HEEN15KO8TNR $899.00

@ Inspiron 15

The Dell Inspiron 15 5558 Multi-Touch Notebook's features a
15.6" LED-backlit touchscreen, which supports multi-touch gestures
incorporated into Windows 10.

» 1920 x 1080 resolution » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10

Processor RAM  Storage Graphics SKU Price
2.46Hz Intel Core i7-5500U | 16GB | 1TBb.4k Intel HD Graphics 5500 | DEIR5588571S | $849.99
2.4 GHz Intel Core i7-5500U | 8GB 118 Intel HD Graphics 5500 | DEIB5586435S | $749.00
2.2 GHz Intel Core i5-5200U | 12GB 118 Intel HD Graphics 5500 | DEIn5586434S | $729.99
2.2 GHz Intel Core i5-5200U | 8GB 118 Intel HD Graphics 5500 | DEIS5584287TW | $599.99
2.16GHz Intel Pentium N3540 | 4GB | 500GB b.4k Intel HD Graphics DEIB55133338 | $429.99

@ Inspiron 5000
The Dell Inspiron 15 i5555-1143blk Notebook features a 15.6”

LED-backlit screen with TrueLife, which offers a 10% higher contrast ratio
than a typical display.

» 1600 MHz DDR3 RAM > SuperMulti DVD Burner

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage
2.5GHz AMD A8-7410  |8GB| 1TB 5.4k

Graphics SKU Price
AMD Radeon R5 | DEI55551143B $479.99
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COMPUTERS

MacBook Pro

The Apple® MacBook Pro® with 13.3" Retina®
display is a powerful notebook computer with

an innovative, ultrathin, ultraportable aluminum
unibody design. It is loaded with advanced power
management features and an integrated Lithium
polymer battery, which work together to provide

Apple MacBook Lineup

¢ Authorized Reseller

MacBook Air

The Apple® MacBook Air® is an ultraportable
notebook computer with a thin and lightweight
design. Apple engineers have leveraged the les-
sons they learned in designing the miniaturized
iPad® and applied them to the design of this
2.38-pound computer.

up to 9 hours of wireless web browsing. =
» 1366 x 768 resolution

» Thunderbolt 2 & USB 3.0 ports
» Flash storage
» 802.11ac Wi-Fi & Bluetooth 4.0

» LED backlit IPS glossy finish

» 2560 x 1600 resolution

» Thunderbolt 2, HDMI & USB 3.0 ports
» 1866 MHz DDR3 RAM » Flash storage

» 802.11ac Wi-Fi & Bluetooth 4.0

» Backlit chiclet keyboard

» Mac 0S® X 10.10 Yosemite

» Intel Iris Graphics yet durable design.

» Backlit standard keyboard
» Mac 0S® X 10.10 Yosemite
» Intel Graphics 6000

1.6”
13.3” Processor RAM Storage SKU Price
Processor RAM Storage SKU Price 1.66Hz Intel Core i 868 51268 APMBAZOMJVP3 $1,494.00
2.7GHz Intel Core 15 1668 25668 APMBPMFB40T $1,689.99 1.66Hz Intel Core i5 468 51268 APMBAZOMUVP1 $1,394.00
2.7GHz Intel Core i5 1668 12868 APMBPMF8391 $1,474.00 1.66Hz Intel Core 5 868 75668 APMBAZOMJVP2 $1,179.00
2.7GHz Intel Core i 868 25668 APMBPMF840LL $1,399.00 1.66Hz Intel Core i5 4GB 25668 APMBAMJVP2LL $999.99
2.76Hz Intel Core i3 868 12868 APMBPMFB39LL $1,199.99 1.66Hz Intel Core i5 868 12868 APMBAZOMJVM? $974.00
1.66Hz Intel Core 15 468 12668 APMBAMJVMILL $799.99
2.9GHz Intel Core i5 1668 178 APMBPMF8415 $2,479.00
2.9GHz Intel Core i5 88 178 APMBPMF8414 $2,249.00 2.26Hz Intel Core i7 868 51268 APMBAZOMIVPS $1,624.00
2.9GHz Intel Core i 1668 51268 APMBPMF8411 $1,979.99 2.26Hz Intel Core i7 868 25668 APMBAZOMJVPS $1,329.00
2.96Hz Intel Core ib 86B 51268 APMBPMF841LL $1,699.99 2.26Hz Intel Core i7 4GB 25668 APMBAZOMJVP4 $1,249.00
2.96Hz Intel Core i 1668 25668 APMBPMF8403 $1,779.00 2.26Hz Intel Core i7 868 12868 APMBAZOMJVM3 $1,129.00
2.9GHz Intel Core i5 1668 12868 APMBPMF8393 $1,594.00 2.26Hz Intel Core i7 468 12868 APMBAZOMJVM1 $1,049.00
2.9GHz Intel Core i5 868 25668 APMBPMF402 $1,569.99
13.3”
3.1GHz Intel Core i7 166B 118 APMBPMF8417 $2,669.99 Processor RAM Storage SKU Price
3.16Hz Intel Core i7 868 178 APMBPMF416 $2,479.99 1.66Hz Intel Core 15 968 51268 APMBAZOMJVG3 $1,559.00
3.16Hz Intel Core i7 1668 51268 APMBPMF8413 $2,169.00 1.66Hz Intel Core i5 468 51268 APMBAZOMUVG1 $1,494.00
3.16Hz Intel Core i7 868 51268 APMBPMF412 $1,979.00 1.66Hz Intel Core 5 868 26668 APMBAZOMUVG? $1,274.00
3.16Hz Intel Core i7 1668 25468 APMBPMF8405 $1,879.99 1.66Hz Intel Core 15 468 75668 APMBAMIVGILL $1,099.99
3.1GHz Intel Core i7 1668 12868 APMBPMF8395 $1,729.00 1.66Hz Intel Core i5 868 12868 APMBAZOMJVE] $1,074.00
3.16Hz Intel Core i7 868 25668 APMBPMF8404 $1,799.00 1.66Hz Intel Core i5 468 12668 APMBAMVEZLL $899.99
3.16Hz Intel Core i7 868 12868 APMBPMF839 $1,599.00
2.26Hz Intel Core i7 868 51268 APMBAZOMIVGS $1,724.00
. I 2.26Hz Intel Core i7 468 51268 APMBAZOMIVGT $1,649.00
;mggzls;?:;?;;ﬁ;ef alrvtlwt‘htlljé’ptiuns L26Hz Intel Core 7 468 15668 APMBAZOMVGS §1,426.00
o he 133 withth following exceptions 2.26Hz Intel Core i7 468 25668 APMBAZOMIVG4 $1,344.00
: 2.26Hz Intel Core i7 868 12668 APMBAZOMJVE3 $1,24.00
2.26Hz Intel Core 17 468 12868 APMBAZOMUVEZ $1,144.00
» LED backlit IPS glossy finish
» 2880 x 1800 resolution
» 1600 MHz DDR3 RAM MacBook
» Intel Iris Pro or AMD Radeon RS graphics - = With a Retina® display and a thin, lightweight design, the Apple® 12" MacBook® provides both portability
15.4” and performance. Measuring just 0.5” (13.1 mm) thin and weighing just 2 pounds, the MacBook is
Processor RAM A T SKU Price compact yet still has a premium feel, thanks to its unibody design.
2.26Hz Intel Core 17| 1468 118 Intel Iris Pro APMBPMJLOZ | $2,799.00 .
L6HzIntel Core 77 | 1668 | 51268 ItellisPro | APMBPMILOZ | $2,239.00 : ﬁg‘émg fesolution
226z Intel Core 17 | 1668 25668 ItellisPo | APMBPMJLOZLL |  $1,815.00 por
» Flash storage
256Hz Intel Core 7 | 1468 11 Radeon RO M370K | APMBPMILTZZ | $2,949.00 » 80.1ac Wi-Fi & Bluetooth 4.0
256z Intel Core 17 | 1668 178 Intel Iis Pro APMBPMILOZ6 | $2,799.00 7 Backlit standard keyboard
LG ielCore7 | 1668 | 51768 | RadeonROMIOK | APMBPMULIZLL |  $2,349.00 > Mac 03° X 10.10 Yosemite B i i
L5GHz Intel Core 7| 1668 | 51268 tellris P | APMBPMILOZS |  $2,249.00 » Intel Graphics 5300
256z Intel Core i7 | 1668 25668 Intel Iris Pro APMBPMJLOZT | $1,999.00
Processor RAM Storage Price
2.86Hz Intel Core i7 | 1668 178 Radeon RY M370X | APMBPMJLTZG |  $3,149.00 1.1GHz Intel Core M 868 25668 $1,199.00
2.86Hz Intel Core 17 | 1668 178 Intel Iris Pro APMBPMJLOZS | $2,999.00 1.36Hz Intel Core M 868 25668 $1,535.00
2.86Hz Intel Core i7 | 1668 51268 | RadeonROM3TOX | APMBPMILTZ3 |  $2,649.00 1.26Hz Intel Core M 88 51268 $1,495.00
2.86Hz Intel Core 17 | 1668 51268 Intel ris Pro APMBPMJLOZ | $2,599.00 1.36Hz Intel Core M 88 51268 $1,735.00
286z Intel Core i7 | 1668 75668 Intel Iris Pro APMBPMILOZ2 | $2,239.00 “aiable I Gold, Siver orSpace Gray

Apple, MacBook, MacBook Air, MacBook Pro, Retina, Mac 0S, iPad are trademarks of Apple Inc. TM and © 2015 Apple Inc. All rights reserved.
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@ Inspiron 17 5000
The silver Inspiron 17 5000 Series 15749-1111SLV 17.3" Notebook

Computer features a dual-core bth generation Broadwell CPU, a
multi-format media card reader and built-in stereo speakers.

» 1600 MHz DDR3 RAM » 802.11ac (DEI57585714S only)

» 802.11b/g/n Wi-Fi & Bluetooth 4.0

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.2GHz Intel Core i5-5200U | 86B | 178 5.4k |Intel HD Graphics 5500 (1920 x1080 touchscreen) | DEI57585714S |$769.00
2.06Hz Intel Core i3-5005U | 4GB |500GB 6.4k | Intel HD Graphics 5500 (1600 x 900) | DEIG74911115 |$469.99

7 Envy 17-j140us
The ENVY 17-j140us TouchSmart 17.3" Multi-Touch
Notebook Computer from HP features a 17.3" HD+ BrightView
widescreen display, which is also a touchscreen so you'll be able
to utilize the multi-touch gestures
» 1600 x 900 Touchscreen resolution
» SuperMulti DVD Burner
» 802.11ac Wi-Fi & Bluetooth 4.0 » Windows 8.1
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage
2.56Hz Intel Core i7-4710MQ [ 126B | 178 5.4k

Graphics SKU Price
Intel Graphics 4600 HEET7J140US | $979.00

TOSHIBA Satellite L75

The Satellite L75-B7240 17.3" Notebook Computer from Toshiba
features a satin gold finish with a Fusion design.

» 1600 MHz DDR3 RAM

» SuperMulti DVD Burner

» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10
Processor RAM  Storage Graphics SKU Price
2.26Hz Intel Core i5-5200U | 86B | 17B 5.4k Intel Graphics 4400 T0L75C7234 | $669.00

SCES Aspire ES1

The black Aspire ES117.3" Notebook Computer from Acer is built to
offer a wide variety of features for bath home and office use.

» 1600 x 900 resolution » DVD Burner

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Windows 8.1

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage
1.66Hz Intel Pentium N3700 | 868 | 50068
1.836Hz Intel Celeron N2940 | 46B | 50068 |

Graphics SKU Price
Intel HD Graphics ACESI7316P1L| $499.99
Intel HD Graphics | ACES1711C73L| $379.00

/iSUS M32AD

» 2.4 GHz Intel Core i7-5500U (Broadwell

» 868 of 1600 MHz DDR3LRAM » 1TB 7200 rpm Hard Drive
» NVIDIA GeForce GTX 950M GPU (26B)

» 17.3" Full HD Matte Display

» 1920 x 1080 Native Resolution » SuperMulti DVD Burner
» 802.11b/g/n Wi-Fi, Bluetooth 4.0

» Built-in Webcam, Mic, & Speakers » Windows 8.1 (64-bit)

(ASX751LXDB71) $883.70

www.BandH.com

COMPUTERS

/iU Republic of Gamers GL551JW
Experience Full HD with the black ASUS Republic of Gamers
GL551JW 15.6” Notebook Computer. The display has a 16:9
aspect ratio and a 1920 x 1080 native resolution, which can
play back 1080p content without upscaling or letterboxing.
» 2.66Hz Intel Core i7-4720HQ » 16GB

» NVIDIA GeForce GTX 960M » 1920 x 1080 resolution

» SuperMulti DVD Burner » 801.11b/g/n & Bluetooth 4.0
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

IPS DISPLAY AND 802.11AC WIFI (ASGL551JWDS)
ASGL561JWDS7

$1,239.09
$1,014.99

/iU Republic of Gamers 675

With the black ASUS Republic of Gamers 675 Gaming Notebook
Computer, you'll be able to experience a 17.3" widescreen display
with an anti-reflective finish that reduces glare.

» 1920 x 1080 resolution » 1TB 7200rpm hard drive

» 802.11ac Wi-Fi & Bluetooth 4.0 » Thunderbolt & HOMI

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Graphics SKU Price

NVIDIA GeForce GTX 980M ASG751JYDB72 | $2,133.03
NVIDIA GeForce GTX 965M | AS6751JLDS71] $1,299.00
» 178 7200 rpm HDD + 128GB M.2 SSD

» NVIDIA Geforce GTX 970M GPU (36B GDDRS)

» 17.3" Full HD eDP Non-Reflective Display » 1920 x 1080 Native Resolution
» 10/100/1000 Mbps Gigabit Ethernet » 802.11ac Wi-Fi, Bluetooth
» SteelSeries Gaming Keyboard » Windows 8.1

[MSGS70SP607)

Processor RAM  Optical
2.6 GHz Intel Core i7-4720HQ | 24GB | Blu-Ray Burner
2.6 GHz Intel Core i7-4720H0 166B|  DVD-RW |

M2S7 6570 Stealth Pro-607 17.3"

Gaming Notebook Computer

» 2.7 GHz Intel Core i7-5700HQ (Broadwell)
» 166B of 1600 MHz DDR3L RAM

$1,687.00

=

GIGABYTE P35XV3
» 2880 x 1620 resolution
» SuperMulti DVD Burner
» 802.11b/g/n Wi-Fi & Bluetooth 4.0
» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.6GHz Intel Core i7-4720H0 | 1668 |  1.2TB NVIDIA GeForce GTX 980M 6IP35XV3CF7 | $2,299.00

GIGABYTE P35WV3-CF4
» 15.6” LED Display » 1600 MHz DDR3 RAM
» SuperMulti DVD Burner

» §02.11b/g/n Wi-Fi

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.6GHz Intel Core i7-4720H0 | 4GB |  1.2TB NVIDIA GeForce 6TX 970M GIP35WV33K | Log-on

2.66Hz Intel Core i7-4720H0 | 166B|  1.1TB | NVIDIA GeForce GTX 970M | GIP35WV3CF4 | $1,699.00
*4K Resolution

GIGABYTE P37W-CF3

» 1920 x 1080 resolution

» 1600 MHz DDR3 RAM

» SuperMulti DVD Burner
» 802.11b/g/n Wi-Fi

» Windows 8.1 » Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.66Hz Intel Core i7-4720H0 | 166B |  1.25TB NVIDIA GeForce GTX 970M GIP3TWCF3 | $1,799.00




COMPUTERS GAMING NOTEBOOKS

$1,499.99
» 51268 M.2 Solid State Drive

» NVIDIA GeForce GTX 860M GPU (268 GDDRS) n

» 13" QHD IPS Multi-Touch Display » 2560 x 1440 Native Resolution
» HDMI, Mini DisplayPort, USB 3.0 » 802.11ac Wi-Fi, Bluetoath 4.0
» Built-in Webcam, Microphone, & Speakers » Windows 8.1 (64-bit)

(DEANW138636S)

@ Alienware 17-R2 Gaming Notebook

» 2.5 GHz Intel Core i7-4710HQ Quad-Core

» 86B of 1600MHz DDR3L RAM » 17.3" Anti-Glare Display
» Full HD 1920 x 1080 Native Resolution

» NVIDIA GeForce GTX 970M Graphics (36B)

» 1TB 7200 rpm SATA 11l 6 Gh/s Hard Drive

» SuperMulti DVD Burner » 802.11ac Wi-Fi & Bluetooth 4.0
» AlienFX Illuminated Keyboard » Windows 8.1 (64-bit)

(DEANW1721435)

@ Alienware 13 ANW13-8636S 13"
Multi-Touch Notebook Computer

» 2.4 GHz Intel i7-5500U (Broadwell)
» 166B of 1600 MHz DDR3L RAM

$1,799.00

Ienowvo Y70 Touch

The Y70 Touch17.3" Notebook Computer from Lenova is pow-
ered by a Intel Core Haswellprocessor and dedicated NVIDIA
GTX graphics, making it suitable for video and image editing,
HD 3D gaming, as well as other uses.

» 1920 x 1080 IPS Touchscreen

» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 8.1
Processor RAM  Storage Graphics SKU Price
2.66Hz Intel Core i7-4720H0 | 1668 | 2566B SSD NVIDIA GeForce GTX 960M LEBODUOOESUS | $1,313.29

2.66Hz Intel Core i7-4720H0 [ 86B | 1TB | NVIDIA GeForce GTX 9%60M | LEBODUOOF5US | $1,209.99

Omen

’ The Omen Touchscreen Gaming Notebook Computer
from HP is designed for mabile professionals wha require a
versatile system which can handle a wide variety of tasks and
applications. This system is powered by a Intel Core Quad-Core
Haswell processor, allowing you to run multiple applications
simultaneously.

» 1920 x 1080 IPS Touchscreen

» 1600 MHz DDR3 RAM » 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 8.1

Processor RAM  Storage
2.66Hz Intel Core i7-4720H0 | 86B | 5126B SSD
2.506Hz Intel Core i7-4710H0| 86B | 26668 SSD |

Graphics SKU Price
NVIDIA Quadro K1100M HEOPLIH60UT | $2,599.00
NVIDIA GeForce GTX 860M | HEJ9KI9UA | $1,426.86

aCET Aspire V3

Power your gaming and entertainment needs with the Aspire V3
from Acer that features the Intel Core Broadwell processor. When
you need additional storage, connect an optional external storage
drive to one of the three USB ports.

» 1920 x 1080 resolution » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 8.1

I72S7 MSIGP70 Leopard

The GP70 Leopard 17.3" Notebook Computer from MSI is built with
gaming and multimedia use in mind. The 17.3" widescreen display
features LED backlighting, which uses less power than CCFL
backlighting.

» 1920 x 1080 resolution

» 1600 MHz DDR3 RAM » SuperMulti DVD Burner

» 802.11ac Wi-Fi &Bluetooth 4.0

» Windows 8.1

Processor RAM  Storage
2.6GHz Intel Core i7-4720H0 | 8GB 178

Graphics SKU Price
NVIDIA GeForce GTX 950M MSGP70LP486 | $929.00

I?2S7i GE72 Apache Pro

The MSI GE72 Apache-078 17.3" Gaming Notebook Computer
is built with gaming and multimedia use in mind. The chassis
features a bold design with a sleek aluminum black body kit.
» 1920 x 1080 resolution

» 1600 MHz DDR3 RAM

» SuperMulti DVD Burner

» 802.11ac Wi-Fi &Bluetooth 4.0

» Windows 10

Processor RAM Storage
2.7 GHz Intel Core i7-5700HQ | 166B | 1TB 7.2k

Graphics SKU Price
NVIDIA GeForce GTX 960M MSGE72A235 | $1,195.95

A72S7 6S60Ghost Pro
The MSI 6S60 Ghost Pro-606 15.6” Gaming Notebook Computer
is built with gaming and multimedia use in mind. The chassis
features a bold design with a sleek aluminum black body kit.
» 1668 GB 1600 MHz DDR3 RAM
» 1.17B Storage
» DVD+/- RW » 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 8.1
Processor Resolution Graphics SKU Price
2.76Hz Intel Core i7-5700HQ | 3840 x 2160 NVIDIA GeForce GTX 970M 66B | MSGS60GP605 | $1,879.00
2.76Hz Intel Core i7-57[]ﬂH[1\ 1920 x 1080 \ NVIDIA GeForce GTX 970M 3GB \MSGSbDGPbUé\ $1,699.00

RazeRr Blade
The Razer Blade 14 QHD+ Touchscreen Gaming Notebook features a
NVIDIA GeForce GTX 970M graphics card with 3GB of video memary and
an Intel Core Haswell processor that allow you to play games as well
as work.
» 3200 x 1800 Touchcreen resolution
» 1600 MHz DDR3 RAM
» 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 10

Processor RAM  Storage
2.66Hz Intel Core i7-4720HQ | 16GB | 512GB SSD
2.66Hz Intel Core i7-4720HQ | 1668 | 25668 SSD |

Graphics SKU Price
RAT4GL512W10| $2,699.00
[RA146L256W10] $2,399.99

i

NVIDIA GeForce GTX 970M
NVIDIA GeForce GTX 970M

The Razer Blade Pro R5 17.3" Gaming Laptop from Razer is
designed for gamers and mobile professionals who require a
versatile system which can handle a wide variety of tasks and
applications.

» 1920 x 1080 resolution

» 802.11ac Wi-Fi &Bluetooth 4.0

Processor RAM  Storage Graphics SKU Price
2.4 GHz Intel Core i7-5500U | 16GB|  1TB NVIDIA GeForce GTX 840M ACV357267308| $999.99 » Windows 10
2. GHz Intel Core i7-5500U | 126B|  1TB Intel Graphics 5500 ACV35727502 | $769.00 Processor RAM  Storage Graphics SKU Price
2.2 GHz Intel Core i5-52000 | 126B|  1TB Intel Graphics 5500 ACV357263RA | $644.49 2.6 GHz Intel Core i7-4720HQ_| 166B | 51268 SSD | NVIDIA GeForce GTX 960M | RAT7GL612W10 | $2,799.99
2.2 GHz Intel Core i5-5200U | 8GB 118 Intel Graphics 5500 ACV3572P594C | $679.00 2.6 GHz Intel Core i7-4720HQ_| 166B | 25668 SSD | NVIDIA GeForce GTX 960M | RA176L256W10 | $2,499.99

800-947-5534 + 212-444-6740




Ienowvo ThinkPad W541

The Lenovo ThinkPad W541 20EFO00LUS Mabile Workstation is
designed for professionals to create 3D models, edit videos, and more.
» 1600 MHz DDR3 RAM

» 802.11ac Wi-Fi & Bluetooth 4.0

» Thunderbolt 2.0 » Windows 7 Professional

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM  Storage Graphics SKU Price
2.86Hz Intel Core i7-4810MQ_ | 8B | 25668 SSD | NVIDIA Quadro K2100M (2880 x 1620) | LE54120EFO0L | $1,899.00

2.86Hz Intel Core i7-4810MQ_ | 86B | 25668 SSD | NVIDIA Quadro K2100M (1920 x 1080) | LE54120EFOON | $1,675.42

2.56Hz Intel Core i7-4710MQ_| 868 | 50068 | NVIDIA Quadro K1100M (1920 x 1080} | LE54120EF00H | $1,549.95

P Book 14 62 Touchscreen
The ZBook 14 G2 14" Touchscreen Mobile

Workstation from HP is designed for mobile enthusiasts who
require professional 3D graphics and strong performance from
demanding applications.
» 1920 x 1080 Touchcreen resolution
» 1600 MHz DDR3 RAM » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0
» Windows 8.1

Processor RAM Storage
2.4GHz Intel Core i7-5500U | 16GB 25668 SSD

Graphics SKU Price
AMD FirePro M4150]  HEZB14G2L354 $1,569.00

™ ZBook 1562
The ZBook 15 G2 15.6" Mabile Workstation from HP is
designed for mobile professionals who require a versatile system
with powerful processing and graphics, as well as simple scalability
that can handle a wide variety of functions.
» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10
» 3200 x 1800 Resolution
Processor RAM  Storage Graphics SKU Price
2.5GHz Intel Core i7-4710MQ_| 16GB | 512GB SSD | NVIDIA Quadro K2100M | HEZB15P3D87U $2,299.00
2.4GHz Intel Core i7-5500U | 16GB | 5126B SSD | AMD FirePro M4170 | HEZB15UP3E25 $1,879.00
2.5GHz Intel Core i7-4710MQ_| 8GB 1TB NVIDIA Quadro K1100M | HEZB15P3D86U $1,729.00

msi Ws0

While the MSI WS60 5.6 Mobile Workstation has a slim and light
chassis, it is also capable of handling CPU and GPU intensive tasks
with ease. Its 15.6” eDP display has a wide viewing angle.

» 1600 MHz DDR3 RAM

» Thunderbolt 2

» 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 7 Professional

» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price
2.56Hz Intel Core i7-4710MQ_| 166B | 1.2TB | NVIDIA Quadro K2100M (3840 x 2160) [MSWS6020J461| $2,549.99

2.56Hz Intel Core i7-4710MQ_| 1668 | 1.1T8_| NVIDIA Quadro K2100M (1920 x 1080) |MSWS6020J006] $2,199.99

@ Precision M2800
» 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 7 Pro + Windows 8.1 Pro License

Processor RAM Storage Resolution SKU Price
3.06Hz Intel Core i7-4610M | 86B 50068 7.2k 19201080 | DEM28005536 $1,233.99
2.66Hz Intel Core i5-4210 | 86B | 600GB7.2k |  1366x768 | DEM28005520 |  $924.99

www.BandH.com
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ITenowo ThinkPad W550s

Constructed from glass-fiber reinforced plastic, the ThinkPad W550s
16.6” Mabile Workstation from Lenovo blends the form factor of an
Ultrabook with the processing power of a mobile workstation.
» §02.11ac Wi-Fi & Bluetooth 4.0
» Windows 7 Pro + Windows 8.1 Pro License
» Get A Free Upgrade To Windows 10 valid until 07/29/16

Processor RAM Storage Graphics SKU Price

2.4GHz Intel Core i7-55000 | 86B | 25668 SSD | NVIDIA Quadro K620M (2880 x 1620) | LEWS50S20CUS |$1,579.00
2.4GHz Intel Core i7-55000 | B6B | 5006 | NVIDIA Quadro K620M (1920 x 1080) | LEWS50S20BUS |$1,159.99

P IBook 14 G2
The ZBook 14 62 14 Mobile Workstation from HP is designed
for mobile enthusiasts wha require professional 3D graphics and strong
performance from demanding applications.
» 1600 MHz DDR3 RAM » AMD FirePro M4150 graphics
» 1920 x 1080 resolution » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0
» Windows 10

Processor RAM Storage SKU Price
2.46Hz Intel Core i7-5500U 1668 5126B 55D HEZB14P3E27U $1,899.00
2.4GHzIntel Core i7-55000 | 1668 | 1TB7.2k |  HEZBT4P3EZOU |  $1,699.00

ZBook 17 62

The ZBook 17 62 17.3" Mabile Workstation from HP
is designed for mobile professionals who require a versatile system
with powerful processing and graphics, as well as
simple scalability that can handle a wide variety of functions.
» 2.56Hz Intel Core i7-4710MQ » 17.3" Anti-Glare Display
» 1920 x 1080 Resolution » 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 10

RAM Storage Graphics SKU Price

166B | 51268 SSD NVIDIA Quadro K2200M HEZB17P3D85U $2,499.00

86B | 1B |  NVIDIAQuadroKI100M |  HEZBI7P3DBAU | $1,919.00
MmIsi WT60

Experience 4K resolution with the MSI'WT60 20K 4K-1271US 15.6”
Mobile Workstation. The WT60 has a 15.6” display with a UHD+ 4K
3840 x 2160 native resolution to ensure that your designs are
represented the way they were meant to be.

» 3840 x 2160 Resolution

» 1600 MHz DDR3 RAM » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 7 Professional

Processor RAM  Storage
2.7GHz Intel Core i7-4810MQ | 1668 1178

Graphics SKU Price
NVIDIA Quadro K3100M | MSWT60241271 $2,399.00

@ Precision M4800
The Dell Precision M4800 15.6” Mabile Workstation is your key
tool for designing digital content, working with CAD madels, analyzing
manufacturing processes, or any ather performance intensive applications.
» §02.11ac Wi-Fi & Bluetooth 4.0 » Windows 8.1

3840 x 2160 Resolution

Processor RAM  Storage Graphics SKU Price

2.9GHz Intel Core i7-4910MQ_| 166B | 256GB SSD | NVIDIA Quadro K2100M | DEM4800BBCV $2,369.99
1920 x 1080 Resolution
Processor RAM  Storage Graphics SKU Price
2.8GHz Intel Core i7-4810MQ | 8GB | 256GB SSD | NVIDIA Quadro K1100M | DEM4800BBCW $1,831.99
2.8GHz Intel Core i7-4810MQ | 8GB | 5006B 7.2k | AMD FirePro M5100 | DEMA4800BBCX $1,480.00
2.56Hz Intel Core i7-4710MQ | 8GB | 500B 7.2k | NVIDIA Quadro K1100M | DEMA4B00BBCY $1,387.99
63




COMPUTERS TABLET & LAPTOP CASES

TABLET COVERS

Case

Survivor All-Terrain Hideaway Case aXtion Bold Case niiiid Case Defender Defender | Voyager Case KidArmor Tough Armor Case | Multi-Grip Case
. Polycarbonate shell/ - Water Waterproof-Fully Synthetic Synthetic . "
Material Silicone frame Silicone Rubber Resistant submersible to 6.6 Rubber Rubber Silicone EVA foam Polycarbonate Silicone
Screen Protector Yes Yes Yes Yes Yes Yes No No No No
. Black, Black, Orange, Glacier, Crushed Glacier, Black, Purple, Red, Black, Blue, Metal Slate, Blue, Black,
Colors Available | g . by Blue, White, Red, Black Red | Black. Avalanche | p o Black Black Pink Magenta, Green, Yellow Satin, Silver Red, Yellow
SKU GRSIPAZBB GUGHIPAOB JOCWEZ201 LINCIPAZBK 0TDSCIPA2GLC | OTDCGTABNSBK | PEC11030BKGY ROKAMINIZB SPSGP10623 XUIPMKCBL
Price Call or Log-on $69.95 $46.04 $116.99 $80.95 $62.96 $54.95-$74.95 $19.95 - $34.99 $29.99 $9.95
. ek iPad Air 2, Galaxy Note . - P iPad, iPad Air Galaxy Tab 8.0 iPad Air 2, o - ) - ) -
Available for iPad, iPad Air 2 Pro, Galaxy Tab Pro iPad mini iPad, iPad Air 2 &iPad mini's 297 iPad mini iPad Air 2, iPad mini iPad mini iPad mini

TABLET PORTFOLIOS

SealdAN>uns b

[t | femigon | Pon | ion | rmwe | oo | Smwg  Sek | e | dm | dm |
Case Customize Me

Hardback Case ProGear Vault Origami SlimShell Origami 3D SlimShell Book Cover DuraFolio StyleFolio Folio Case | Rotatable Case
Material Polyurethane Stainless Steel ABS p_lastu: W Polyurethane Polycarbonate Synthetic leather Polycarbonate Faux Leather Hardshell Hardshell
watertights seal Shell
Closure Magnetic Snap Latches Latch Magnetic Magnetic Folding Magnetic Locking Clasp Magnetic Magnetic
Black, Blue, Red, Black, Blue, . Black, Blue, Red,
Colors Available | Black, Red Black Black, Grey Gray, Green, Magenta, Red, Turquoise, %llzcek'ﬂvr\g:tz Grila%kihk Green, Grey, Pink, mftke %;Ttke
Turquoise, Purple, Gold Green, Purple, - orang . Floral Pink, Rattleskin
SKU KEK97358US PE1065C PEPVIPAB ROSCCIPB ROOCT1056BCG SABCGN12.28 SPDFCIPAPNWH SPSCIM123BSG XUIPAFB XUIPARB
Price $34.95 $26.38 - $36.48 $58.77 - $70.52 $4.95 - $34.95 $16.98 - $37.99 $49.99 $40.99 - $59.95 $20.99 - $20.22 $24.99 $24.99
. I~ iPad Air, iPad mini . - ko -
n iPad Air 2, B P iPad Air 2, ' ' iPad Air 2, Galaxy Tab, iPad Air & iPad Air 2, iPad mini, - .
Avallab ey iPad mini ZRLURES iPad mini B;Laxngl?s Béfdxlye 'é?rt: Galaxy Tab Galaxy Note Pro iPad Air 2 Galaxy Tab, Kindle Fire R TR

SLEEVES

mPlmiere sl

Brand Brenthaven Case Logic Incase Designs Incase Designs mm Ruggard Ruggard mm

. Neoprene Blade Herringbone Ultra Thin Waterpoof Textured Neoprene
B 0 AR 2 Pro Sleeve 1.0 Armor Case Sleeve Sleeve Pouch Sleeve
Material Ballistic Nylon Neoprene Neoprene Neoprene Neoprene Polypropylene Wir::ﬂﬁ;;';;gnt Neoprene Waterproof Neoprene
Interior Fur-lined Neoprene Soft, Nonabrasive Fleece Suede Padded Padded Double Seamed Waterproof Padded
Closure Tipper Tipper Magnetic Tipper Tipper Zipper Tipper Tipper Double Enclosure Tipper
. Black, Grey, Green, Pink, Black, Grey,
Colors Available Black Black Black, Grey Blue, Magenta, Purple Orange Black Brown Black Transparent Blue, Pink Red
SKU BRP11B CAPLS15B INCL60521 INCL60225 LAF1035P RAACFRML RUHLTS13 RULPS13B XUIPWPC XUSNT12R
Price $37.95 $16.13-$16.13 $45.99 - $45.00 $24.95 - $39.00 $7.99 $49.99 $14.99 - $19.99 $10.95 - $12.99 $9.95 $9.95
Available for 17133 167 107-15" 107-15" 102 Small 815" 107-15" iPad & 10" Tablets
Tablets & Laptops | Tablets & Laptops | Tablets & Laptops Tablets & Laptops Tablets Laptops Tablets & Laptops | Tablets & Laptops iPad mini
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TABLET & LAPTOP CASES  COMPUTERS

BACKPACKS

Laptop City Renegade Red Series Ruby U100 Tectonic . Groove
= Backpack Backpack RSS Backpack 33 Tech Backpack Urban Elite Backpack L Laptop Backpack Ll
Material Nylon Bler?[?fy degllleerave Polyester 900D Polyester Denier Kodra Nylon Ballistic Nylon Nylon Nylon Nylon
Interior Nylon Fleece Padded 150D Polyester Hard shell case Padded Airflow Padding Padded Padded
Closure Tipper Tipper Tipper Tipper Tipper Zipper Zipper Zipper Zipper
Colors Available Black Black, Khaki Black Black with Red Black ) il Blue Black Black
Olive, Black
SKU CAVNB217 INCL55450 0GRRPB RUCBB3B PEUT00BPB SA443322642 SWA731606F00 TACVR600 TATXL617
Price $22.99 $98.84 - $129.95 $149.90 $99.95 $169.78 $59.99 $78.48 $36.99 $58.86

MESSENGER / SLING BAGS

I ¥YLY[frjerre

el - Sy P - T B
Material Chambray Nylon Ballistic Nylon Leather Canvas Nylon Nylon Ballistic Nylon Polyester Quilted tricot fabric
Interior High-Density Foam | Brushed Poly Lining Fleece Padded Padded Nylon Padded Cotton | Brushed Poly Lining Padded Quilted tricot fabric
Closure Metal Hook Lipper Lipper Computer Slips In Snap Clips Lipper Lipper Lipper Buckle and strap |  Quick-release buckles

Colors Available Iﬁgiag[f‘gte Black Black Brown, Black Navy, Olive Gmiﬁ‘ﬁféﬁ%ﬁy Black Black Black SEE“WR'EEE

SKU BRCVM13 CAMLAT10 KEK62590AM MALT3EIVN MOMECMEY PAMSSBJG RUSB13B SAX2MB TATCMO04US TICMCNBB

Price $59.95 $21.28 $40.95 $198.99 $33.16 $66.68 - $85.00 $16.99 Call Or Log-on $17.95 $89.24 - $119.00

BRIEFCASE & SHOULDER BAGS

ot Collins Checkpoint Laptop Red Series Red Series 1495 Laptop Case TEI R Columbian HeE My 2nd Brain
Slim Brief Friendly Case Attache Convertible Bag | Lava Tech Briefcase piop Leather Case Briefcase
Material Chambray Ballistic Nylon Nylon 900D polyester 900D polyester High-impact copoly- Ballistic nylon Leather Polyester Nylon
mer polypropylene
Interior Padded Padded Padded polyester polyester Foam Padded Padded Padded Tricot nylex-lined
Closure Metal Hook Tipper Tipper Tipper Tipper Combination Lock Tipper Buckles Tipper Tipper
Colors Available Grey, Blue Black Black Black Black Black, Desert Tan Black Brown Black Black, Green, Blue
SKU BRCSB CAZLCS217 CAVNAZ16 RUCLB2B RUCFB1B PE1495FB SAX2SB156 SA45798 SWM156CBG6 THM2BC158
Price $59.95 - $79.95 $30.92 - $44.54 $18.99 - $40.76 $49.95 $49,95 $148.97 - $154.62 $21.69 $100.99 $47.25 $85 - $144.75
Available for upto15.4” 1417 107-18" 1547107 15.4"-10" upto 17 15°-17" upto15.6” 16" 13°-15"
Notebooks Notebooks Notebooks MacBooks MacBooks Notebooks Notebooks Notebooks Notebooks Notebooks
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COMPUTERS

ALL-IN-ONE COMPUTERS

Authorized |Mac

Reseller The Apple iMac is an all-
in-one desktop computer with an ultra-stim uni-
body design. Measuring at just 5 mm at its edges,
the iMac has 40% less volume than the 2011 iMac.
The body of the iMac isn't the only thing that got
thinner. The LCD display is now 5 mm thinner, and
Apple also remaved a 2 mm gap between the LCD
panel and the glass to save even more space.

iMac 27”

» 27" Retina 5K IPS Display » 5120 x 2880 Native Resolution » 3.3 GHz Intel Core i5 (Haswell)
» AMD Radeon M290 GPU (26B GDDRS) » 802.11ac Wi-Fi, Bluetooth 4.0 » 2x Thunderbolt 2 and 4x USB
3.0 Ports » FaceTime HD Camera, Dual Mics, Speakers » Mac 0S X 10.10 Yosemite

iMac 21.5”
» 21.5" LED-Backlit IPS Display » Full HD 1920 x 1080 Native Resolution

» 802.11ac/a/b/g/n Wi-Fi, Bluetooth 4.0 » Thunderbolt, USB 3.0, SDXC Card Reader
» 720p FaceTime HD Camera, Dual Mics » Mac 0S X 10.10 Yosemite

Storage Memory SKU Price Processor Storage Memory Graphics SKU Price
3TB Fusion 166B APIMMF88511 2,489.99 3.16Hz Intel Core i7 1TB Fusion 166B GeForce 6T 750M | APIMMEO873 2,049.00
1TB Fusion 1668 APIMMF88510 2,349.00 2.76Hz Intel Core i5 178 b.4k 166B Intel Iris Pro APIMMED861 1,469.99

31B 7.2k 1668 APIMMF8859 2.299.00 2.9GHz Intel Core i 178 5.4k 868 GeForce GT 750M | APIMMEOS7LLA 1,379.00
1TB Fusion 868 APIMMF8854 2,149.00 1.4 GHz Intel Core i 1TB Fusion 868 Intel HD 5000 | APIMMF8832 1,299.00

118 7.2k 166B APIMMF8851 2,149.00 2.7GHz Intel Core i 178 5.4k 868 Intel Iris Pro | APIMMEOBGLLA 1,199.99

31B 7.2k 868 APIMMF8853 2,099.00 1.4 GHz Intel Core i 178 b.4k 868 Intel HD 5000 | APIMMF8831 1,129.00

1TB 7.2k 868 APIMMF885LLA 1,899.99 1.4 GHz Intel Core i 5006B 5.4k 868 Intel HD 5000 | APIMMF883LLA 1,029.00

@ Inspiron 23 5000 5348

The Inspiron 23 5000 5348 23" Multi-Touch All-in-One Desktop
Computer from Dell is a 10-point capacitive multi-touch, all-in-one system
designed for use in school, home, and IT environments. It is well-suited far
web browsing, email, multimedia, and video playback.

» 3.5 GHz Intel Core i3-4150 Dual-Core » 8GB 1600 MHz DDR3 RAM

» 178 5400 rpm Hard Drive » Integrated Intel HD 4400 Graphics

» 23" Full HD LED-Backlit Touch Display » 1920 x 1080 Native Resolution
» Built-In DVDRW » Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

DEINSP5000 765.99

Ilenowvo (5

The Inspiron 23 5000 5348 23" Multi-Touch All-in-One Desktop Computer from
Dell'is a 10-point capacitive multi-touch, all-in-one system designed for use

in school, home, and IT environments. It is well-suited for web browsing, email,
multimedia, and video playback.

» 1.7 GHz Intel Core i5-4210U » 8GB Memory

» Integrated Intel HD 4400 Graphics » 23" LED Touchscreen » DVD-RW Drive
» 802.11ac Wi-Fi, Bluetooth 4.0 » Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

27B (LEC5030F0B24) 849.99
178 (LEC5030F0B27) 726.00

Ilenowvo Cil

» 21.57 LED Display » DVD-RW Drive » 802.11ac Wi-Fi, Bluetooth 4.0
» USB 2.0/USB 3.0/Memory Card Reader » Windows 8.1

» Free upgrade to Windows 10 until 7/29/16

Processor
1.8 GHz AMD A4-6210

Memory Storage Display

LED Display

w ATIV One 7
» 2.2 GHz Intel Core i5-5200U (Broadwell)

» B6B of 1600 MHz DDR3L RAM » 1TB 5400 rpm Hard Drive
» Intel HD Graphics 5500 » 27" Curved Anti-Reflective Display
» 1920 x 1080 Resolution » 802.11ac Wi-Fi & Bluetooth 4.0
» Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

(SADP700A7KK1)

LEC4005F0B50

Call Or Log-on

@ LG Chromebase

The LG Chromebase 21.5” All-in-One Desktop Computer
features the Google Chrome 0S with built-in apps like Gmail, YouTube,
Hangouts, and Docs. This system also includes 100GB of free cloud storage
for 2-years, and 2-months of free Google Play Music ALl Access.
» 1.4 GHz Intel Celeron 2955U Dual-Core P
» 26B 1600 MHz DDR3L Memory » 1668 SSD » 21.5" IPS LED Display » 1920 x 1080 Resolution
» 802.11a/b/g/n Wi-Fi + Bluetooth 4.0 » Integrated Intel HD Graphics » Google Chrome 0S (64-bit)

WHITE (L6220v241W) 321.99
BLACK (L622CV241B) 299.00
Pavilion 23-r110

The 23-r110 All-in-One Desktop from HP is an all-in-
one system designed for home environments, including family
entertainment and productivity.

» 2.9GHz Pentium Dual-Core » 4GB DDR3L 1600 MHz RAM
» 1187200 rpm Hard Drive » Intel HD Graphics
» 237 LED > 802.11b/g/n Wi-Fi » Windows 10

HEMIZ64AA

Sprout

Experience innovative and intuitive multi-touch technology with
the HP Sprout Immersive Computer. Located on the Sprout is the Sprout
[tluminator, which is made up of the HP DLP projector, the HP high-resolution
camera with up to 14.6 megapixel resolution, and the Intel RealSense 3D
camera for instant capture of 20 and 3D objects along with an LED desk lamp.
» 3.2 GHz Intel Core i7-4790S » 8GB 1600 MHz Memory
» NVIDIA GeForce GT 745A » 23" HD LED Touchscreen
» 802.11a/b/g/n & Bluetooth 4.0 » Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

HE235010

1,899.00

Envy Beats Special Edition
» 2.9 GHz Intel Core ib-4570T
» 86B 1600 MHz DDR3L RAM » 1TB 5400 rpm SATA SSHD
» §6B SSD Cache » 23" LED Backlit Full HD Touchscreen
» Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

HEF3FO0AA 949.99

-~

800-947-5534 + 212-444-6740




Stream

At just 2.13" tall, the Stream 200-010 Mini Desktop Computer
from HP features a compact design and is able to fit into most work-
spaces with its tiny footprint. Designed for standard use and general
pracessing, including web browsing, email, document creation, and
multimedia playback.
» 1.4 GHz Intel Celeron 2957U Dual-Core » 2GB 1600 MHz Memory
» 326BM.2SSD » 802.11b/g/n » Windows 8.1
» Free upgrade to Windows 10 until 7/29/16

(HES200010M) 209.00

(

Ienowvo ThinkCentre M93p

The ThinkCentre M93p 10AB0010US Tiny Desktop Computer from Lenovo
is a reduced size computing machine allowing you to situate this PC in a
variety of locations.

» 2.9 GHz Intel Core ib-4570T

» 46B 1600MHz DDR3 RAM » 500GB 7200prm HD

» Intel HD Graphics 4600

» Windows 7 Pro » Free upgrade to Windows 10 until 7/29/16

(LEM93PT45000) 570.99

/iSUS M32AD

With an integrated 4th generation Intel Core processor the M32AD-
US032S Desktop Computer from ASUS gives you the tools needed to
multitask with ease.

» 3.6 GHz Intel Core i7-4790 » Windows 8.1

» Free upgrade to Windows 10 until 7/29/16

Optical Drive RAM Storage
SuperMulti DVD-RW 1268 118 7.2k

Graphics SKU Price
AMD Radeon R7 240 ASM32ADUS033 799.00

SuperMultiDVD-RW | 8GB | 17B7.2k |  IntelHD4600 | ASM32ADUSO34 |  699.99

“‘rview Cyber PC

» 1.33 GHz Intel Atom Z3735F Quad-Core

» 268 of 1333 MHz DDR3L-RS RAM

» 326B Internal Storage » microSD Expandability to 12868

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Built-in USB Port

» Supports 1080p Video Output » Less Than 5" Long and 2" Wide
» Includes a Wireless Keyboard » Windows 8.1 & Android 4.4

(ASG10AJUSO10)

1,399.99

/iSUS K30AM-J-US001S

» 2.41 GHz Intel Core J1800 Celeron » 4GB of DDR3 1600 MHz RAM
» 5006B 7200 rpm HD » Intel HD Graphics

» 2bx DVD-RW Optical Drive » Windows 8.1

» Free upgrade to Windows 10 until 7/29/16

[ASK30AM) 241.23

(intel') Compute Stick

Transform your display into a fully functional computer with the
Compute Stick STCK1A32WFC from Intel. This over-sized thumb drive PC offers
the performance similar to your other computer and allows you to stream online
videos, play games, work on projects, and more
» 1.33 GHz Intel Atom Z3735F Quad-Core » HDMI and USB 2.0
» Micro SDXC Memory Card Slot » 802.11b/g/n Wi-Fi, Bluetooth 4.0
» Multi-channel Audio » Space-saving Design

+ I3

RAM Storage Operating System SKU Price
268 3268 Windows 8.1 INBOXSTCK1A3 135.92
168 \ 868 | LinuxUbuntu [ INBOXSTCKIAS | 99.99

DESKTOPS = COMPUTERS

/iS50 Chromebox
Google Chrome 0S is a Linux-based operating system designed by Google

to work exclusively with web applications. The ASUS Chromebook combines
the aspects of a pure cloud client with the hardware of a traditional portable
computer, which puts it in its very own class of netbook and
notebook computers.

» 166B SSD » Free 100GB on Google Drive for 2 Years

» 802.11a/b/g/n Wi-Fi, Bluetooth 4.0

» DisplayPort, HDMI, USB 3.0 » Google Chrome 0S

Processor RAM SKU Price
1.4 GHz Intel Celeron 29550 268 ASCBMO04U 158.99

@ Inspiron 3000 13847

Unlike typical desktops, Dell has outfitted this computer with Wi-Fi
technologies so you can access the Internet without the need for a cable. With
Windows 10 Home preinstalled, you get a hybrid start menu that features live
tiles and quick access to your most-used programs and files.

» 802.11b/g/n Wi-Fi + Bluetooth 4.0 » Integrated 5.1 Audio, 8-in-1 Card Reader
» 4xUSB 3.0, 4 xUSB 2.0 Ports » Windows 10

Processor RAM  Storage
3.3 GHz Intel Pentium 63260 | 468 | 1TB7.2k

Graphics SKU Price
Intel HD Graphics DEI38471696B 358.99

@ Inspiron 3000 13647

This small form factor computer lets you run multiple everyday
programs such as spreadsheets, image editing, and more. Cortana is your
personal virtual digital assistant, which is integrated into Windows 10. She can
guide you to your answer by searching the Internet and keeps track of what you
like as well as what you want her to do.

» 1TB 7200rpm Hard Drive » Intel HD Graphics 4400

» SuperMulti DVD Burner

» 802.11b/g/n Wi-Fi + Bluetooth 4.0 » Windows 10

Processor RAM SKU Price
3.2 GHz Intel Core i5-4460 868 DEI36474618B 549.99
3.7 GHz Intel Core i3-4710_| 46B \ DEI36473851B \ 399.99

@ OptiPlex 3020
» 3.3 GHz Intel i5-4590 Quad-Core

» 500 GB 7200 rpm HD » Intel HD Graphics 4600
» 8X DVD+/-RW Optical Drives
» Windows 7 Pro

868 (DE302005WX1W) 607.17
4GB (DE30200KKYMN) 569.00

Tenowo Hh0057327454 Desktop Computer
» 2.41 GHz Intel Pentium J2900 Quad-Core » 4GB DDR3 RAM

» 1187200 rpm Hard Drive » Integrated Intel HD Graphics

» VGA Port » DVD Burner » Gigabit Ethernet / 802.11b/g/n Wi-Fi

» 7-in-1 Card Reader » USB Keyboard & Mouse Included

» Windows 8.1

(LEH500573274) 359.00

To view a full listing of all Computers

or visit our website BandH.com/w1567

www.BandH.com




COMPUTERS WORKSTATIONS

” Authorized Mac Pro

Reseller With a unified thermal core, Apple opted for a leaner, lighter,
and quieter structure that was more streamlined than earlier Mac Pro's. The unique
cylinder design stands just 9.9 inches tall with a diameter of just 6.6 inches, which
allows it to be a professional workstation that can actually sit on your desk.

» Six Thunderbolt 2 Ports » Four USB 3.0 Ports, One HOMI 1.4 Part
» Supports up to Three 4K Displays » 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.0
» Unique Compact Cylinder Design » Mac 0S X 10.10 Yosemite

Ienowo. ThinkStation P500

The ThinkStation P500 Tower Workstation from Lenovo is a high-performance
system with fast processing that was designed for architects, product designers,
financial traders, medical and research professionals, software designers, and
engineers. Additionally, it is also well suited for those who work with intensive
graphics, multimedia tasks, and gaming.

» 16x SuperMulti DVD Burner » 8 x USB 3.0 /4x USB 2.0/ 1 x LAN
» USB Keyboard and Mouse Included » Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

Processor Memory Storage Display SKU Price Processor RAM  Storage Graphics SKU Price
2.76Hz Intel Xeon Twelve-Core|  64GB 18 AMD FirePro D700 x2 APMPMD87816 8,799.00 3.7 GHz Intel Xeon Quad-Core | 46B | 1TB7.2k | NVIDIA Quadro K&200 |  LEP5007000S 2,089.99
3.0GHz Intel Xeon Eight-Core |  646B 118 AMD FirePro D700 x2 APMPMD87811 7,994.00 3.5 GHz Intel Xeon Quad-Core | 46B | 1TB7.2k | NVIDIA Quadro K2200 | LEP50030A7QU 1,619.99
3.56Hz Intel Xeon Six-Core | 3268 178 AMD FirePro D500 x2 APMPMD87628 5,049.99 3.1 GHz Intel Xeon Quad-Core | 4GB | 5006B 7.2k | NVIDIA Quadro K620 | LEP50030A7MU 1,268.98
3.56Hz Intel Xeon Six-Core | 166B | 5126B | AMD FirePro D700 x2 APMPMD8785 4,794.00
3.56Hz Intel Xeon Six-Core | 32GB | 5126B | AMD FirePro D500 x2 APMPMD8786 4,594.00
3.56Hz Intel Xeon Six-Core 1668 25668 |  AMD FirePro D500 x2 APMPMD878LLA 3,699.00 @ PI'ECiSiOI'I T1700
3.7GHz Intel Xeon Quad-Core |  166B | 512GB | AMD FirePro D300 x2 APMPME2532 3,299.00 » 16x SuperMulti DVD Burner
3.76Hz Intel Xeon Quad-Core | 126B | 256GB | AMD FirePro D300 x2 APMPME253LLA 2,818.99 » hxUSB3.0/6xUSB2.0/1xLAN

@ Precision Tower 5810

The Precision Tower 5810 Workstation from Dell is designed for
professionals who require reliability and high performance for tasks such as
intensive graphics, 3D rendering, multimedia, and gaming, as well as science
and engineering applications.

» Gigabit Ethernet » 4 x USB 3.0 Ports &9 x USB 2.0 Ports
» USB Keyboard & Mouse Included » Windows 7 Pro
» Free upgrade to Windows 10 until 7/29/16

» USB Keyboard and Mouse Included » Windows 8.1

Processor RAM Storage Graphics SKU Price
3.6 GHz Intel Core i7-4790 |  8GB 11B7.2k | AMD FirePro W4100 DET17005452 1,224.59
3.3 GHz Intel Xeon Quad-Core| 1668 118 7.2k | NVIDIA Quadro K620 DET17005453 1,224.59
3.6 GHz Intel Core i7-4790 |  8GB 118 7.2k | NVIDIA Quadro K620 DET17005451 1,208.73
3.3 GHz Intel Core i5-4590 | 8GB | 5006B 7.2k |Intel HD Graphics 4600 DET17005450 891.37

@ Precision T1700 Small Form Factor
» Bx SuperMulti DVD Burner
» 24xUSB3.0/6xUSB2.0/1xLAN » USB Keyboard and Mouse Included

Processor RAM Storage Graphics SKU Price » Windows 8.1

3.5 GHz Intel Xeon Six-Core | 326B | 2566B SSD | NVIDIA Quadro K4200 |  DEP58108799 3,019.99

3.5 GHz Intel Xeon Six-Core | 1668 1TB7.2k | NVIDIA Quadro K2200 |  DEP58108702 2,289.99 Processor RAM  Storage Graphics SKU

3.5 GHz Intel Xeon Quad-Core | 16GB 1TB 7.2k | NVIDIA Quadro K4200 |  DEP58108701 2,109.99 3.3 GHz Intel Xeon Quad-Core | 86B | 500GB 7.2k | Intel HD Graphics 4400 DET17005447 927.99
3.6 GHz Intel Xeon Quad-Core | 16GB 1TB 7.2k AMD FirePro W5100 |  DEP58108699 1,849.99 3.6 GHz Intel Core i7-4790 | 8GB | 50068 7.2k | Intel HD Graphics 4600 DET17005446 914.99
3.6 GHz Intel Xeon Quad-Core | 1668 1TB7.2k | NVIDIA Quadro K2200 |  DEP58108700 1,829.99 3.3 GHz Intel Core i5-4590 | 8GB | 5006B7.2k | NVIDIA Quadro K620 DET170029622 917.11
3.6 GHz Intel Xeon Quad-Core | 8GB | 5006B 7.2k | NVIDIA Quadro K620 |  DEP58108698 1,569.99 3.3 GHz Intel Core i5-4590 | 8GB | 5006B7.2k | NVIDIA Quadro K620 DET17005445 861.70

L Series Workstations

The Z Series Workstations from HP delivers powerful performance and is designed for professionals wha require high reliability. The Z Series is well suited for tasks such as intensive graphics, 3D rendering,
multimedia, and gaming, as well as science and engineering applications. The system is powered by an Intel Xeon Quad-Core processor which will allow you to run multiple applications simultaneously.

Model 1440 1440 1640 1640 1840 1840
CPU 3.5 GHz Intel Xeon E5-1620 3.1 GHz Intel Xeon E5-1607 2.4 GHz Intel Xeon E5-2630 2 x 2.4 GHz Intel Xeon E5-2630 2.3 GHz Intel Xeon E5-2650 2.4 GHz Intel Xeon E5-2630
Memory 86B 86B 1668 6468 1668 1668
Hard Drive 118 7.2k 50068 7.2k 118 7.2k 12678 18 7.2k 178 7.2k
Graphics NVIDIA Quadro K2200 NVIDIA Quadro K620 Graphic Card Not Included NVIDIA Quadro K4200 Graphic Card Not Included NVIDIA Quadro K4200
Optical Drive SuperMulti DVD Writer SuperMulti DVD Writer SuperMulti DVD Writer Blu-ray Disc Burner SuperMulti DVD Writer SuperMulti DVD Writer
SKU HEZ440F1M4BU HEZ440FIMATU HEZ840FIMOTU HEZ640FTMTK HEZ840K7P0BU HEZ840K7PO7U
Price 1,604.03 1,344.99 2,263.82 5,633.68 3,302.87 3,481.91

800-947-5534 + 212-444-6740




CyberpowerPC Gamer Supreme
The Gamer Supreme Gaming Desktop Computer series from CyberpowerPC is a high-performance desktop computer designed to meet the stringent standards of PC gamers.
» DVI/ HDMI/ DisplayPort

» 2hx Dual-Layer Super-Multi Drive

» 7.1 Surround Sound Audio

» Gigabit Ethernet

» USB Keyboard & Mouse Included

» Windows 10 Home (64-bit)

GAMING COMPUTERS

(& CVBERPOWER

COMPUTERS

§9908:048

Model SLC8800 SLC7800 SLC8000 SLC8800 SLC7200 SLC8400 SLC8200 SLC8600
CPU 3.66Hz Intel Core 4.0GHz Intel Core i7- | 4.0 GHz Intel Core i7- | 3.3 GHz Intel Core i7- 3.3 GHz Intel Core 4.0 GHz Intel Core i7- | 4.0 GHz Intel Core i7- | 4.7 GHz AMD FX-9590
Six-Core 6700K Quad-Core 6700K Quad-Core 5820K Six-Core i7-5820K 6700K Quad-Core 6700K Quad-Core Eight-Core
Memory 16GB DDR4 16GB DDR4 16GB DDR4 16GB DDR4 16GB DDR4 16GB DDR4 16GB DDR4 16GB DDR4
Storage 2.278 2178 21TB 2178 2178 21TB 2178 2178
Graphics AMD Ra[%eﬁoﬂn] R9390 | AMD Ra[dBeBUBn] R9390 | AMD Ra[[éeGan] R9 390 NVIDI;\{)[(]ie[E%rgle 6| avp Radeon R9 270 NVI[]I;xé[uie[E%rg]e 6TX NVIDI;\{)[(]ie[E%rgle 61X | AMD Ra[(ieﬁoﬂn] R9 390
SKU CYSLC9000 CYSLC7800 CYSLCBO0O CYSLCB800 CYSLC7200 CYSLCBA00 CYSLCB200 CYSLCBA00
Price 1,922.99 1,501.74 1,539.00 1,462.55 1,474.99 1,399.00 1,399.00 1,236.82

CyberpowerPC Gamer Ultra
The Gamer Ultra Gaming Desktop Computer from CyberpowerPC is a high-performance desktop computer designed to meet the stringent standards of PC gamers.
» DVI/ HDMI / DisplayPort

» 2hx Dual-Layer Super-Multi Drive

» 7.1 Surround Sound Audio

» Gigabit Ethernet

» USB Keyboard & Mouse Included

» Windows 10 Home (64-bit)

486888

Model GUA570 GUA530 GUA540 GUA520 GUA510 GUA470
CcPU 3.5 GHz AMD Vishera FX-8320 | 3.8 GHz AMD Vishera FX-4300 | 3.5 GHz AMD Vishera FX-6300 | 3.8 GHz AMD Vishera FX-4300 | 3.8 GHz AMD Vishera FX-4300 3.9 GHz AMD A6-6400K
Eight-Core Quad-Core Six-Core Quad-Core Quad-Core Dual-Core

Memory 1668 DDR3 8GB DOR3 8GB DDR3 8GB DDR3 8GB DDR3 4GB
Storage 7B 118 118 178 118 50068
Graphics NVIDIA GeForce GTX 960 GPU (26B) | AMD Radeon R7 360 GPU (2GB) | AMD Radeon R5 230 GPU (16B) |NVIDIA GeForce GT 730 GPU (2GB)| AMD Radeon R5 230 GPU (1GB) AMD Radeon HD 8470D

SKU CYGUAB70 CYGUAB3D CYGUAB4D CYGUAB20 CYGUAB1D CYGUA4TD

Price 879.00 589.00 $529.00 519.00 489.00 439.99

@ Alienware Area-51

The Dell Alienware Area-51 A5T1R2-1172SLV Gaming Desktop
features a triangular case that allows easy access to all the ports and provides
efficient cooling for the internal components by offering a large space for hot
air to escape.

» 3.3 GHz Intel Core i7-5820K (Broadwell)

» 8GB DDR4 RAM » 2TB 7200 rpm Hard Drive
» NVIDIA Geforce GTX 980 Graphics (468

» DisplayPort, HDMI, DVI

» Slot-Loading SuperMulti DVD Burner

» Gigabit Ethernet, 802.11ac

» Liguid Cooling, Bluetooth 4.0

» Alienware Multimedia Keyboard & Mouse

» Windows 8.1 (64-bit)

(DEASTRZTITZS) 2,099.00

2S5 Gaming 24GE

The black-red trim Gaming 24GE Gaming All-in-One PC from MSI for gaming enthusiasts
features Anti-Flicker technology, an NVIDIA GeForceGTX 960M 26B graphics card, a 2.6 GHz
Intel i7-4720HQ quad-core processor, and a Killer E2200 Intelligent Networking Platform.

» 2.6 GHz Intel i7-4720HQ Quad-Core » 23.6” 1920 x 1080 LED Backlight
» NVIDIA GeForce GTX 960M 2GB » 802.11ac & Bluetoath 4.0

» Windows 8.1 » Free upgrade to Windows 10 until 7/29/16

)
£

GIGABYTE Brix Gaming Ultra Compact PC Kit

The Brix Gaming GB-BXi7G3-760 Ultra Compact PC Kit from Gigabyte is a

barebones kit that gives you the flexibility to choose which operating software

and storage drive as well as how much RAM memory to install into your ultra
compact computer.

» 2 xS0-DIMM Sockets (Max 166B) » Supports 2.5” SATA Drive » 1x mSATA Slot
» 2 x Mini HDMI Ports » 1x Mini DisplayPort » 4 x USB 3.0 Ports

Memory Storage Display SKU [ » Wi-Fi 802.11a/b/g/n/ac & Bluetooth 4.0 » VESA Bracket and Screws Included
1668 1.17B Touchscreen MS24GE20QE014 1,699.99 Processor Graphics SKU Price
1268 178 Touchscreen MS246E2QE015 1,425.99 2.5 GHz Intel Core i7-4710HQ NVIDIA GeForce GTX 760 GIBBXI7G3760 833.99
86B 1.1TB Touchscreen MSG24GE2QE13 1,499.99
1268 118 Anti-Glare MS24GE2QE016 1,299.99
= iBUVPOWER
/i=U= ROG The iBUYPOWER gaming computer is a high-performance workstation designed to

The ROG Gaming Desktop Computer from ASUS is a small form factor system that is
designed for those who require reliability and high performance.

» HOMI / DisplayPort / DVI-1 / DVI-D » Slim Tray SuperMulti DVD Burner

» Gigabit Ethernet & 802.11ac Wi-Fi » 12.b-Liter Case » Windows 8.1

» USB Keyboard & Mouse Include » Free upgrade to Windows 10 until 7/29/16

meet the stringent standards of PC gamers. AUL components are housed in the Azza
Atlas gaming case with a 500-watt power supply. Visuals are handled by the AMD
Radean R7 260X graphics card with 2GB of discrete memory, which has a VGA, a
DVI port, an HDMI port, and a DisplayPort.

» SuperMulti DVD Burner » 802.11b/g/n Wi-Fi, Bluetooth » USB Keyboard & Mouse Included

Processor Memory  Storage Display SKU Price » Azza Atlas Gaming Case » Windows 8.1 » Free upgrade to Windows 10 until 7/29/16
3.6 6Hz Intel Core i7-4790| 868 | 17B 7.2k +B6B SSD| NVIDIA GeForce 6TX 760 (26B) |AS620AJUS009| 1,037.44 Processor Memory Storage Graphics SKU Price
3.2 GHz Intel Core i5-4460  8GB | 1TB 7.2k +86B SSD| NVIDIA GeForce 6TX 750 (26B) | ASG20AJUS023|  769.00 3.6 GHz Intel Core i7-4790 | 166B 118 AMD Radeon R7 260X Graphics (26B) | IBNAO10 | 1,000.99
35 GHZAMD FX-T70K_ | 868 71B 7.2k |AMD Radeon R9 270 GPU (26B) ASG208MUS005| _774.00 3.8 GHzAMD FX-4300 Vishera  8GB | 178 | AMD Radeon R7 260X Graphics (26B) | IBNADTZ | 729.99

www.BandH.com




COMPUTERS

SarnDisk' Cruzer Blade
USB Flash Drive

» Easily Share Files
» Mac and PC Compatible

8GB (SACB3GBB) 449
16GB (SACB16GBB) 5.95

USB Flash Drive

» USB 3.0 Technolagy

» Capless Design

» Durable Metal Casing

» Max Data Read Speed: 100 MB/s
86B (KIDTSE96286) .....
166B (KIDTSE962166) ..
326B (KIDTSEI62326) ........

64GB (KIDTSE9G2646) ... 23.50
1286B (KIDTSE962126) ... 44.96

USB Flash Drive

» USB 3.0 Interface
» Windows, Mac and
Linux Compatible \‘.
e

8GB (KIDT1006386B)............ 5.95
166B (KIDT10063166).......... 6.91

326B (KIDT10063326).......11.95
64GB (KIDT10063646)..........22.54

PPINY. Technologies Turbo

USB Flash Drive .,
. - Q’

1668 (PNT166B).... 9.9

» USB 3.0/ USB 2.0 Compatible

» Compatible with Mac, PC

326B (PNT3268)..... 12.99  1286B (PNT12868) ... .49.99
64GB (PNTO4GB).............. 19.95  256GB (PNT2566B)...........89.95

Lexar S73 JumpDrive
USB Flash Drive

» USB 3.0 Technolagy

» Max Data Read Speed: 100 MB/s
» Max Data Write Speed: 55 MB/s

» Mac and PC Compatible

» Advanced Security Software

166B (LEJDS7316GB) 13.95
64GB (LEJDS73646B) 34.95

& transcend” JetFlash 710
USB Flash Drive

» USB 3.0 Interface

» Sturdy Metallic Structure

» Dust, Shock, Water Resistant \

» NAND Memory Technology

8GB (TRJF71086B) ... 7.99  32GB (TRJF710326B)........ 12.99

16GB (TRIF71016GB)........... 9.99  64GB (TRIF71064GB)......... (2499

70

USB FLASH DRIVES

SarDisk’ Extreme

USB Flash Drive

» Max. Read Speed: 190MB/s

» USB 3.0 Interface

» Password Protection via SecureAccess \1’
» 26B Online Backup - YuuWaa Cloud Storage

166B (SACCZ68016GB) 20.95
326B (SACCZ680326B) 29.95
64GB (SACCZ68064GB) 44.95
Kingston DataTraveler | G4

USB 3.0 Flash Drive

» Pratection Cap
» Windows and Mac Compatible

» Large Loop for Attaching to Key Ring
» Backward Compatible with USB 2.0
8GB (KIDTIG48GB)......

e
-

. 22.80
326B (KIDTIG4326B)....... 1049 12868 (KIDTIG41266B)........ 44.95

\Y Verbatim. DataTraveler | G4
USB Flash Drive

» Capless USB Slider Design
» Plug-and-Play

» Fast USB 2.0 Data Transfer

16GB (VEUD16GB)............... 9.95
64GB (VEUD3Z2GB)............. 12.54

128GB (VEUD32GB)............. 12.54

PN Technologies Attaché
USB Flash Drive

» USB 2.0 Interface S
» Compatible with Mac, PC ._J-Y-

8GB (PNAGGB).......
16GB (PNAT6GB)... .
32GB (PNA3ZGB)..............10.89  128GB (PNA128GB)............. 44.99

Lexar JumpDrive TwistTurn
USB Flash Drive

» USB 2.0 Interface

» Capless Rotating Jacket

» Easily Transport Files

8GB (LEJDTT86B) 6.99
16GB (LEJDTT166B) 1.49
326B (LEJDTT326B) 9.95

& transcend* JetFlash 790
USB Flash Drive

» USB 3.0 Interface

» Capless Design / Slide-Out Connector
» LED Usage Status Indicator

» NAND Memory Technology NS
8GB (TRJF79086B)..... :

166B (TRJF7901668). .
32GB (TRJF7903268)............9.99  128GB (TRJF79012668B).......39.95

SarDisk' Cruzer Glide
USB Flash Drive

» SecureAccess Software Included

» 128-bit AES Encryption

» 26B Secure Online Storage via YuuWaa
» Retractable USB Connector

8B (SACC760868) 5.49
326B (SACCZ603268) 10.95
646B (SACCZ6064GB) 24.95
Kingston DataTraveler GE9 Gold-Plated

USB Flash Drive

» Plated in 24 Carat Gold

» Built-In Loop for Easy Attachment

» USB 2.0 Interface & Capless Design
» Windows, Mac & Linux Compatibility

8GB (KIDTGEI8GB) 4.95
16GB (KIDTGE9166B) 7.10

\Y Verbatim. DataTraveler GE9 Gold-Plated
USB Flash Drive

» Green, Blue, & Red Flash Drives f.',"
» USB 2.0 Interface e

» Retractable USB Connector :
» Downloadable Password Protection

4GB (VE4GSNGFDR3P)
16GB (VEBGSNGFDR3P)

@& PetiteKey A
USB Flash Drive

» USB 2.0 Interface » Secure AES 256-bit Encryption N 4
» Waterproof to 328" (100 m)

» Wuala Secure Cloud Storage ==

» Compatible with Windows and Mac 0S —

8GB (LAPKS) 9.99
16GB (LAPK16) 14.99
326B (LAPK32) 24.99

St ULTIMAUO03
USB Flash Drive

» USB 2.0 Interface

» Capless Design, Retractable Connector

» LED Status Indicator

» Free Download of SP Widget Software

» Compatible with Windows, Mac, Linux 0S

166B (SIUFDU03166K) 5.99
326B (SIUFDU03326K) 10.99

& transcend” JetFlash 770
USB Flash Drive

» §GB Data Storage Capacity

» UUSB 3.0 Interface e -

» Max. Read Speed: 85MB/s 9 5
» Max. Write Speed: 15MB/s

8GB (TRJF770868) 6.99
16GB (TRJF7701668) 9.99
326B (TRJF7703268) 11.99

800-947-5534 + 212-444-6740




EZ Elements

Portable Hard Drive

» USB 3.0 Interface

» Up to 5 Gb/s Data Transfer Speed

» Formatted for Windows 8, 7, Vista & XP
» Use with Mac Requires Reformatting

500GB (WEWDBUZG5000) ....49.99
750GB (WEWDBUZG7500) ... 64.00

1TB (WEWDBUZG0010)........ 59.99
2TB (WEWDBU6Y0020) .......99.00

@<> Rugged
Thunderbolt External HD
» One USB 3.0 Port

» Shock, Dust, Water Resistant

» One Integrated Thunderbolt Cable

2506B SSD (LATU3250) 279.99
5006B SSD (LATU3500) 499.99
1TB SSD (LATU31) 899.99
1TB (LARTUT) 179.99
2B (LARTU2) 249.99

G-DRIVE
Mobile Portable Hard Drive

» Time Machine Compatible

» Reformat for Windows

» Bus Powered

» Includes USB 3.0 Cable

» Transfer Rates up to 136MB/sec
» USB 3.0 Interface and USB 2.0 Compatible
» Mac Format HFS+ with Journaling

1TB (6T60MU3172) 99.95

TOSHIBA Canvio Basics

Portable External Hard Drive

» USB 3.0 Port

» Max. Data Transfer Rate: 56b/s
» 5400rpm Drive Speed

» 8MB Cache Buffer

» Plug-and-Play Connectivity

» Internal Shock Sensor

» Windows 8, 7, Vista, XP Compatible

» Also available in 2TB and 3TB in White and Silver

1TB (TOHDTB210XK3) 59.99

&) Transcend” StoreJet 25M3
Anti-Shock External HD

» USB 3.0

» Backup Software

» One-Touch Auto-Backup ‘
» Up to b Gbps Data Transfers g
» USB 2.0 Backwards-Compatible

» Durable Anti-Shock Rubber Casing

» Meets U.S. Military Drop Test Standards

1TB (TRSJ25M31) 57.99
2TB (TRTS2TSJ25M3) 99.99

www.BandH.com

PORTABLE HARD DRIVES

EZ3 My Passport Drive
Portable Hard Drive

» USB 3.0 Interface

» WD Security Utility

» WD Drive Utilities

» Formatted HFS+ Journaled

» USB 3.0 Data Transfer Rate Up to 5 Gb/s

» USB 2.0 Data Transfer Rate Up to 480Mb/s

=
-y Pt
-

500GB (WEBLUZS000AS) 59.00
1TB (WEBLUZ0010BS) 69.00
2TB (WEWDBZYL0020) 99.00
@<> Rugged

Mini Portable Hard Drive

» USB 3.0 Interface

» Transfer Rate Up to 56b/s

» 47.2" Maximum Drop Height
» LaCie Private-Public Seftware
» Automatic Backup

50068 7200rpm (LARMDU35007) 79.99

17B (LARMNUS1) 109.99

2TB (LARMD?) 149.99
G-DRIVE

Mobile Hard Drive with Thunderbolt

» Transfer Rates up to 136 MB/s
» Bus Powered via Thunderbolt/USB e
» Time Machine Compatible P ;
» USB 3.0 and Thunderbolt

Cables Included
» Preformatted HFS+ for Mac
» Can be Reformatted for Windows

1TB (6T0603040) 189.95

Seagate () Backup Plus Slim
Portable External USB HD
» USB 3.0 Port

» 5400rpm Disk Speed

» Pre-Loaded NTFS Driver for Mac

» Seagate Dashboard for Automatic Backup ‘ '
» Max. Sustained Read/Write Speed: 100MB/s ‘ '
» Use on Windows, Mac Without Reformatting

5006B (SESTCD500104) 64.99
1TB (SESTOR10006) 64.00
2TB (SESTDR200016) 89.00

'HGST Touro S
Ultra-Portable External HD
» USB 3.0 Interface

» 7200 rpm Rotational Speed

» Up to 5 Gb/s Data Transfer Rate

» Preformatted NTFS for Windows

» Windows / Mac Compatible

500GB (HGTS500P) 59.00
1TB (H6TS1P) 72.95

COMPUTERS

21 My Passport
Ultra Portable HD
» Desktop HD Enclosure

» USB 3.0 Interface

» Bus Powered

P

» Local and Cloud Backup

» Windows 8 Compatible ‘ ‘ ‘

» Data Transfer Rates up to 5 Gb/s

500GB (WEMPUS00BY) 54.99
1TB (WEMPU1B) 59.00
2TB (WEMPUZB) 89.00

@3 Rugged Triple Interface
Portable Hard Drive

» AES 256-Bit Encryption
» USB 3.0 & FireWire 800 Ports
» Works with FireWire 400 &
USB 2.0
» Max Data Transfer Rate of
Up to BOMB/s
» AES 256-Bit Encryption
1TB (LARTY)
2TB (LART2)

—_ -
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Lo o
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G-DRIVE ev ATC
Hard Drive with Thunderbolt

» Rugged, All-Terrain Drive Solution
» Shock Resistant up to 6.6/ 2.0m
» Water, Pressure, and
Dust Resistant
» Floats In Water
» Case Interface: Thunderbolt 10 Gb/s
» Drive Interface: USB 3.0 and SATA
» Formatted for Mac
1TB (GTGDEVATCI) 199.95

=

seagate(C" Expansion

Portable Hard Drive

» SuperSpeed USB 3.0 Port

» Backwards Compatible
with USB 2.0

» USB 3.0 Cable

1TB (SESTEA100040)

seagate (€' Portable SSD T1
External HD

» 450 MB/s Data Transfer Speed

» Internal Solid-State Drive

» USB 3.0 Interface

» AES 256-Bit Encryption

(2]
o
=3
-3

250GB (SAMUPS2508AM) 134.00
5006B (SAMUPS500BAM)
1TB (SAMUPS1TOBAM)




COMPUTERS

EZ Elements
External Desktop HDD

» USB 3.0/ USB 2.0 Interface

» Up to 5 Gb/s Data Transfer Rate

» Plug-and-Play Compatible

» Reformat Required for Use
with Mac 0S X

2TB (WEWDBWLG0020)....... 89.99
3TB (WEBWLG0030HB) ... 109.99

4TB (WEWDBWLG0040) ... 149.99
5TB (WEWDBWLG0050)......199.99

EZ My Book Studio
Studio Desktop HDD

» USB 3.0/ USB 2.0 Interface

» Up to 56b/s Data Transfer Rate

» Pre-Formatted Mac 0S X 10.6.5 or Later
» Requires Reformatting for Windows 0S
» Password Protection o
» WD Drive Utilities

2TB (WEWDBHMLOD20) ... 113.05
3TB (WEWDBHMLO030) ..o 129.20
LTB (WEWDBHMLOOAD) oo 159.00

G-DRIVE
USB External Desktop HD

» 7200 rpm Speed

» 64MB Cache

» Integrated Heat Sink

» Preformatted HFS+
for Mac

» USB 3.0 and FireWire Connectivity

» USB/FireWire Cables Included » Time Machine Compatible

2TB (6760U32) 169.95
4TB (GTGDU34) 249.95
> (2 Quadra
Desktop Hard Drive § e
» External Drive with 3TB Capacity N

» USB 3.0/ FireWire 800 / eSATA Ports

» Up to 130MB/s Data Transfers via USB 3.0

» Supports FireWire Daisy-Chaining

» Simple, User-Friendly Backup Software

» Stackable and Rack-Mountable

» Heat-Sink and Eco Power-Management Mode
3TB (LAD20HD3V3) 199.99
5TB (LAD20V35) 299.99

External Drive

» 7200 rpm Disk Speed
» Disk Healt_h Monitoring s
» Auto-Sensing Power Input 0 -

» Quiet Intelligent Cooling Fan
» Read/Write Speeds up to 184 MB/s
» USB 3.0, FireWire 800 and eSATA Ports

1TB (6LS1000)................. 174.99
2TB (6LS2000) ................214.99  4TB (GLS4000) ................ 349.00
3TB (6L53000)................249.00  5TB (GLS5000) ............... 399.00

DESKTOP HARD DRIVES

CZ) MyBook

External Hard Drive for Mac "
» USB 3.0 Connectivity

» Time Machine Compatible

» Preformatted in HFS+Journaled for Mac
» WD Security

» WD Drive Utilities

» Windows Compatible (Requires Reformat) -

2TB (WEWDBYCC0020) .......99.00  4TB (WEWDBYCC0040) .....129.00
3TB (WEWDBYCCO0030) ... 109.00  6TB (WEWDBYCC0060) ......229.00

seagate(C" Expansion

External Desktop USB 3.0 HD
» USB 3.0/2.0 Interface, Cable Included

» Automatically Recognized by Windows

» Preformatted NTFS for Windows

» Windows 8, 7, Vista, XP SP3 (32/64 bit)

3TB (SEEDT3TBY) 104.00
5TB (SEEDTHTBY) 169.99
G-DRIVE
External Desktop HD with
Thunderbolt

» One Thunderbolt Port 2
» One USB 3.0 Port
» Upto 165 MB/s Data

Transfer Speed
» Preformatted HFS+ for Mac
3TB (6760T3) 279.95
4TB (6T6DT4) 379.95
6TB (6T60T6) 499.95

> d?2 Thunderbolt 2
Desktop Hard Drive

» Data Transfer Rates up to 220 MB/s
» 7200 rpm Rotational Speed

» Two Thunderbolt 2 Ports

» One USB 3.0 Port

» AES 256-bit Software Encryption

» Fan-Free AU-Aluminum Enclosure

31B (LAD2T23) 299.99
4TB (LADZT24) 349.99
6B (LADZT26) 449.99

‘HGST Touro Deskpro
External Hard Drive

» 64MB Cache

» 8 ms Seek Time

» Fast USB 3.0 Interface

» Includes 3 GB of Cloud Storage
» Enormous Storage Capabilities

4TB (HGTDP4) 169.00

21 MyBook
Desktop HDD

» USB 3.0 Interface

» Up to 56b/s Data Transfer Speed
» Local and Cloud Backup

» Preformatted for Windows 8, 7, Vista, XP
» Reformat for Mac 0S X Operating Systems
» WD SmartWare Pro

» Acronis True Image WD Edition
2TB (WEWDBFJK0020)........ 99.00
3TB (WEWDBFJK0030) ... 109.00

4TB (WEWDBFJK0040).......129.00
6TB (WEWDBFJK0060).......199.00

5TB (SESTDT500010).......... 149.99
6TB (SESTDT600010)....... 219.00
8TB (SESTDTB00010)........ 249.99

seagate(C" Backup Plus
Desktop Drive

» One USB 3.0 Port

» i0S / Android Compatible Seagate App
» Simplified Backup Options

» Windows & Mac Compatible

2TB (SESTDT200010)........... 99.00
3TB (SESTDT300010)........... 99.99
4TB (SESTDT400010).........149.99

G-DRIVE

Professional Strength External HD
» One USB 3.0 Port
» One eSATA Port
» Two Firewire 800 Ports L&
» 7200 RPM Speed
» SATA 6Gbps Interface » 64MB Cache
» Customizable for up to 16 Partitions

2TB(GTODO2)...oo 199.95
3TB(GTODO3)....o 229.95
BB (BTODOA) .o 299.95

@=> FA. Porsche Designed
Desktop Hard Drive

» Capacity of bTB

» USB 3.0 Port

» Data Transfers Up to 5Gbps

» Wuala Cloud Storage with 106B
» Backup and Password Protection Software
» Eco-Mode » Classic, Thick, Aluminum Design

3TB (LAHDPIZ303) ..o 129.99
ATB {LAHDPIB20) ... 159.99
BTB (LAP230) 179.99

TOSHIBA Canvio

Desktop External Hard Drive

» USB 3.0 Interface

» 5700 RPM Speed

» 32 MB Cache Buffer

» Compact Desktop Design

» Easy-to-Use Backup Software
» Secure Backup with Password

2TB (TOHDECBY) .............. 78.56
3TB (TOHDECBS) ........... 104.00  5TB (TOHDECBS) ............. 154.56
4TB (TOHDECBY)............ 128.64  6TB (TOHDECBO) ... 222.43

800-947-5534 + 212-444-6740




EZ3 My Book Duo
External RAID Storage

» Two USB 3.0 Ports

» Formatted in NTFS for Windows
» Max. Data Transfer Rate: 290 MB/s
» 156-Bit AES Encryption

» RAID 0, 1, and JBOD Configurations
» Includes WD Drive Utilities

» User Serviceable Enclosure
4TB (WEWDBLWEDD4D) ......249.00
6TB (WEWDBLWED060) ......299.00

8TB (WEWDBLWE008D) ... 349.00
12TB (WEWDBLWED120) ....499.00

G-RAID
External Hard Drive Array + Thunderbolt
» Dual Thunderbolt Ports
» RAIDO
» 2 SATA 11l Drive Bays
» Time Machine Ready
» Data Transfer Rate of up to 327 MB/s
» Daisy-Chain up to 6 Thunderbolt Devices

BTB (BTBRTATB).....occ 499.95
GTB (GTORTOTB)....o 549.95
BTB (GTORTBTB)..... 699.95

EXREH Pegasus2 R4
Thunderbolt 2 RAID Storage Array

» Two Thunderbolt 2 Ports
» 4 Hot-Swappable Drive Bays
» Pre-Configured in RAID 5 Mode
» Supports RAID 0,1, 5, 6,10
» Mac Compatible
» Compatible with
Time Machine in 0S X

8TB (PRPZR4HDBUS)

Call Or Log-on

@D Ihig

Thunderbolt 2 Series 2-Bay RAID
» Dual Thunderbolt 2 Ports o
» Preconfigured HFS+ RAID 0

» RAID 0/ 1/ JBOD Compatible

» Easy RAID Selection Button
» Max. Data Transfer Rates of 360 MB/s
» USB 3.0 for PC and Mac Compatibility

OTB (LAZBTZ6) . 599.00
BB (LAZBTZ8) ... 699.00
1278 (LA2BT212) 899.00

Storage Array

» 7200 RPM Disk Speed

» RAID 0and 1 Support

» Auto-Sensing Power

» Disk Health Monitoring

» Quiet Intelligent Cooling Fan
» USB 3.0, FireWire 800 & eSATA Ports

2TB (6LSR2000)............... 299.99
4TB (6LSRA000)............. 359.00  8TB (6LSRB000)............... 639.00
6TB (6LSR6000)............... 499.00  10TB (6LSR10000).......... 780.00

www.BandH.com

CZ) MyBook
Thunderbolt Duo

» 2 x Thunderbolt Ports

» Up to 10Gb/s Data Transfer Rate

» Designed with Two Removable Drives
» RAID 0, 1 & JBOD Compatible

» Daisy Chain up to Six Devices

» Compatible w/ Mac 0S X 10.6.8 or Higher —

4TB (WEWDBUTVOD40) 449.00

6TB (WEWDBUTVO060) 499.00

8B (WEWDBUTVO0S0) 549.00
G-RAID

Storage System with Removable Drives

» One USB 3.0 Port

» One eSATA Port

» Two FireWire 800 Ports

» T200RPM Drive Speed

» Configurable RAID 0/1 and JBOD

» Aluminum Enclosure with Smart Fan

4TB (6T0603240) 449.95
8TB (6T0603244) 699.95
12TB (6T0603411) 1,199.95

EEREH Pegasus? R6
Thunderbolt 2 RAID Storage Array

» Two Thunderbolt 2 Ports
» 6 Hot-Swappable Drive Bays
» Pre-Configured in RAID 5 Mode
» Supports RAID 0, 1,5, 6, 10, 50
» Mac Compatible
» Compatible with

Time Machine in 0S X
12TB (PRPZR6HD12US)
18TB (PRP2R6HD18US)

Call Or Log-on
Call Or Log-on

@D 5hig

Thunderbolt 2 Series 5-Bay RAID

» Two Thunderbolt 2 Ports i
» Up to 660 MB/s Data Transfer Speeds .
» Preconfigured HFS+ RAID b

» RAID 0/1/5/6/10/JBOD Configurations

» Support for DisplayPort 1.2 Connectivity

» Advanced Cooling System

10TB (LASBT2R10) 1,299.00
20TB (LASBT220) 1,999.00
30TB (LASBT230) 2,999.00

-n#- ThunderBay 4
= Hard Drive Array

» SATAIII (6 Gb/s) Interface
» 7200 rpm, 32MB Cache

» Preformatted in RAID

» Two Thunderbolt 2 Ports
» Supports RAID via SoftRAID b Software
LTB (OWTB4TB24) ... 729.00
8TB (OWTB4TB2S)............ 849.00
12TB (OWTB4TB212)......... 969.00
16TB (0WTB4TB216) ... 1,148.00

20TB (0WTB4TB220)....1,279.00
24TB (OWT424)............ 1,929.00
32TB (OWT432)............. 3,239.00

RAID  COMPUTERS

dropo. 5D Kit
External RAID Storage

» Desktop HD Enclosure

» Holds 5 x 3.5” SATA I/II/Il HDDs

» Holds 1 x mSATA SSD

» Thunderbolt / USB 3.0

» Hot Swappable Drives

» Battery Backup

» Any Drive/Manufacturer/Speed/Spindle

20TB (DRDRDR5A21K3) 1,483.99

G-RAID Studio
Thunderbolt 2 External Storage System

» 330 MB/s Transfer Rate

» 7200rpm Drive Speed

» Supports RAID 0, 1, and JBOD

» Two Thunderbolt 2 Ports

» Preformatted for Mac

» Supports 2K and Compressed 4K Video
4TB (GTGRS6TB)
8TB (GTGRSSTB)
12TB (GTGRS12TB)

[EEEH Pegasus2 R8
Thunderbolt 2 RAID Storage Array

» Two Thunderbolt 2 Ports
» 8§ Hot-Swappable Drive Bays
» Pre-Configured in RAID 5 Mode
» Supports RAID 0, 1,5, 6, 10, 50, 60
» Mac Compatible
» Compatible with
Time Machine in 0S X

24TB (PRPZRBHDZAUS).......

@3 2big Quadra
USB 3.0 2-Bay RAID Array

» 7200 rpm Speed, 32MB Cache

» USB 3.0 and FireWire 800 Connectivity

» RAID 0, 1 Modes

» Hot Swappable Drives

» Email Alerts for Temp and RAID Events

» Includes USB 3.0 and FireWire 800 Cables
6TB (LA2BQ6)
87TB (LA2B08)
10TB (LA28D10)

BUFFALD DriveStation Duo
Storage Array

» 4TB Storage Capacity

» Includes 2 x 2TB Hard Drives

» SATA Il Internal Drive Interfaces

» 1xUSB 3.0 Interface

» Supports RAID 0/1/J80D

» Windows / Windows Server / Mac 0S X

LTB (BUHDWHATUSRT) .o 273.99
OTB (BUHDWHOTUSRT) .o 344.99
8TB (BUHDWHBTUSRT) oo 449.99
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COMPUTERS

EZ1 Red SATA
NAS OEM Hard Drive

» 3.5" Form Factor » 64 MB Buffer
» Fast SATA 6 Gbps Interface » Energy Efficient
» NASware 3.0 Technology

» 3D Active Balance Plus

2TB (WEWD20EFRX)
3TB (WEWD30EFRX)
4TB (WEWDAOEFRX)........... 149.00

5TB (WEWDS0EFRX)......... 209.99
6TB (WEWD6OEFRX).......... 249.00

< 850 Evo

Solid State Drive

» SATAIII 6 Gb/s Interface
» 2.5 Form Factor

» Up to 540 MB/s Sequential Read Speed
» Up to 520 MB/s Sequential Write Speed
120GB (SAMZ75E1208A) ... 71.99
2506B (SAMZ75E25084)....107.99
500GB (SAMZ75E50084) ....180.00

1TB (SAMZ75E1TOBA)......... 345.59
2TB (SAMZ75E2TOBA)........799.99

- -

DESKSTARNAS

‘HGST Deskstar
SATA Internal Hard Drive

» 4TB Storage Capacity

» 7200 rpm Rotational Speed

» 64 MB Cache Memory Buffer
» 1 Million Hours MTBF

» 6 Gb/s SATA Interface

3TB (HG0S03660)............132.99
4TB (HG0S03664)..........169.99

5TB (HGDSIHDY)............... 231.99
61B (HGDSIHDO.............. 269.00

seagate(C) Barracuda
Internal Desktop Hard Drive (OEM)

» 7200 RPM Spindle Speed » 64MB Cache
» 66b/s NCQ SATA Interface

» 4096 Bytes per Sector

» 300,000 Load/Unload Cycles

» 2,400 Power On Hours

» Seagate OptiCache Technology
3TB (SEST3000DMOD) ... 91.00

crucial MX100
Internal Solid State Drive
» SATA 6 Gb/s Interface N

» 2.5" Form Factor » TRIM Support -\\___
» 1.5 Million Hours MTTF "

» Integrated ECC Technology

128GB (CRMX100128) 84.00
2566B (CRMX100256) 109.00
5126B (CRMX100512) 209.95

San)isk’ ExtremePro

Internal Solid State Drive

» 550 MB/s Sequential Read Speeds

» 520 MB/s Sequential Write Speeds

» SATA 3 Interface

» Enhanced Shock & Vibration Resistance

2406B (SASSDXPS240) 124.00
480GB (SASSDXPS480) 214.00
960GB (SASSDXPS960) 429.99

INTERNAL HARD DRIVES

EZ2 Desktop Performance Caviar Black
HDD Retail Kit (WD4003FZEX)

» SATA 6 Gb/s Interface
» 3.5” Form Factor

» 64MB Cache

» 7200rpm Spindle Speed

1TB (WEIDDPT).................69.00
2TB (WEIDDP)............... 134.00  ATB (WEWDAOEFRX).......... 149.00

<« 850 PRO Series
Solid State Drive

» Sequential Read up to 550 MB/s
» Sequential Write up to 470 MB/s
» Random Read up to 100,000 10PS
» Random Write up to 90,000 I0PS
1286B (SAMZ7KE128BW).....97.99
25668 (SAMZ7KE256BW)...139.99
5126B (SAMZ7KES128W)...234.00

1TB (SAMZ7KETTOBW)........454.00
2TB (SAMZTKEZTOBW)....... 997.99

e e

DESKSTAR

'HGST Deskstar Coolspin
Internal Desktop Hard Drive

» 3.5" Internal Hard Drive
» SATAIII 6 Gbps Interface
» Power-Efficient CoolSpin Technology
» Compatible with Windows or
Mac Systems

4TB (HGHDIS34) 149.00

seagate(C) NAS
Internal HDD (OEM)

» SATA 66b/s Interface

» 64MB Multisegmented Cache
» Low-RPM Spindle Speed

» 600,000 Load/Unload Cycles
2TB (SEST2000VNO0)
3TB (SEST3000VNO0)
4TB (SESTA000VNOO)

crucial MX200

Internal Solid State Drive
» 7.0mm, 2.5” Internal SSD N
» SATA 6 Gb/s Interface
» 5b5 MB/s Read Speed
» 500 MB/s Write Speed

2506B (CR2506MX2005) 94.99
5006B (CR500GMX2005) 174.99
1TB (CR1TBMX200) 338.99

TOSHIBA Desktop

Internal Hard Drive

» SATAlll Interface

» Up to 6 Gb/s Transfer Rate

» 7200 rpm Spin Speed

» 64MB Cache Buffer

2TB (TOHDIB2) ... 79.99
3TB (TOHDIB3) ... 94.08  5TB (T0PH35000117) ... 139.99
4TB (TODTHDATB)............. 128.64  6TB (TOPH3600UTI7) ... 249.99

EZ Desktop Everyday
Green Hard Drive (WD40EZRX)

» SATA 6 Gb/s Interface
» IntelliPower Rotational Speed

» 64MB Cache

» 3.5” Form Factor

1TB (WEIDDM1) . .54.90  4TB (WEIDDM4) .
2TB (WEIDDM2) . .79.99  5TB (WEIDDM5) ..
3TB (WEIDDM3) ............... 93.99  6TB (WEIDDM6)

< 850EvomSATA .

Solid State Drive - l
» SATAIII (6 Gb/s) Interface - !
» mSATA Form Factor Samn 550 80510 l
» Samsung MGX Controller S

» Up to 540 MB/s Sequential Read Speed
» Up to 520 MB/s Sequential Write Speed
1206B (SAMIM5E1208W) .. 77.99  500GB (SAMZM5E5008W) . 197.99
25068 (SAMZM5E2508W)..107.99  1TB (SAMZMBETTOBW)......397.99

'HGST Travelstar
Mobile Hard Drive

» 118 Drive Capacity

» SATA Il Interface

» 32MB Cache

» 7200 rpm

» 6 Ghit/sec Data Transfer Rate
500GB (HG0S03788)
1TB (HGHDIS25)

Seagate@ Archive
Internal HDD (OEM)

» 128MB Cache (Multisegmented)
» NCQ SATA Il Interface

» 4096 Bytes per Sector

» 300,000 Load/Unload Cycles
5TB (SEST5000AS00)
6TB (SEST6000AS00)
8TB (SESTB000AS00)

Internal Solid State Drive

» LS| SandForce Controller
» Max Read and Write
Speed up to 450MB/s
» Max 4K Read Speed
up to 85,000 10PS
60GB (KISV30037A60)......... 45.99  2406B (KISV30037A24).....81.99
1206B (KISV30037A12)....... 59.99  480GB (KISV30037A48)......169.99

Lo imgston

intel) 930 Series
L/ Internal Solid State Drive

» 1.6 Form Factor

» Tmm Thickness

» Sequential Read Speed Up to 540 MB/s
» Sequential Write Speed Up to 490 MB/s
1206B (IN530120)
180GB (IN530180) 129.99
2406B (IN530240) 149.00

800-947-5534 + 212-444-6740




EZ3 My Cloud

Personal Cloud Storage

» Dual Core Processor

» Gigabit Ethernet

» USB 3.0 Expansion Port

» DLNA 1.5 and UPnP Certified
» Free Desktop and Mobile Apps
» Auto Network Discovery

2TB (WEWDBCTL0020) 149.00
4TB (WEWDBCTL0040) 199.00
6TB (WEWDBCTLO0OD) ... 292,99

EZ My Cloud EX4

Personal Cloud Storage NAS Server

» & Hot Swappable Drive Bays

» Two Gigabit Ethernet Ports

» Two USB 3.0 Expansion Ports

» 7 GHz Processor & 512MB RAM

» RAID 0, 1,5, 10, JBOD

» Device Management Dashboard

» Cloud & LAN/WAN Backup Options
8TB (WEMYEX4CS08) 699.00
16TB (WEMYEXACSTE)......999.00

899.99
24TB (WEMYEX4CS24)...1,379.00

12TB (WEMYEX4CS12)

logy DiskStation BeyondCloud Mirror

2-Bay NAS
» Two SATA 11l Drive Bays
» 800 MHz MARVELL

Armada 370 88F6707 CPU
» 256MB DDR3 RAM » Two x USB 2.0 Ports
» RAID 0, 1, Basic, Hybrid, & JBOD
» One Gigabit LAN Port -
» Up to 512 User Accounts
4TB (SYBC214SE220)
6TB (SYBC21452300) oo

seagate(C" Personal Cloud
2-Bay Home Media Storage NAS

» Simultaneous Back Up to Bath Drive Bays
» Create Your Very Own Cloud
» Seagate Media App

» Seagate Dashboard Software
» Access Content from Other Devices
» Stream Media from Your Smartphone/Tablet

4TB (SESTCS40001) 269.99
6TB (SESTCS60001) 361.99
BTB (SESTCSBO00T) - 549,00

BUFFALD TeraStation 3400

4-Bay NAS Server

» 16B DDR3 RAM

» Dual Gigabit NICs

» RAID 0/1/5/6/10/JB0D

» One USB 3.0 & Two USB 2.0 Ports

» Failover Support

» Remote File Access

» Dual-Core 1.33 GHz ARM Processor

» Buffalo Surveillance Video Manager
8TB (BUTS34008) ..o

www.BandH.com

NAS DRIVES

EZ My Cloud Mirror

External Hard Drive

» 1.2 GHz Pracessor

» 512MB RAM > Twa Drive Bays
» Centralized, Dual Drive Storage
» Remote/Automatic Backup ;
» Mirrored Data Protection (RAID 1) - -

» Remote access from PC/Tablet/Phone

4TB (WEWDBZVMO040) 299.00
6TB (WEWDBZVMO060) 379.00
8TB (WEWDBZVMOOBO) ... 579,99

2 My Cloud Business Series DL4100
4-Bay NAS

» 1.7 GHz Intel Atom C2338 Dual-Core

» 26B DDR3 RAM

» Two USB 3.0 Ports & 1 x USB 2.0 Port
» RAID0, 1,5, 10, JBOD, and Spanning
» Two Gigabit Ethernet Ports

» AES 256-bit Volume Encryption
» NASware Technology

8TB (WEDL41008TB) 849.00
12TB (WEDLA100K2) ........ 943.00

16TB (WEDL410016TB)...1,169.00
20TB (WEDL4100K3) .. 1,251.00

logy DiskStation DS214Play
NAS Server Kit with Drives -

» Includes 2 x 2TB Hard Drives
» Two Bay NAS Enclosure

» Dual-Core 1.66Hz Processor
» One USB 3.0/ 1x USB 2.0/ 1x eSATA Ports

» Gigabit LAN Connectivity

» SATA 6 Gb/s Interface » 64MB Cache per Drive
4TB (SYDS214PLAYK)

6TB (SYDS214PLAK2)

8TB (SYDS214PLAKS) ..o

seagate () STCT2000100
2-Bay NAS Server

» ARM 1.2 GHz Processor

» 512MB DDR3 Memory

» One Gigabit LAN, Wake on LAN

» iSCSI, SNMP Integration

» RAIDO,1,and JBOD » Two USB 3.0
» Seagate Apps, Plus Third-Party Apps
» Mac, Windows, Linux Compatible
2TB (WEMYEX4CS08) 699.00  4TB (SESTCT400010) 299.99
8TB (SESTCT800010) ..........499.99  10TB (SESTCT100001) .....599.99

o o1 B~
o~ N o
o1 o o
S © 3

BUFFALD LinkStation 420

RAID NAS Server

» 1% 2TB Internal Hard Drives

» 1.2 GHz Dual Core Processor

» High Performance Gigabit Ethernet

» USB Part for Backup or Printer Sharing
» DLNA Certified

» iTunes &PS3 Media Server

» Easy-To-Use Setup Wizard

N
~
oy
o~
~

4TB (BULSA20D0402) ...

COMPUTERS

EZ My Cloud EX2

Personal Cloud Storage Server

» Two Hard Drives

» Two 3.5" Hard Drive Bays

» 1.2 GHz Processor, 512MB RAM

» RAID 0, 1, JBOD & Spanning Modes
» FTP, Backup, & P2P Server Options
» Disk Spin-Down / Scheduled On/Off

6TB (WEBVKWO060JC) 399.00
8TB (WEBVKWO080JC) 499.00
12TB (WEWDBVKWOT20).....ooccc. 679,99

EZ3 Cloud Expert Series EX2100
2-Bay NAS

» 2x3.5" SATA Drive Bays

» 1.3 GHz ARM Dual-Core Processor

» 16B DOR3 RAM » Two x USB 3.0 Ports

» RAID (0, 1, JBOD, and Spanning

» Two Gigabit Ethernet Ports

» AES 256-bit Volume Encryption

4TB (WEMCEX21004)

8TB (WEMCEX21008)

T2TB (WEMCEXZ10012).o

logy" DiskStation DS1515+
4-Bay NAS
» 2.4 GHz Intel Atom C2538 Quad-Core
» 268 DDR3 Memory
» & x Gigabit Ethernet Ports
» 4xUSB 3.0/ 2 x eSATA Ports
» RAIDO, 1,5,6,10, JBOD Support
» Read: 450.77 MB/s, Write: 396.50 MB
10TB (SYDS1515PK1) ... 1,264.94
15TB (SYDS1515PK2) .. 1,329.99
20TB (SYDS1515PK3) .. 1,514.99

/s

25TB (SYDS1515PK4) .. 1,714.99
30TB (SYDST515PK5)..... 2,064.99

seagate () STDF24000100
6-Bay NAS Pro Server

» Intel Dual-Core 1.7 GHz Processor
» 268 DDR3 Memory

» RAID0,1,5, 6,10, and JBOD

» Two Gigabit LAN, Wake on LAN

» iSCSI, SNMP Integration

» One USB 2.0 and Two USB 3.0 Parts
» Seagate Apps, Plus Third-Party Apps
6TB (SESTDF600010) 899.99  24TB (SESTDF240001)
1278 (SESTDF120001)...1,199.99

1,599.99
30TB (SESTDF300001).....1,999.99

BUFFALD LinkStation 210

NAS storage

» SATA 3 Gb/s Drive Interface

» One Gigabit Ethernet Port

» One USB 2.0 Port

» Enhanced Network File Services

» Create Your Own Personal Cloud

» Twonky, DLNA Server, iTunes Server
» Free Remote Access Service

3TB (BULS210D030) - 143,50




COMPUTERS

@ U2412M
UltraSharp 24” LED Monitor

» DVI-D with HDCP, DisplayPort, VGA &4 x USB 2.0 Ports
» 1920 x 1200 (@ 60 Hz Resolution

» 1000:1 Contrast Ratio

» 300cd/m2 Brightness

» 8ms Response Time

» 0.27 x 0.27mm Pixel Pitch

» 178 and 178 Degree Viewing Angle
» 16.7 Million Colors

(DEU2412M) e 284.48

/iSU= VE228H
21.5” Widescreen LED Backlit LCD Monitor

» VIGA + DVI-D + HDMI Inputs
» 1920 x 1080 Resolution |
» 10,000,000:1 Contrast Ratio |
» 250cd/m? Brightness

» 170°/160° Viewing Angles
» bms Response Time

» 16.7 Million Colors

» Integrated Stereo Speakers
(ASVE228H)

Authorized Apple Dlsplay

Reseller  27” Thunderbolt Display
» Thunderbolt Port + FireWire 800 » 3 x USB 2.0
» Gigabit Ethernet Port
» Kensington Security Slot
» 1000:1 Contrast
» 178°/178° Viewing Angle
» 12ms Response Time
» Built-In 2.1 Speaker System
» Built-In Face Time HD Camera with Mic
[APMC914LLB) ..929.00

NEC PA272W-BK
27” LED Backlit Wide Gamut LCD Desktop Display

» HDMI + (Mini) DisplayPort + DVI-D » 2560 x 1440 Resolution
» 1,000:1 Contrast Ratio » 16:9 Aspect Ratio

» 340 cd/m? Brightness

» 178°/178° Viewing Angles
» 6 ms Response Time

» 1.07 Billion Color Support
» 14-bit Lookup Table

» Enhanced Color Gamut
(NEPA272WBK)

all Or Log-on

<ICEr S220HQL Abd
27” LED Backlit Wide Gamut LCD Desktop Display

»100,000,000:1 Dynamic Contrast Ratio
» VGA + DVl Inputs

» 1920 x 1080 Resolution

» 250 cd/m? Brightness

» 170°/160° Viewing Angles
» bms Response Time

» 16.7 Million Colors

» LED Backlight
(ACS220H0L) e 124.40

MONITORS

@ E2414H
24” Widescreen LED Backlit TN LCD Monitor

» 16:9 Widescreen Aspect Ratio » 170°/160° Viewing Angle

» 1920 x 1080 at 60 Hz Optimal Resolution » 16.7 Million Colors
» 1000:1 Typical Contrast Ratio
» b ms Response Time

» DVI-D & VGA Connectivity

» Antiglare with Hard-Coating 3H
» 100mm VESA Mount

» ENERGY STAR/EPEAT Gold/TCO/CEL Certified
(DEE2414H)......... 155.00

/NSUS V62480E
24” LED Backlit LCD Monitor

» HDMI, DisplayPort, Dual-link DVI-D
» 1920 x 1080 Resolution

» 16.7 Million Colors

» §0,000,000:1 Contrast Ratio
» 144Hz Rapid Refresh Rate
» 3b0cd/m?2 Brightness

» 170°/160° Viewing Angles
» Tms Response Time
(ASVG2480QE)....... 249.99

" LDisplay Promo Z24i
24” Widescreen LED Backlit IPS Monitor

» 16:10 Aspect Ratio » 1920 x 1200 @ 60 Hz Native Resolution
» VIGA/DisplayPort 1.2/DVI-D Connectivity

» 16.7 Million Color Support ———
» 300 cd/m? Brightness

» 8 ms Response Time

» bxUSB 2.0 Ports » Low Halogen
» Arsenic-Free Display Glass

» ENERGY STAR/EPEAT Gold/TCO Certified
(HEZ24)............ 327.70

@ LG 34UM95-P
34” Widescreen LED Backlit UltraWide IPS Monitor

» 34" UltraWide 21:9 Display » 3440 x 1440 Resolution
» Covers 99% of the SRGB Color Spectrum
» |PS Panel Technology
» 320 cd/m? Brightness
» 178°/178° Viewing Angles
» 2 x HDMI Connectors
» 1x DisplayPort Connector
» 3xUSB 3.0/ 2 x Thunderbolt Ports
(LG34UM95) ...

__Call Or Log-on

W S$24C200BL
23.6” LED Backlit LCD Monitor

» D-Sub + DVI Inputs

» 1920 x 1080 Resolution

» 1,000:1 Static Contrast Ratio
» 250cd/m? Brightness

» 170°/160° Viewing Angles

» bms Response Time

» 16.7 Million Colors

» 100 x 100 VESA Mount Compatible

(SAS24C2008L) ... 189.99

@ U2415

24” Widescreen LED Backlit IPS Monitor
» In-Plane Switching (IPS) Technology » Built-In USB 3.0 Hub
» HDMI/Mini DisplayPort/DisplayPort Inputs

» 1920 x 1200 Resolution

» 1,000:1 Contrast Ratio

» 300 cd/m?2 Brightness

» 178°/178° Viewing Angles
» 6 ms Response Time

» 16.78 Million Color Support :
(0Evz415) —= 30999

/iSUS PB278Q

27” Widescreen LED Backlit LCD Monitor
» HDMI+D-Sub+DisplayPort+DVI-D Inputs

» 2560 x 1440 Resolution
» 80,000,000:1 Contrast Ratio
» 300cd/m? Brightness
» 178°/178° Viewing Angles
» bms Response Time
» 2 x IW Speakers

(ASPB2780) S 399.99

7 EliteDisplay Promo E241i

24” Widescreen LED Backlit IPS Monitor
» 24" Widescreen LED Backlit IPS Monitor » 16:10 Aspect Ratio
» 1920 x 1200 Resolution |
» 178°/178° Viewing Angles
» 1,000:1 Static Contrast Ratio
» 250 cd/m?2 Brightness
» Tilt, Swivel, Pivot Adjustable
» 8 ms Response Time » 3 x USB 2.0 Ports
» TXDVI/1XVGA/1xDisplayPort 1.2 Inputs

(HEE241) - - 249.99

BeNQ GW2765HT

27” Widescreen LED-Backlit LCD IPS Monitor

» 27" IPS Technology Panel -

» 25601440 WOHD Resolution

» LeroFlicker & Low Blue Light
for extended viewing comfort

» HDMI Multimedia Interface

» Built-in Speakers

» Ultra-Flexible Height
Adjustment System (HAS)

(BEGW2765HT)

10C E1649FWU

16” Widescreen LED Backlit Portable LCD Monitor
» 1366 x 768 Maximum Resolution » WLED Backlight

» USB Powered

» 200cd/m? Brightness

» 500:1 Contrast Ratio

» 16ms Respanse Time

» 0.252 x 0.252mm Pixel Pitch
» 90° x 50° Viewing Angle

» 262K Color » Foldable Stand
[AOE1649FWU)

800-947-5534 + 212-444-6740




@ P2715Q
27” Ultra HD 4K Monitor

» In-Plane Switching (IPS) Technology » Built-In USB 3.0 Hub
» DisplayPort Input + DisplayPort Output » 1.07 Billion Colors
» 3840 x 2160 Resolution
» 2,000,000:1 Contrast Ratio
» 350 cd/m?2 Brightness

» 178°/178° Viewing Angles
» 9 ms Response Time -
» Mini DisplayPort + HDMI (MHL) Inputs
(DEP27150) S ———— 519.99

/1iSU= PB2870 28” widescreen
WLED Backlit LCD 4K UHD Monitor

» 28" Widescreen 4K UHD Monitor » 3840 x 2160 4K Resolution
» 300 cd/m? Brightness

» 1.073 Billion Color Support

» 170°/160° Viewing Angles

» § x SPLENDID Video Preset Modes
» 3 x Skin Tone Selection Modes

» & x Color Temperature Selection Modes
» 2x2 W lntegrated Sterea Speakers

(ASPB2870) S 481.73

127s
27” Widescreen LED Backlit IPS Monitor
» In-Plane Switching (IPS) Technology » 1.07 Billion Colors
» HDMI 1.4/DisplayPort/Mini-DisplayPort
» 3840 x 2160 Native Resolution
» 1,000:1 Static Contrast Ratio
» 300 cd/m?2 Brightness
» 178°/178° Viewing Angles
» 6 ms Response Time
» 4x USB 3.0 Ports

(HEZ27S) et 699.00

10C U2868PQU
28” 4K Ultra HD Professional Display

» 28" 4K Ultra HD Display » HDMI + DisplayPort + DVI + VGA
» 3840 x 2160 Native Resolution @ 60 Hz
» 70,000,000:1 Dynamic Contrast Ratio J§
» 1.073 Billion Colors |
» 300 cd/m?2 Brightness

» 170° / 160° Viewing Angles
» 2% USB 3.0 Ports &2 x USB 2.0 Parts
» 2 x 3W Stereo Speakers

(A0U2868PQU) e 479.22

yz4x-rite ColorMunki Photo
Color Management Solution
» Camera, Monitor & Projector Profiling
» RGB & CMYK Printer Prafiling
» Ambient Light Measurement
» Spat Color Measurement
» Built-in White Calibration
» No Cumbersome Accessories
» DigitalPouch

Communication Tool

(XRCMP)

omunki GEED -

www.BandH.com

4K MONITORS & CALIBRATION SOLUTIONS

@ UP24140 24” widescreen
LED Backlit IPS Ultra HD LCD Monitor
» 1.07 billion colors (8-bits +AFRC)

» HDMI/DisplayPort/mini-DisplayPort Inputs
» Can Display 99% Adobe RGB / 100% sRGB

»2,000,000:1 Dynamic Contrast Ratio
(DEUP24140).. ——630.99

» 3840 x 2160 Resolution

» 350 cd/m? Brightness

» 178°/178° Viewing Angles
» 8 ms Response Time

ViewSonic' VP2780-4K

27” Widescreen LED Backlit 4K LCD Monitor
» Active Matrix TFT LCD Technology » 3840 x 2160 Resolution

» HOMI (MHL) / DisplayPort Inputs
» 1,000:1 Contrast Ratio

» 350 cd/m? Brightness

» 178°/178° Viewing Angles
» b ms Response Time

» 1.07 Billion Color Support
» Built-in USB 3.0 Hub

(VIVP27804K). = 799.99

BenQ BL3201PH
32” Widescreen LED Backlit LCD IPS 4K Monitor
» In-Plane Switching (IPS) Technology
» DVI-DL/DP1.2/ mDP1.2 / Dual HOMI
» 3840 x 2160 Resolution

» 1,000:1 Contrast Ratio

» 350 cd/m2 Brightness

» 178°/178° Viewing Angles

» 1.07 Billion Color Support » USB 3.0 Hub
» 100% SRGB Color Gamut

(BEBL3201PH) 919.89

PHILIPS Brilliance
28” 4K Ultra HD LED Backlit Monitor

» 4K Ultra HD WLED-Backlit Display » 1.07 Billion Colors

» 3840 x 2160 [@ 60 Hz Native Resolution » 1,000:1 Contrast Ratio
» 50,000,000:1 SmartContrast Ratio
» 300 cd/m? Brightness

» 170°/160° Viewing Angles

» b ms Response Time

» 2xUSB 3.0 &2 x USB 2.0 Parts

» HDMI + DisplayPort + Dual-Link DVI + VGA

(PH288PALJEB) 583.10

rz4x-rite ColorMunki Smile
Color Management Solution
» Intuitive Color Calibration Solution
» For Use with One or Mare Displays
» Includes Color
Measurement
Device and CD

(XRCMS) ...... Call Or Log-on

COMPUTERS

@ U280590D
28” UHD LED TN Monitor

» 3840 x 2160 Resolution » Displays 1 Billion Colors
» 370 cd/m?2 Brightness o
» Contrast Ratio: 1,000:1

» 170°/160° Viewing Angles
» Response Time: 1 ms

» Headphone Jack

» Metallic Easel Stand Tilts -1t0 15° A
» 1x DisplayPort and 2 x HDMI Connectors ————

(SAU28D590D) e 512.15

NEC MultiSync EA244UHD
23.8” 4K IPS LED Monitor

» 3840 x 2160 UHD Resolution
» Contrast Ratio: 1,000:1

» 350 cd/m? Brightness

» 178°/178° Viewing Angles

» Response Time: 6 ms

» ControlSync &3 x USB 3.0 &
» 2% DVI-D, 2 x DisplayPort, & 2 x HOMI
» 100 x 100mm VESA Mount Compatible

(NEEA244UHDBK)

Call Or Log-on

@ LG Digital Cinema 31MU97-B
31” Widescreen LED Backlit IPS 4K Monitor

» In-Plane Switching (IPS) Technology
» HDMI / DisplayPort / Mini DisplayPort
» 4096 x 2160 Resolution

» 1,000,000:1 Contrast Ratio
» 320 cd/m? Brightness

» 178°/178° Viewing Angles
» 17:9 Aspect Ratio

» AdobeRGB 99.5% / DCI-P3 97% Gamut

(L63TMU97B)

31.5” LED Backlit IPS LCD Monitor

» In-Plane Switching Technology » 3840 x 2160 Resolution
» DisplayPort / DVI / HDMI Inputs

» 1,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles
» 5 ms Response Time

» 16.77 Million Color Support
» Built-In USB 3.0 Hub

(EIEV3237FXBK)

all Or Log-on

..1,703.99

datacolor s Spyder5PRO

Display Calibration System

» Calibrate Laptops, Desktop Monitors

» Includes
Color Probe

» 16 Calibration
Choices

» 3 Ambient
Light Settings

Spyder4rs

————

b

(DAS5P100) S 189.00




COMPUTERS GRAPHIC DISPLAY CARDS

NVIDIA GeForce GTX 980Ti Graphics Cards

With a slightly altered “Big Maxwell” chip, NVIDIA's GeForce GTX 980 Ti Superclocked Graphics Card is geared
towards high resolution gaming at fast frame rates. With its 2816 CUDA cores overclocked to 1102 MHz and
6GB of GDDRY5 vRAM coupled with a 384-bit interface, the GTX 980 Ti packs quite a processing punch. While

the card operates under its thermal limits NVIDIA's GPU Boost can increase the clock speed up to 1190 MHz for
smoother gameplay.

The GTX 980 Ti's CUDA cores are arranged using NVIDIA's Maxwell architecture, allowing the GPU to operate using

less power while generating less heat than the previous generation Kepler architecture. Operating at full tilt during intense gaming sequences,
the card will only draw a maximum of 250 watts of power. Each GeForce 980 Ti delivers 4k resolution (4096 x 2160) in Dual Slot PCle 3.0 x16
interface, with 66B GDDR5 memory, 384-bit memory interface, 2816 CUDA Cores and outputting to four display monitors simultaneously.

| e BGA L BGA | BGA L BGEG Ggbe | MSL WS ol

; " . GTX980Ti GTX 980 Ti 6TX 980 ) ) ) ) )
Model GTX 980 Ti GTX 980 Ti GTX 980 Ti Superclocked Superclocked Ti Hybrid GTX 980 Ti 61 GTX 980 Ti GTX 980 Ti GTX 980 Ti GTX 980 Ti
Base Clock 1000 MHz 1000 MHz 1000 MHz 1102 MHz 1102 MHz 1140 MHz 1152 MHz 1000 MHz 1000 MHz 1000 MHz 1253 MHz
Max Boost Clock 1076 MHz 1076 MHz 1076 MHz 1190 MHz 1190 MHz 1228 MHz 1291 MHz 1076 MHz 1279 MHz 1076 MHz 1353 MHz
Tx DVI-I DL Tx DVI-I DL Tx DVI-I DL Tx DVI-I DL Tx DVI-I DL x DVI-I DL 11f([I]J\\II|I[I][[]]LL 1x DVI-I DL Tx DVI-I DL Tx DVI-I DL Tx DVI-I DL
Display Ports 3x DisplayPort 3x DisplayPort 3x DisplayPort 3x DisplayPort 3x DisplayPort 3x DisplayPort s DisplavPort 3x DisplayPort 3x DisplayPort 3x DisplayPort | 3x DisplayPort
Tx HOMI Tx HOMI Tx HOMI 1x HOMI Tx HOMI Tx HOMI 1x|l-)IDr\y4I Tx HOMI Tx HOMI Tx HOMI Tx HOMI
n Blower-Style ACX 2.0+ Blower-Style " Hybrid Liquid/Air Windforce Express Fan Twin Frozr V Blower-Style IceStorm
Cooting Cooler Cooler Cooler Blower-Styte Cooler | ACK.0+ Conler Cooler 3x Cooler Cooler Cooler Cooler Cooler
SKU ASGTX980TI66 EV6GP44991 EVGTX980TI66 EVGTX980TISC EV6GP44993 EV6GP41996 GIVN9BTG1666 MSGTX980TIV1 MSGTX980TI66 106TX980TI66 10219050510
Price $659.99 649.99 669.99 705.00 659.95 759.95 689.99 Call Or Log-on 679.99 Call Or Log-on 692.959

NVIDIA GeForce GTX 970 Graphics Cards

Packed with 4GB of GDDR5 vRAM and a processor core speed boostable to 1178 MHz the NVIDIA
GeForce GTX 970 Graphics Card can drive displays with native resolutions up to 4096x2160. Gamers can take
advantage of the card’s integrated performance technologies to improve frame rates and reduce unwanted

artifacts like tearing and aliasing when playing games at high resolutions.
Not only useful for gaming, the GTX 970 is powered by NVIDIA's Maxwell architecture which leverages the parallel
configuration of the 1664 CUDA cores to accelerate PC performance. These cores are useful when carrying out
processor intensive tasks like video conversion, 3D graphics rendering, and anything that benefits from parallel processing.

The four simultaneous outputs from the card can support multiple displays and create an immersive gaming experience with NVIDIA's Sur-
round technology. Each GeForce GTX 970 delivers 4k resolution (4096 x 2160) in Dual Slot PCle 3.0 x16 interface, with 4GB GDDR5 memory,
256-bit memory interface, 1664 CUDA Cores and outputting to four display monitors simultaneously.

oo | b | dos | B o | 0ok | BGA | G| Gt | Gt G| W W9 | NS | o

GeForce GTX

Strix Turbo Geforce GeForce GeForce eforce eforce GeForce GTX |  GeForce GeForce eforce 970 Million Geforce Geforce GeForce
Model GeForce GeForce GTX 970 X970 6TX 970 6TX 970 G6TX 970 970 FIW X970 6TX 970 6TX 970 Milestone GTX 970 GTX 970 6TX 970
GTX 970 GTX 970 Mini SuperSC | Superclocked Mini Edition Overclocked | Overclocked
BaseClock | 1114MHz | 1088MHz | 1088MHz | 1050 MHz | 1050MHz | 1190MHz | 1165MHz | 1216MHz | 1114MHz | 1178 MHz | 1076 MHz | 1051MHz | 1076MHz | 1102MHz | 1076 MHz
Maa:;?st 1263MHz | 1228 MHz | 1228MHz | 1178MHz | 1178MHz | 1342MHz | 1317MHz | 1367MHz | 1263MHz | 1329 MH: 1216MHz | 1279 MHz | 1216MHz | 1241 MHz | 1216 MHz
DVI-D DL Port 1 1 1 1 1 - 1 1 1 1 1 1 - 1 1
DVI-I DL Port 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
DisplayPort 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3
HDMI Port 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
Coolin DirectCU II' | Turbo Blower- | DirectCU Mini | Blower Style | ACX 2.0 ACX 2.0 + ACX2.0 ACX2.0 | Windforce 3x | Windforce 3x | Blower Style | Twin Frozr V| Blower Style | Armor 2X | Blower Style
9 Cooler Style Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler Cooler
SKU ASGTX970FOC | ASGTX9704GB | ASGTX9704GD5 | EVGTX970 | EVGTX970ACXZ | EVGF97046B | EVGTX970SCAZ | EVGTX970FTW | GIGVN97OWF30 | GIGVN9706T | GIN970IXOC4N | MSGTX9701ME | MSGTX9704G0C  MSGTX97046D5| Z0GTX970GC
Price Log-on Log-on 354.99 329.99 Log-on 329.99 339.99 350.00 333.99 358.85 Log-on 339.99 Log-on Log-on Log-on

78 800-947-5534 + 212-444-6740




NVIDIA Quadro Graphic Cards

The NVIDIA Quadro Professional Graphics Cards provides the APl support and parallel processing performance required
for CAD modeling and DDC applications that involve rendering 3D graphics. The processing power can also be
harnessed for other computationally intensive tasks, such as transcoding video or data analysis. The Quadro
series features CUDA Cores, which are general purpose stream processors that not only render display

GRAPHIC DISPLAY CARDS

graphics, they also allow dozens of computations to be performed simultaneously.

Starting at the high end with the Quadro K6000 Graphics Card, a professional computer graphics card for applica-
tions that require or benefit from dedicated GPU processing power, featureing driver and APl support for Windows as well
as many Linux and Solaris distributions; down to the more economical K420, that not only renders display graphics, it also allows dozens of

computations to be performed simultaneously.

COMPUTERS

Quadro Quadro Quadro K5000 Quadro Quadro Quadro Quadro Quadro Quadro
Model K6000 K520 for Mac K420 K2200 K2000 K1200 Quadro K620 K600 Ke20
Cuda Cores 2880 2304 1536 1344 640 384 512 384 192 192
M 1268 GDDRS 8GB GDDRS 46B GDDRS 46B GDDRS 4GB GDDRS 2GB DDRS 4GB DDRH 26B DDR3 16B DDR3 16B DDR3
"y 384-Bit 256-Bit 256-Bit 256-Bit 128-Bit 128-Bit 128-Bit 128-Bit 128-Bit 128-Bit
. D DVED DL DR DVED DL I OV-DDL 1xDVI-I DL 1xDVI-I DL 1xDVI-I DL 4x Mini 1xDVI-1 DL TxDVI-I DL 1xDVI-I DL
Display Ports X OV DL 13DV DL 1OV DL 2x DisplayPorts 2x DisplayPorts 2x DisplayPorts DisplayPorts 1x DisplayPort 1x DisplayPort 1x DisplayPort
7 x DisplayPorts 2 x DisplayPorts 2 x DisplayPorts pay Py Py piay piay piay pay
Cooling Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink Active Fansink
SKU PNQK6000 PNVCQK5200PB PNVCQK5000MA PNVCQK4200PB PNVCQK2200PB PNVCQK2000PB PNVCQK1200DP PNVCQK620PB PNVCQK600PB PNVCQK420PB
Price 4,099.00 1,799.00 1,699.99 784.00 428.53 399.99 288.02 163.34 174.99 104.00

AMD Radeon Graphics Cards

Built for gaming at high resolutions, AMD's Radeon
Graphics Cards features GDDR5 vRAM for
loading large textures and graphics
coupled to over 1280 Stream Proces-
sors running at a base speed of 1000
MHz with between 256 and 512-bit

memory bus . Using the included utility, the
GPU’s can be overclocked up when running in OC

mode, which also boosts the GPU clock speed.

AMD FirePro Graphics Cards

The FirePro offers capabilities that can help
maximize productivity and help lower
cost and complexity. High graphics
performance, compute power, and

high-resolution multi-display capabilities
allows broadcast, design and engineering professionals to work
with detail, speed, responsiveness, and creativity. The FirePro
graphics incorporate an Autodetect technology. As you open

new 3D applications or move between them, driver settings are
automatically configured for optimized performance of supported
applications, no matter what your workflow demands.

Model Radeon R9 390 | RadeonR9 380 | Radeon R9 280X | Radeon R9 270X | Radeon R9 270X
Max Clock 1060 MHZ 1000 MHZ 1000 MHzZ 1020 MHZ 1020 MHZ Model FireProW7100  FireProW600 | FireProW5100 | FireProW4100 | FirePro V4900
Stream
Processors 2560 1792 2048 1280 1280 Performance 3.3 TFLOPS NA 143TFLOPS | 645.1 GFLOPS NA
Memory 86B GODRS 46B GDORS 36B GDORS 46B GDORS 26B GDORS Stream 179 NA 7% 512 480
512-Bit 256-Bit 384-Bit 256-Bit 256-Bit Processors
T1xDVI-D DL 868 GDDR5 268 GDDRS 46B GDDRS 268 GDDRS 16B GDDR5
) zeovipol | PROVEDDL Ty | TXDVEDDL T x DVED DL Memory 256-Bit 128-Bit 128-Bit 128-Bit 4-Bit
Display ! CHOM TXDVIHI DL 1 HOM X DVI-I DL TXDVI-I DL
Ports ) 1x HOMI - 1 x HOMI 1 x HOMI . bx 6 x Mini hx 4x Mini 1 DVD Dual-Link
x DisplayPort 1x DisplayPort Diszp)l(ar;rl’glrts 1xVGA 1xVGA LELIAE DisplayPorts DisplayPorts DisplayPorts DisplayPorts 2x DisplayPorts
: : i cqinati . Discreet Active Discreet Discreet Discreet
) Twin Frozr V Twin Frozr V| Double Dissipat Dual-X Dual-X
Cooling w?mrlgir wg][mrln;r o Eanlssi?kpa o Ct:]oaling C[:Ioaling Cooling active cooling Cooling active cooling active cooling active cooling
SKU MSR9390GAMBG | MSR9380GAM4G | XFR9280XTDFD | SA1121704206 | SAT12170120 SKU AMFWT100 AMFW00 AMFW5100 AMFWA100 AMFVA900
Price 329.99 239.99 239.99 189.99 199.99 Price 619.95 479.99 324.99 154.99 149.99

www.BandH.com
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COMPUTERS POWER SUPPLIES AND COMPUTER CASES

Power Supplies

For the user wanting to build thier PC from the ground up, or the advanced gamer who need to upgrade to more power, B&H carries a wide
assortmant of internal Power Supplies that are fully compatible with most computer cases. Whether you are looking for a unit with cables
hard-wired or a fully modular Power Supply without any permanently attached cables that simplifies installation and allows you to use only the
cables you need for a neat and clean build by improving performance by reducing airflow obstruction.

L PP PIFET

e i o || o |G| o |G| oo | Tmatae |t

Model VP-450 EA6506 AX1500i HX1000i HX750i RM850 RM750 CX600 PS480D Toughpower GOLD | SMART Standard
Wattage 450w 650 W 1500 W 1000W 850 W 850 W 750 W 600W LW 750 W 750 W
Modular Non-Modular Non-Modular Modular Modular Modular Modular Modular Non-Modular Non-Modular Modular Non-Modular

Active Power Factor No Active 0.99 0.99 0.99 0.99 0.99 0.99 No Active Active
Haswell Support No No No No Yes Yes Yes No No No No
CrossFire No No No No No No No No No No No
SLI No No No No No No No No No No No
+12V Rails Dual Single Multiple Multiple Multiple Single Single Single None Single Single
Certification 80 PLUS Certified Bronze 80 PLUS Titanium | 80 PLUS Platinum | 80 PLUS Platinum | 80 PLUS Gold 80 PLUS Gold | 80 PLUS Bronze Energy Star 80 PLUS Gold 80 PLUS Bronze
SKU ANVP450 ANEA650G COP9020067NA | COC9020074NA | COC9020072NA | COP9020056NA | COP9020055NA | COP9020048US LOPS4B0DBK THPSTPDO750M THSP750P
Price 3.7 7.99 400.64 199.99 154.99 139.97 119.99 69.99 19.50 92.99 67.78

Computer Cases

B&H has a large assortment of full-tower, mid-tower, rackmountable and desktop computer cases featuring 1-9 expansion slots, modular
drive cages each capable of housing three 3.5" or 2.5" drives, four sideways mounted tool-free dedicated SSD cages, and room for up to

eight fans. On the exterior of the case you will find USB 2.0 and USB 3.0 ports to connect a variety of peripherals as well as headphone and
microphone jacks. Available with aluminum or steel exterior, some cases included side panel windows allowing you to show off your hardware
while the integrated thumb screws make swapping out parts simple,

I e e e AT

Model VSK4000E Prodigy M CM Storm Trooper |  HAF X 942 HAF 9112 HAF 9112 Graphite 760T | Obsidian 750D H440 Commander G42
Form Factor Full Tower Mid-Tower Full Tower Full Tower BOX/MID-TOWER Mid-Tower Full Tower Full Tower Mid-Tower Mid-Tower Full Tower
ATX, . ATX, ATX, E-ATX, ATX, ATX, E-ATX, ATX, E-ATX, ATX, ATX,
Edl?;]ht:rtl::;?; MICRO-ATX, Mhlllcl':l[ll-llg(xv MICRO-ATX, MICRO ATX, MICRO-ATX, MICIETS(:ATX MATX, MICRO ATX, | MATX, MICRO ATX, |~ MICRO-ATX, MIEART(;(:ATX MICRO-ATX,
P MINI-ITX E-ATX XL-ATX MINI-ITX MINIITX, XL-ATX | MINIITX, XL-ATX MINI-ITX E-ATX
Expansion Slots 7 5 9+1 9 7 7+1 9 9 7 9 8
Side Panel Window No Yes Yes Yes No No Yes Yes Yes Yes Yes
Available Black, White, Black/Red,
Black Orange, Blue, Black Black Black Black Black, White Black White, Black Black
Colors
Red, Green Black/Green
SKU ANVSK4000E BIBPRM3KKWSK |  COGC5000KWN1 | CORC942KKN1 | CORC902XBKKN | CORC912KKN1 COCC9011045W | COC9011035WW | NZCAH440WM1 | THCATBS00MIW | THCATB6OOFIW
Price 34.99 84.99 161.99 161.99 86.99 59.99 189.99 149.99 119.99 59.49 129.99

80 800-947-5534 + 212-444-6740




MOTHERBOARDS, CPUS AND COOLING SYSTEMS =~ COMPUTERS

Motherboards

B&H carries Motherboards that support 4th and 5th generation Intel processors in the LGA1150 socket and AMD models that support 970 and
SB950 chipsets that deliver CPU power, integrated graphics, RAID support, built-in surround sound and a wide selection of PCle slots and I/0
ports for the user looking to custom build their ideal gaming system.

Aad A S a2 d L

Brand Asus Asus Asus Asus Asus Gigabyte Gigabyte Gigabyte Gigabyte
Republic of Gamers X99S Crosshair V .
Model X99 Deluxe X99-A MAXIMUS Il IMPACT 297 SLIPlus [ 197-A GA-990FXA-UD3 | GA-Z97X-XLI | 970 Gaming | GA-H97M-D3H = GA-B85M-DS3H
Form Factor ATX ATX Mini-ITX ATX ATX ATX ATX ATX ATX Micro-ATX Micro-ATX
Chipset Intel X99 Intel X99 Intel 297 Intel X99 AMD990FX / SB950 Intel 297 AMD990FX / SB950 Intel 297 AMD 970 Intel H97 Intel B85
LGA 1150 v3 LGA 1150 v3 L6A 1150 v3
CPU Socket (Haswell-E) (Haswell-E) LGA 1150 (Haswell-E) AM3 [ AM3+ LGA 1150 AM3 / AM3+ LGA 1150 AM3 / AM3+ LGA 1150 LGA 1150
Memory Support DDR4 DDR4 DDR3 DDR4 DDR3 DDR3 DDR3 DDR3 DDR3 DDR3 DDR3
Maximum Memory 6468 6468 1668 12868 3268 3268 3268 3268 3268 3268 3268
PCle PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 3.0/ PCle 2.0/ PCle 3.0/ PCle 3.0/
PCle 2.0 PCle 2.0 PCle 2.0/mini-PCle PCle 2.0 PCle 2.0 PCle 2.0/ PCI PCle 2.0/ PCI PCle 2.0/ PCI PCI PCle 2.0/ PCI PCle 2.0
RAID 01,510 0,1,5.10 0,1,5,10 0,1,5,10 01,510 0,1,5,10 01,510 0,1,5,10 0,1,5.10 None
) CrossFire CrossFire CrossFire CrossFire CrossFire CrossFire CrossFire CrossFire )
Crossire /S| "y and LI None and S and S and S and S and S and S CrossFire flone
SKU ASX99DLXUS31 ASX99A ASMVIIIMPCT MSX99SSLIPLS ASCHVFZDTMB ASZ97AMB GIG990FXAUD3 GIGAZ97XSLI MS970GAMING GIGAH97MD3H GIGAB85MDS3H
Price 399.99 239.99 239.00 223.99 213.28 142.48 109.99 114.99 98.99 84.00 64.99

CPU Cooling

CPU’s need a robust cooling system that allows you to monitor temperature and control lighting and fan speed. There are many variables to
consider, including whether using a fan-only based system or selectiing a liquid cooler kit is your best choice. B&H carries all types of CPU,
VGA and Case coolers that deliver optimum performance in a wide selection of fan sizes, speeds, airflow and heatsink materials.

=R BB YT H R

Brand Corsair Corsair Corsair Cooler Cooler Cooler Cooler Cooler Zalman Zalman Cooler
Master Master Master Master Master CNPS8900 CNPS8900 Master
Model cw“;gz%:;.luuvlvw Hydro H100i Hydro H80i Hydro H55 Seidon 120V Hyper 612 $524 Geminll | Hyper 212EVO | CNPS9500AT Hyper TX3 Hyper TX3
Form Factor Liquid Cooler 2x120mm Fans Liquid Cooler Liquid Cooler Liquid Cooler 120mm Fan 120mm Fan 120mm Fan 92mm Fan 110mm Fan 120mm Fan
Fan Speed 2400rpm 2435rpm 2400rpm 1700rpm 2400rpm 1300rpm 2000rpm 2000rpm 2650rpm 1500rpm 2800rpm
Airflow 70CFM 70 CFM 70CFM 57 CFM 86 CFM 44 CFM 65 CFM 82 CFM No Info 54 CFM 54 CFM
Sound 37 dBA 37 dBA 37dba 30dba 40dba 20dba 22dba 36dba 27dba 25dba 35dba
Bearing Type Custom Custom Custom Custom Rifle Rifle Loop Dynamic | Long Life Sleeve Dual Ball Long Life Sleeve | Long Life Sleeve
I;f;t:rii';ll‘ Aﬁ?ﬂﬁfﬁuﬁm Copper AlEuUrIrJﬁ:l:/m Aﬁ?{ﬂfﬁuﬁm Aluminum Aluminum Aluminum Aluminum Copper Aﬁ?rﬂ?r?l;/m Aluminum
SKU COCW906021WW COHT101 COCW906017WW COHB5 COS12V24PKR1 CORH6V213PR1 CORRG5V220R1 CORR212E20R2 ZACNPS9500AT ZACNPS89000U CORR910HTX3G
Price 11.99 129.99 89.24 63.99 49.99 45.99 42.47 31.05 34.94 38.99 18.75

CPU Processors

The Intel Core processor, including the latest Broadwell and Skylake series, are well suited for users who are interested
in general-use tasks, such as Internet browsing, checking E-mail, document creation and editing, multimedia playback,
as well as more intensive tasks that are able to benefit from overclocking including gaming and video processing.




COMPUTERS

(@ audioengine A2+

2.75” Powered Desktop Speakers

» 2.0 Powered Speaker System

» 2.75" Kevlar Woofer

» 34" Silk Dome
Tweeters

» 60W Total
Peak Power

[AUSAZPB) ...

249.00

BassPULSE
2.1 Channel Speaker System
» 3.5mm

» Full-Range Satellite
Aux Input

Speakers
(606GBP000100)............. . 49.99

» Side-Firing
Subwoofer

" Dancing Water
XCELLON" Stereo Speakers
» Four Streams of Water

» USB-Powered for

Convenience and Mohility

» Water and Lights

Black (XCDWS100B).............. 19.95
White (XCOWST00W)......cco. 19,95

Dance to Your Music

- Logitech S-120
Speaker System
» Dual Speaker System

» Volume & Power

» Built-In Headphone Jack
» Designed for Computer Use
» Ultra-Affordable

Control Knob
(L0S120) 11.95

SonaVERSE USB clip on
Soundbar Laptop Speaker

=

» Laptop Stereo Speaker
» Clip-on Design o
» Vertical/Horiztonal Stand =

» USB Plug-and-Play
» Onboard Volume Controls
» Lightweight for Portability

[6OUSBCOSB ..o 269D

"@=g\\ CA-2014

CVber Acoustics Computer Speakers

» Stereo Sound

» Front-Panel Controls

» Integrated 3.5mm
Audio Cable

» Headphone Jack

(CYCA2014) ... .11.88

SPEAKERS

harman/kardon

SoundSticks lll
2.1-Channel Desktop Speakers
» Up to 40W of Total Power
» § Full-Range Transducers
» 6" Down-Firing Subwoofer | s
» 1 x 3.5mm Auxiliary Input g
» Touch Controls for Volume and Mute

[HASSIAMA) ..o

CREATIVE GlgaWorksT40

Series |l Speakers g .

» Speakers Deliver
32 Watts RMS
» BasXPort Tech.
» Each Speaker:
2 Drivers, 1 Tweeter
» Bass, Treble, Volume Controls

(CRTA40) 129.95
a' Dancing Water
XCELLON" Stereo Speakers

» Water and Lights

Dance to Your Music
» 6 Multi-Colored LED Lights
» 6 Streams of Water
» 3.5mm Stereo Audio Input
» USB-Powered for Convenience and Mobility

(XCOWS200B) ...cco o 269D

- Logitech 5_150
USB Digital Speaker System

» 1.2WRMS

» USB
Powered

» Compact
Design

(LOST50) 11.53

—<AITEL BX1521

12W 21 ESNr;eaker System
» 2.1 Channel
System o
» Dedicated
Subwoofer
» 12 W of Power
» Built-In Headphone Jack

[ALBXTS21) - 49,95

CA-3602

Cyber Acoustics Computer Speakers

» Subwoofer Delivers Thunderous Bass
» For Gaming, Computers, MP3 / DVD Players
» Aux-In & Headphane Jacks

» Exceptional Amplifier
Technology

» Wired Remote
(CYCA3602) oo B9

M4V Companion 20
Multimedia Speaker System

» Dual Speakers with
Full, Natural Sound

» Advanced Ported
Design for Low-Notes

» Control Pod with Volume

and Mute Control
(BOC2OMS) oo

249.00

CREATIVE GigaWorks T20

Series Il Stereo Speakers

» 28W RMS

» Headphone
Jack

» BassXport

(CRGT202)....

N Pebbles
sy Speakers

» 2.0-Channel Audio System

» 3.5mm Aux-in Port » USB Plug-&- Play

» Silver / White

» Proprietary
Technology

(JBP2SSZPSW) . Ol

- Logitech ZZ[][]
Multimedia Speakers
» 2.0-Channel Speakers

» 10 W Peak Power O O
» Auxiliary Input

» Bass Control

» Volume & Power Controls
» Headphone Jack

OO0

(L0Z200MB) 24.99

Prisma Encore
Bluetooth Speaker System
» Up to 64W of
Total Power
» 2.1-Channel
» Bluetooth
» Remote Control
» 3.5mm Auxiliary Interface 9

[EDE3ZO0BTB) ...

149.95

CA-2026

Cyber Acoustics Computer Speakers

» 5 RMS Power

» Bass Reflex Enclosure
» Auxiliary Input

» Headphone Output

» Magnetically Shielded
» Desktop Controls

[CYCAZ026) ..o L

M4V Companion 2

Series Il Multimedia Speakers

» Stereo Sound
» Digital Signal Processing
» Ported Cabinet Design
» Auxiliary Input

» Volume Control

» Headphone Jack

(BOCZMS) . 99.00

CREATIVE InsplreT1l]
Speaker Syste Je=s
» 2.0 Audio System
» Dedicated Tweeters
» BasXPort Technolog
» Headphone Jack

» Auxiliary Input

(CRITTO) . 43299

@ ACS
USB Soundbar

» Stereo Playback
» 2x1.25 W of Power
» 1xAux-In /1 x Headphone-Out

» Compact Design at 16" Wide » USB Powered
» Compatible with Select Dell Monitors
(DENCWE) . 26.00

- Logitech 213[]

Speakers

» Dual Speakers Push Total bW of Power

» Built-in Volume and
Power Control

» Built-in
Headphone Jack

» Windows & Mac

(LOZ130) 24.95

Raz€R Leviathan

Elite Gaming Soundbar

» Bluetooth 4.0 Wireless Streaming

» Supports aptX Codec

» 5.1-Channel
Surround Soung

» Dedicated
Subwoofer

(RALEGMSB) oo 196.94

CA-2880

Cyber Acoustics USB Powered Speaker

» Dual 1.5"
Neodymium
Full-Range Drivers

» Chrome 3.5mm Input » USB-Powered

» Attaches to Laptop via Clip

» Desktop Volume Control & On/0ff Switch

(CYCAZ880) .o 17,08

800-947-5534 + 212-444-6740




SONYY Pulse Elite Edition

Wireless Stereo Headset

» BassImpact Technology

» 7.1 Virtual Surround Sound

» Hidden Noise-Canceling Mic

» On-Screen Headset Updates

» Optimized Preset Sound Modes

» Supports Windows,Mac,Sony PS Vita,PS3,PS4

[SOPS3PEWSHS)....oocc.. 89,99

KOSS" SB4S
Communication Headset
» Dual 3.5mm Plug Connectors

» 18 Hz to 20 kHz Freq. Response
» Soft Leatherette Ear Cushions
» Noise-Reducing Clear

Voice Tech Mic
» Anisotropic Ferrite Magnet Structures

(KOTBAZAT) .o 24.45

Raz€&R Kraken USB
Over-Ear PC Headset
» Virtual 7.1 Surround Soung
» 1.3" Neodymium Drivers
» Unidirectional Analog Mi¢
» Closed Ear Cup Design

» Extended Gaming Comfart

(RAKUSBOEHSBK] ..o 99,99

Osteelseries H
Gaming Headset & Transmitter

» Headphones Freq. Response:
20Hz - 20000Hz

» Wireless Range: 12m
(40ft) straight line

» Analog In & Out, mini USB

» Unidirectional Mic

(ST81298)

299.99

NAZ1O Levetron GH808
USB Gaming Headset
» Super Bass with Vibration
» Dynamic Digital Sound
» USB Plug &Play

» Circumaural Ear-Cups
» Foldable Microphone
» Volume Control Knob

(AZGHB08)

ADY QHM-100
s Stereo Headphones
» Condenser Mic with Flexible Boom

» 40mm Drivers
» Extra-Long 10" Cable
» Intine Volume & Mic Control
» 3.5mm Mini

Female-to-Male Y Cable

(NAQHM1000)......ccc 15.99

www.BandH.com

SONYY PlayStation Gold
Wireless Stereo Headset
» 7.1 Virtual Surround Sound
» Hidden Noise Canceling MIC
» Headset Companion App

» PC & Mac Compatible

» Mobile Devices Supported

» PS Vita, PS3, & PS4 Compatible

[SOPSAHSG) .o TBLT9

AKOSS" SB45USB

Communication Headset

» USB Plug Headset Connection
» Noise-Reducing Mic

» 18 Hz - 20 kHz Freg. Response
» Soft Leatherette Ear Cushions
» Foldable Design —
» Anisotropic Ferrite Magnet Structures ¥

(KOT78203) .o 34,69

RazeRr Kraken Mobile

Music & Gaming Headphones

» Large 40mm Neodymium
Magnet Drivers

» Tuned for Deep Bass
and Clear Highs

» Foldable Ear Cup

» Available in Colors

(RAKMGHSNG) ..o

89,99

@GP U2
= USB Stereo Headphones

» USB Connection to Computer,
» Integrated Headphones
and Condenser Mic

» Windows and
Mac 0S Compatible ~
N

)
[CAUZ) 3900

jmcorsair H2100

Wireless Dolby 7.1 Gaming Headset

» 2.4 GHz Wireless USB Headset and Retractable
Noise-Canceling Mic

» Freq. Response: 20Hz-20kHz

» 50mm Neodymium Drivers

» Wireless Range: up to 40°

» Up to 10 Hour Battery

(COCA901127NA) 89.99

TRITION Trigger
Stereo Headset for Xbox 360

» Separate Game and Voice Volume Controls
» Around-The-Neck Resting Position
» Padded, Adjustable Head-Rail

» Flexible Performance Mic

» Ergonomically Designed

» Quick Setup

[TRTX360HS) e 4929

GAMING HEADSETS

[/ SENNHEISER GAME ZERO

Gaming Headsets

» Leatherette & Memory W

Foam Pads » Closed Design =y
» Noise Cancelling Mic @
» Ergonamic Acoustic
Refinement et
Black (SE506079)..oooooo. 199.00
White (SE506064).......... 199.00

RKOSS" CS100USB
Over-The-Head Headset

» PC Voice & Interactive Gaming Use
» Electret, Noise Reduction Mic
» Extended Frequency Response
» Foam Ear Cushions
» Single USB Plug

» 8" (2.4 m) Cord

(KO178188) ...

2126

Razer Kraken7.1Chroma

Surround Sound Gaming Headset

» 7.1 Virtual Surround Sound Engine
» Enhanced Digital Mic
» Chroma Lighting

» Razer Synapse Enabled
» Closed Ear Cup Design
» Foldable Ear Cups

[RAK71CSUSBGH)...........cccvc

o 9499

/iSUS" STRIXT7.1
USB Gaming Headset

» True 7.1 Surround Sound
» 10 Neodymium

Magnet Drivers
» Plug-&-Play USB

Audio Station » Foldable Ear Cups
» 130mm Protein Leather Cushions » PC & Mac

(ASTRIXTT).c. 189,99

jAcorsair H1500

Dolby 71 Gaming Headset

» 50mm Neodymium Drivers

» Freq. Res.: 20 Hz - 20 kHz

» 95 dB Dynamic Range

» Microfiber-Wrapped Earpads

» 32 Ohms Impedance /
» Noise-Canceling & Retractable Mic

(COCADTIZBNA) ..o 10,99

TRITTON 720+
7.1 Surround Headset
» Works with Xbox 360,
PlayStation 4 and 3
» Dolby Headphone Tech.
» 3D Directional Audio
» Selectable EQ
Settings
(TR720P7.THS) .o

.
A
|l

/

i 149,99

COMPUTERS

/1 SENNHEISER GAME ONE
Gaming Headset
» Plush Velvet Ear Pads
» Cushioned Headband
» Noise Cancelling Mic
» Volume Controls on

Right Ear Cup

(SE506080) 179.99

RAKOSS" SB4Y
Communication Headset
» 18 Hz - 20 kHz Freq. Response
» Clear Voice Tech. (CVT) Mic

» Oxygen-Free Copper Voice Coils :
» Soft Leatherette Ear Cushions ;
» Volume Control on Cord 1
» Foldable Design ———ea——
(KO186008) ... 27.16

RazeRr Tiamat7.1Elite

7.1 Surround Sound Gaming Headset

» 10 x Discrete Neodymium Dri
» Dual Titanium Coated Bass
» Retractable Noise-Filtering
» Multi-Channel Customizatior
» Accurately Adjust Level, Posi
» 9.8" (3 m) Braided Fiber Sheath Cable

(RASAGHS)

159.99

/iSUS STRIXPRO

Gaming Headset

» 60mm Neodymium
Magnet Drivers

» Braided Fiber Cables

» USB Control Box

» Cancels Environmental Noise

» Supports PC,Mac,PS 4,Smartphones & Tablets

(ASTRIZPRO) ..o 99.99

pAcorsatr Raptor HS30

Analog Gaming Headset

» 40mm Neodymium
Transducers

» Closed-Back
Circumaural Design

» Noise-Canceling Mic

» Ergonomic Earpads

(CO9011121NAY) 29.99

Microsoft Xhox One

Stereo Headset

» Stereo Headset

» Over-the-Ear Design

» Unidirectional Mic

» Game/Chat Balance Buttons
» Volume Control, Mute Button
» Compatible with Xbox One Controllers

L LRTAY 1 —— 51.14




COMPUTERS

Authorized MagiC Mouse
Reseller  Wireless Mouse

» Bluetooth Wireless
» Multi-Touch Surface

» Laser Tracking ‘

» Customizable Functionality
» Mac 0S X 10.5.8+ Compatibility

(APMMO)

(e- Logitech' M510
Wireless Mouse

» Laser Tracking

» Side-to-Side Scrolling and Zoom
» Programmable Controls

» Contoured Design

» Long Battery Life

(LOM510)

Micresoft Arc Touch

Bluetooth Mouse
» Curve to Turn On

» Flatten to Turn Off

» Touch Scroll

» BlueTrack Optical Sensor » Bluetooth 4.0 Enabled Device
» 2.4 GHz Wireless Frequency » Uses 2 x AAA Batteries Included
» Up to 6 Mo. Battery Life » Windows 8.1, 8, and RT Compatible

(MI7MP00001)

RazeRr DeathAdder Chroma

Gaming Mouse i |
Slip Buttons
@GRIFFIN PowerMate

» 10,000 dpi Optical Sensor

» Ergonomic Right-Handed Design

» 1,000 Hz Uttrapolling

» On-the-Fly Sensitivity Adjustment

» T Lightweight Braided Fiber Cable

» 5 Programmable Hyperesponse, Nan-

(RADMCEGM)

Assignable USB Multimedia Controller

» Shuttle Wheel & One-Touch Button

» Connects Via USB

» Programmable

» Preset to Work with
iMovie & GarageBand

» Windows & Mac Compatible

(GRNA16029)

pAcorsar Vengeance M65

FPS Laser Gaming Mouse

» Aluminum Unibody Design

» 8200 dpi Laser Sensor

» Selectable Respanse Time

» Onboard Profile Storage \

» High-Mass Scroll Wheel » Switches Rated for 20 Million Clicks
» Adjustable Weight System » PTFE Glide Pads

(COH9000022NA)

—

7.95

MICE & TRACKBALLS

Kensington™ Expert Mouse

4-Button USB Trackball

» DiamondEye Optical
Tracking Technology

» Scroll Ring for Comfortable
Operation

» Detachable Wrist Pad

» Compatible with Windows 8

(KEMEPU) ......... 69.95

(e: Logitech Performance Mouse MX

Wireless Mouse

» USB » 2.4 GHz Wireless

» Right-Hand Design

» Laser Tracking » Fast Scrolling
» Unifying Wireless Receiver

» 4 Thumb Buttons

» Mac & Windows Compatibility
(LOPMX).......... 58.48

Micresoft Sculpt
Ergonomic Mouse

» Wired USB » Ergonomic Design
» Zoom Slider

» Email and Internet Hot Keys

» Multimedia Keys

» Integrated Palm Rest

» Windows and Mac Compatible

(MIL6V00001).....

Raz€er MambaElite

Ergonomic Gaming Mouse

» Optical & Laser Sensor » 6400dpi

» Wired/Wireless Functionality

» Battery Lasts up to 16 Hours

» Multi-Colored Lighting

» Mac and Windows Compatible

» Wireless Receiver is Also Charging Dock

(RAEWGM).........

@ Air Mouse GO Plus
Gyration Wireless Mouse
» 2.4 GHz Wireless
» USB Transceiver
» In-Air Cursor Control
» Symmetrical Design
» Windows/Mac Compatible

(GYGYM1100NA) . 71.54

Swiftpoint 6T Touch

Gesture Mouse

» Bluetooth 4.0 and 2.4 GHz RF Wireless
» Ergonomic, Pen-Style Grip

» Comfortably Swipe, Flick, and More

» 30 Sec. Charging Gives One Hour of Use

» For Windows, 0S X, i0S, and Android
» Includes Charger/Receiver, Case, Parking Spot and Rest Mat

[SWSM500) e 139.00

Kensington" Orbit

Trackball with Scroll Ring

» Symmetrical Design

» USB » Scroll Ring

» Optical Tracking Technology

» Click-Free Scrolling

» Mac & Windows Compatibility

» Uses Less Desk Space than a Mouse

(KEK72337US)

(- Logitech M570
Laser Wireless Trackball
» Laser Tracking Technology

» Advanced 2.4 GHz Wireless

» Adjustable Cursor Speed

» Stowable USB Receiver

» Windows and Mac Compatible

» 18-Month Battery Life

(LOMS70) 29.95

cccccccccccccc

» Control X, Y & Z Axes

» Pressure-Sensitive

» Compatible with
Most 3D Applications

Standard Edition (303DX700026)

Notebook Edition (303DX700034) ..97.95

Raz€R Naga

Expert MMO Gaming Mouse

» 19 MMO-0Optimized Buttons

» Razer Synapse 2.0

» 12 Button Mechanical Thumb Grid

» 1000Hz Uttra-Polling » Hyperespanse Buttons

» 8200 dpi Precision 46 Laser Sensor » Ergonomic Form Factor
» Green LED Backlighting » Zero-Acoustic Ultraslick Mouse Feet

(RANEMMOGM) ...

~"Evoluent” VerticalMouse 4

m Inventor of the handshake grip

Right Hand
» Comfortable and Avoids Forearm Twisting
with Your Hand in an Upright Posture
» Features Six Programmable Buttons
» 2 Thumb Buttons w/Improved Thumb Rest
» Adjustable Laser Sensor

Wired (EVWWMAR)..... . 89.95
Wireless (EVVM4W) 101..99

a' MSW-L15

XCELLON" Wireless Laser Mouse
» User-Selectable Resolution

» 400, 1000, 1200, and 1600 dpi
» Scroll Wheel

» Infrared Laser Diode

(XCMSWLIBBM) ...

800-947-5534 + 212-444-6740




Authorized Apple Keyboard
Reseller  With Numeric Keypad

» Anodized Aluminum Enclosure

> Extended Layout e e
» LowProfile Keys | e L L L Lo ]

0 30 soon
» One-Touch Access | Mafaaaaeese s e lerL[
» Two USB 2.0 Ports — L
(APMB110LLB) 48.49

Microsoft Sculpt

Ergonomic Keyboard for Business
» Cushioned Palm Rest

» Split Keyset

» Natural Arc Key Layout

» Dome Keyboard Design

» Separate Number Pad

» Compatible With Windows 8, RT, 7

[MISEKBBO) ... 65,98

Targus' AKP10US
Numeric Keypad

» Wired USB Connection

» Ergonomic Tilted Design

» Windows and Mac Compatible

(TAAKPTOUS) . i 10,39

(=- Logitech K350
Wireless Keyboard
» Wave-Shaped Design
» Dedicated Numeric Keypad
» Logitech Unifying Receiver
» USB » 2.4GHz Wireless

» Media Controls » Programmable F-Keys » Adjustable Height
» 3-Year Battery Life » Windows Compatibility

[LOK3B0) .

e £9.99

RazeRr BlackWidow Chroma RGB
USB Gaming Keyboard

» b Macro Keys

» 10-Key Rollover

» Gaming Mode Option

» USB Braided Fiber Cable
» Programmable Backlit Keys
» Up to 60 Million Key Strokes

(RABWCRGBBKB)........ccoccc

ADESSI) Tru-Form Pro 308

~~ssy Contoured Ergonomic Keyboard

» 105 Key extended keyboard
layout as well as 8 hotkeys

» USB Interface & Port

» Windows Power Keys included

» Built-in Touchpad with left/right buttons

» Compatible With Windows 8/ 7/ Vista/ XP/ 2000

[ADPCKOBUB) ...

i 39,95

i 95,95

www.BandH.com

KEYBOARDS

a‘ KW-SB100B
XCELLON™ Wireless Solar Keyboard
» Integrated Solar Panels Charges From Any Bright Light Sourc

» 2.4 GHz Frequency : :
» Maximum Wireless

Range of 33’
» Discreet USB Nano Receiver

» Plug-and-Play Functionality
(XCKWSBTOOB) ...

i 39,95

Microsoft Natural
Ergonomic Keyboard
» Wired USB

» Ergonomic Design
» Loom Slider

» Multimedia Keys
» Email & Internet Hot Keys :

» Integrated Palm Rest » Windows and Mac Compatible

(MIKBNEADOO) ... 399D

™ Elitev2
Wireless Keyboard

» 2.46Hz Wireless Connection

» Up to 30 ft Range

» Ultra Slim Shape

» Fast-Access Hot Keys

» Exclusive HP Link-b Technology

(HEQBA46TAA) 34.99

G rocearn 1.46Hz Multimedia Keyboard
with Laser Trackball and Scroll Wheel
» 33 Operating Range
» 2.4GHz Wireless
» USB
» Windows
Compatibility

(IOKBMM) .

Quick Fire TK
Gaming Keyboard

» USB 2.0

» UV Coated Keycaps

» T Multimedia Shortcuts

» N Key Rollover in USB Mode

. 35,20

(COQFTKBRGK) 91.49

HENGE-DOCK S Clique
Dock for Apple Trackpad & Wireless Keyboard

» Holds Apple
Wireless Keyboard & Trackpad

» Minimalist Form

» One-Piece Chassis » External Power Buttons

(HEAO1CLIQUE) 24.95

COMPUTERS

CM Storm QuickFire Rapid
Gaming Keyboard P

» Wired USB / PS/2

» N-Key Rollover (PS/2 Mode)

» Multimedia Shortcuts

» Anti-Ghosting (]

Brown Key Switch (COS&0GKCMIUS) ........oococo... 85,22
Blue Key Switch (COQFRK) 79.19

Microsoft Sculpt

Ergonomic Desktop Keyboard & Mouse
» Natural Arc and Domed Keyboard Design
» Cushioned Palm Rest
» Split Keyset Design
» Separate Number Pad
» Thumb Scoop » Reverse Tilt » Windows and Back Buttons
» 4-Way Scroll Wheel » Includes USB RF Receiver

[MISEKBB) ..o

. 89.00

kanex Multi-Sync
Bluetooth Keyboard

» Pairwith iMac, [T T r
. . LD ] ] 1 | mE|
iPhone, Pa —wwﬁ—ﬂ—m—\

» Bluetooth LLLT M S o0

» 1-Touch Quick Switching

» Full-Size Wireless Keyboard for Mac » iPhone/iPad Stand Incl.

(KAQWERTYX) 59.95

NZ 10O KB505U

Large Print Tri-Color LED USB Keyboard

» Plug & Play USB Interface

» 104 Keys (13 Hotkeys)

» Tri-Color Backlight
(Red, Blug, Purple)

» Membrane Switch Type

» Switch Reliability of 10 Million Cycles » 5 Cord Length

(AZKBBOSU) o 2495

i Thermaitake POSEIDONZ
llluminated Keyboard

» Media Keys

» Anti-Ghosting

» Full Backlighting
» Mechanical Switches
» Adjustable Brightness
» Windows Key Disabling

(THIZKLBLUSO1) 76.94

"%+ belkin YourType
Wireless Keypad o= oOoDo
» For iMac, MacBook Pro & MacBook Air [J[] (I
» Supports Apple Wireless Keyboard [ Il 1 [ 1Ll
» Bluetooth Connection |
» Numbers, Function Keys,

Doc Navigation
» Aluminum Design Matches Apple Keyboard
(BEFBT067TT) 54.95




COMPUTERS

SOFTWARE & WEBCAMS

Microsoft \indows 10

Install the 64-bit Windows 10 operating system
from Microsoft on your notebook or desktop to
enhance it with a hybrid Start Menu, Microsoft

Edge web browser, and Cortana personal assistant.

Without leaving the Windows desktop to access
your apps, the hybrid Start Menu in Windows 10
Home looks similar to the menu in Windows 7 and

Home Edition

» Expanded Start Menu

» Microsoft Edge Web Browser
» Cortana Digital Assistant

» Touch Support

» Cloud Connectivity

» Windows Store

64-bit on a DVD (MIKW900140) ............ 99.00
32-bit on a DVD (MIKW900186)............ 99.95

inTuit QuickBooks 2015
Small Business Accounting

» Organize Business Finances * =
» Expense Tracker
» Improved Import Batching
» Improved Budget Reports
» Set up, Go & Guide Me Tutorials
MAC 2015 (INQB2015PRMV)

179.95
PRO 2015 FOR WINDOWS (INQP150)............ 199.99

""" Mntivirus for Mac

Bitdefender Antivirus Software

» Designed for Mac
» Worry-free Security
» 2417 Guard Duty

» Web Protection

(BIAM3UTY) 39.00

CREATIVE LIVEICAM CHAT HD
HD 720p Webcam

» 720p Online Video
Chatting @ 30 fps

» 5.7MP Still Images

» Noise-Canceling Mic

» Supports Password Protection Controls

» USB 2.0 Plug & Play » Supports PC,Mac,Linux

[CRLCCHDWC) 20.38

Micresoft |ifeCam Studio

Webcam

» 1920 x 1080 Sensor Res

» Up to 30 Frames Per Sec.

» 5 Megapixel Still Images

» 75° Diagonal Field of View

» 720p HD Video Chat » Auto Focus 0.3 to 32.8'
» Rotates 360° » Wide-Band Mic » Wide-Angle
[MILCSPL2) 59.00

combines it with the live tiles used in Windows 8's
Start Screen. The Start Menu has been enlarged
to include these tiles, which can let you view

how many email messages you have, the current
weather status, and more. In addition to the live
tiles, you still have enough room on the Start
Menu to pin your most frequently used apps and

Pro Edition
» Bitlocker

» Enterprise Data Protection
» Domain Join and Group

Policy Management

» Multiple Virtual Desktops

» Business Store

64-bit on a DVD (MIFQC08930) ......... 139.95
32-bit on a DVD (MIFQC08970).......... 139.95

COREL WordPerfect Office X7
Home & Student Edition

» WordPerfect Word Processor

» Quattro Pro Spreadsheet
Program » Presentations
Slideshow Creator

» WordPerfect Lightning
Digital Notebook

FOR WINDOWS (COWPCXTHSB)......................79.99

(kp)) Recover It USB Stick
=¥ Forensic Data Recovery
» See Deleted Emails/Videos/Pictures
» Save, View or Delete Chat Logs

» Works on Most Devices

with Flash Memory -

» Easy to Use & Easy
to Read Report

(KJP9910)

159.00

CREATIVE [|VE!CAM SYNC HD
HD Webcam

» 720p Online
Video Chatting
@30 fps

» 3.7TMP Still Images » Noise-Canceling Mic

» Surveillance and Monitoring Software

» USB 2.0 Plug & Play » Supports PC,Mac,Linux

(CRLCW) 20.46

Micresoft LifeCam HD-3000
USB Webcam

» 720p HD Video, 30 fps
» 16:9 Widescreen

» Integrated Omnidirectional Mic
» TrueColor Tech. 24-bit Color Depth
» Mavie Maker Software

» Photo Gallery Software » Skype Certified
(MIHD3000). oo 23044

files. Built with the strengths of Windows 7 and
Windows 8, Windows 10 Home combines the best
features of bath engines to remain compatible with
nearly all your peripherals and the computer’s in-
ternal components. Furthermore, it offers a similar
design to the previous version of Windows, so you
can easily start using Windows 10 right away.

Mty
W,

KASPERSKYZ  [nternet Security 2015
Security Software

» Internet Protection Against
Al Viruses » Protection
Against Online Threats

» Secure Online Banking
and Shopping

» Detects New and Emerging Threats

(KAIS20153PC) 31.99

e

ANTI-VIRUS

=

LO/JACK  LoJack for Laptops
Standard Edition

» Track & Recover Your Stolen
Laptop » Device Lock Blocks
Access Remotely » Data Delete
Erases Personal Information

» Theft Recovery Team Support

» 1 Computer License for a 1-Year Subscription

(LoLIM) 69.95

LO/ JACK

- Logitech 920
HD Pro Webcam
» FullHD 1080p Video at
30 fps Over Skype
» Wide 78° Diagonal View
» Omni-Directional Dual Sterea Mics
» H.264 Encoding Tech. » Built-in Monitor Clip
» Logitech RightLight 2 Tech. » PC Compatible
(L0C920) 69.95

Microsoft |ifeCam Cinema
WebCam For Business

» USB 2.0 Interface

» 720p HD Widescreen

» Autofocus » Glass Lens
» ClearFrame Technology
» Digital Microphane

» Aluminum Body
(MiLcCWB) 40.61

Micresoft (ffice 2013

Home and Student

» Personalized Office
Experience

» Share Your Work

» Word

» Excel

(MIO20T3HSB6) .. 139.00

) Office

Microsoft (ffice for Mac 2011
Home and Business

» Word

» PowerPoint
» Excel

» Qutlook

(MIOMHB20TTP)....ooo. 168.40

KASPERSKYE  Anti-Virus 2015
Security Software

» Anti-Spyware, Anti-Phishing
» Anti-Rootkit » URL Advisor
» Automatic Exploit Prevention
» System Watcher & Rollback
» Instant Safety Checks

» Rescue CD » Free Technical Support
(KAAV20TB3PC) o 32.99

D it

INTERNET
SECURITY

I\ Adobe Acrobat ProDC
2015 for Windows (Boxed)

» Edit & Share PDFs
Across Devices

» Document Cloud Services

» Adobe Acrobat DC Mobile
App Compatible

» Windows Compatible

(ADAPDC2015W)....ooooo

J— A N

- Logitech £930e
HD Webcam
» Full HD 1080p

Video Calling
» H.264/SVC Compression
» 90° Field of View » Carl Zeiss Certified Lens
» 4X Zoom in 1080p » Integrated Autofocus
» External Privacy Shutter » Dual Stereo Mics

(L0C930E) Call or Log-on

- Logitech \WehStar Posiive,
LED Ringlight : @)
» LED Ringlight for Webcams e
» USB-Powered

» 22 Energy-Efficient LEDs

» Two Levels of Illumination
» Spring-Loaded Clamps

(STOVIZ0LB) 79.00

800-947-5534 + 212-444-6740




WACOM' Intuos Pro

Professional Pen & Touch Tablet

» 2048 Levels of Pen Pressure Sensitivity
» Multi-Touch Support

» Express View Display, Touch Ring
» USB Interface

» Included Wireless Kit

» § Programmable Express Keys

» Mac & Windows Compatible

8.8 x5.5” Active Area (WAIPPTM) ..o 349.95
6.2x3.9” Active Area (WAIPPTS) . 269.95

WaCOoM' Intuos
Art Pen & Touch Medium Tablet

» 8.5x5.3" Active Area

» 1,024 Levels of Pressure Sensitivity

» USB Interface

» 4 Programmable
ExpressKeys

» Pressure-Sensitive,
Battery-Free Pen

» Corel Painter Essentials » Mac & Windows Compatible

Mint Blue (WAIAPTTMBL) Black (WAIAPTTMBK).....................199.95

WaCOM' Intuos Photo
Pen & Touch Small Tablet

» 1,024 Levels of Pressure Sensitivity

» 4 Programmable ExpressKeys

» USB Interface

» Multi-Touch Support

» Pressure-Sensitive,
Battery-Free Pen

» Macphun Creative Kit (Mac) » Corel AfterShot Pro (Mac/Windows)

» Corel PaintShop Pro (Windows) » Mac & Windows Compatible

6.0x3.7" Active Area (WAIPPTSBK).........o.cooooo 99.95

AJESS]) CyberTablet212
~se=gray Widescreen Graphic Tablet

» 10 x 6.25" Surface Area » USB Powered
» 1024 Levels of Pressure Sensitivity
» 12 Programmable Hot Keys

» 28 Programmable Macro Keys

» Handwriting Recognition Technology
» Supports up to 2000 Lines Per Inch
» Included Cordless 2-Button Drawing Pen
» Compatible with Mac and Windows

(ADCTZI20) 79.53
wacom wacom
Intuosé Grip Pen Pro Pen

» Draw, Erase,
and Mouse Functions

» Pressure and Tilt Sensitivities

» Ergonomic Design, Natural Feel

» Weighted Stand » Replacement Nibs

» Only Works with Intuosé Tablets

(WAIGP) oo 63,99

» Included Spare Nibs

» Carrying Case

www.BandH.com

» Included Color Identification Rings
» Compatible with Intuos Pro Tablets

(WAPPCC) ..o

GRAPHIC TABLETS & PENS

WaCOM' Cintig 13HD
13.3” Creative Pen Display

» 11.75x 6.75" Active Area

» 13.3" Full HD IPS Display

» 1920 x 1080 Native
Resolution

» 250 cd/m? Brightness

(WACT3)

WaCOM' Cintig 22HD Touch
HD Touch Pen Display

» 215" Screen Size

COMPUTERS

WaCOM' Cintig 22HD

22” Creative Pen Display

» 19.57x 11.5" Active Display

» Mac and PC Compatible

» USB / DVI-I Connectivity

» 230 cdm? Brightness

» 16-User Assignable
ExpressKeys

(WAC22)

WACOM' Cintiq 27QHD
27” Creative Pen Display

» 235x13.2" Active Area

» 1920 x 1080 Resolution » 27" AHVA LCD
» 72% Adobe RGB Color Gamut Pen-Only Display
» 16:9 Aspect Ratio » (HD 2560 x 1440
» 16.7 Million Color Support Native Resolution
» Multi-Touch Gestures T » 330 cd/m? Brightness
» 2048 Pen Tip & Eraser Pressure Levels
» Integrated ExpressKeys & Touch Strips
(WACZ2T) e 1,999.95 (WAC270HD) 2,299.95
WaCOM' Bamboo WACOM' Cintiq 27QHD Touch
Wireless Pen & Touch Tablet HD Touch Pen Display
» 457 x 3.07" Active Area » 235x13.2" Active Area
» 512 Levels of Pen » 27" AHVALCD
Pressure Sensitivity Pen-Only Display
» Supports 4-Finger » (HD 2560 x 1440
Multi-Touch Gestures Native Resolution
» Included Pen » 330 cd/m? Brightness
» Mvailable in Black, ~ &
Blue, Green or Purple L <
(WACTH300B)......ooo oo ....59.99 (WAC270HDT) 2,799.95
€L MO (RA-1 , ﬁ IRISNotes 2 Executive
Wireless Tablet “#IRIS pigital Pen N
» USB o e » Captures Handwritten Notes & Graphs
» Includes Pen £ » Converts Notes into Editable Text
» Features a 50" (15 m) R — » Full Mouse & Tablet Functionality
Wireless Range » Stores up to 100 A4/Letter Size Pages
» Operates up to 16 Hours » Texts & Graphs Combined Recognition
On a Full Charge » OCR Recognition Trainer Module
» Windows Compatibility » Works Online & Offline
» USB Rechargeable » Mac & Windows Compatible
(ELCRAT) ... Calll or Log-on (IRABTABD) e 94.29
wacom wacom wacom
Intuosé / 5 Classic Pen ArtPen Intuos3 SE Grip Pen
» Slim, Classic Look with » Unique 360° Rotation Sensitivity » 1024 Pressure Levels
a Natural Feel » Pressure / Tilt Sensitivity » +[-0.25mm Pen Accuracy
» Draw, Erase, and » Chisel and Bullet Tipped Nibs » Programmable Side-Switch
Mouse Functions » Digital Eraser » Nib Extractor » Battery-Free Operation
» Pressure and Tilt Sensitivities » Weighted Stand » Cushioned Grip
» Weighted Stand » Replacement Nibs
» Extra Nibs » Works with Intuos4
» Works with Intuos4 & 5 Tablets and Intuosb Tablets
o 79.95  (WAICP) o 646.95  (WAIAMP) oo 8999 (WACGP) 69.95
87




COMPUTERS

WIRELESS NETWORKING

0 wnoieanesares AirPOrt Extreme Base Station
-

WIRELESS ROUTERS

0 sunoimarns AirPort Time Capsule

NETGEAR R7000

» Simultaneous Dual-Band 802.11ac Wi-Fi » Simultaneous Dual-Band 802.11ac Wi-Fi T Nighthawk AC1900 Smart Wi-Fi Router

» 802.11a/b/g/n Wi-Fi Compatible » 802.11a/b/g/n Wi-Fi Compatible » Wireless 802.11ac 1900 Router

» WPA/WPA2 Encryption, NAT Firewall » WPA/WPA? Encryption, NAT Firewall » 2.46Hz & 56Hz Dual Band

» 1xUSB 2.0 Port » 1xUSB 2.0 Port » by Gigabit Ethernet Parts

» 3 x Gigabit Ethernet LAN Ports » 3 x Gigabit Ethernet LAN Ports » 1xUSB 3.0, 1x USB 2.0

(APAPEQ) 179.99 3TB (APAPTC3) 359.00  2TB (APAPTC2) 277.99 (NER7000100PA) 199.95
NSU=S AC2400 /1SS RT-AC68U Ienowvo WRT1900AC

Wireless Dual-Band Gigabit Router Wireless Dual-Band Gigabit Router Wireless AC Router

» §02.1ac Protocol » 02.11ac Pratocol » Wireless 802.11a/b/g/n/ac Compatible

» Up to 1734 Mb/s at 5 GHz » Up to 1734 Mb/s at 5 GHz » Dual Band 2.4 GHz / 5 GHz

» Dual-Band 2.4 GHz/5 GHz Frequencies » Dual-Band 2.4 GHz/5 GHz Frequencies » 1.2 GHz Dual-Core ARM Processor

» Five 10/100/1000 BaseT Ethernet Ports » Five 10/100/1000 BaseT Ethernet Ports » 128MB Flash / 256MB DDR3 RAM

» Four External Antennas » Four External Antennas » & x Detachable External Antennas

» File, Printer & 36/46 Modem Sharing » File, Printer & 36/46 Modem Sharing » & x Gigabit LAN Ports

(ASRTAC87U) 233.00 (ASRTAC68U) 195.99 (LIWRT1900AC) 219.95
D-Link AC3200 TP-LINIK ArcherC7AC1750 TDP-1 INIK TL-WR84IN

Wireless Tri Band Gigabit Cloud Router » |EEE 802.11 a/b/g/n/ac Standards » Up to 300Mbps

» 802.11alg/nfac Protocol 802.3/3u  Protocol > Upto1.75 Gbps Total Bandwidth » 14148366k

» Upto 3.2 Gbps » 2.4 GHz / b GHz Frequencies » Easy Setup Assistant

» Tri-Band: 2.4 GHz & Dual 5.0 GHz » 4x10/100/1000 Mbps LAN Ports » Quick Security Setup

» Four Gigabit LAN Ports » 1x10/100/1000 Mbps WAN Port » SPI Firewall Dual 5dBi Omni &((_-"_)

» Six External Antennas » 3x b dBi External Antennas Directional Antennas ———
(DLDIRBYOLR) 309.95 (TPARCHERCT) 99.95 (TPTLWRBA4IN) 18.99
WIRELESS ACCESS POINTS

«J UAP-AC «J UAP-PRO «J UAP UniFi
UBIQUITI UniFi Access Point Enterprise UBIQUITI UniFi Access Point UBIQUITI Access Point
» 802.11 a/blg/nfac Wi-Fi Standards » 802.11 a/b/g/n Wi-Fi Standards » 802.11 b/g/n Wi-Fi Standards
» Range of up to 400’ » Range of up to 400° » Range of up to 400’
» 2x10/100/1000 Ethernet Ports D » 2x10/100/1000 Ethernet Ports & Speed of 300 Mb/s
» UniFi Controller Software » UniFi Controller Software P » UniFi Controller Software A
» Integrated 5 dBi Omni Antennas » Integrated 5/4 dBi Omni Antennas » 1x10/100 Ethernet port
[UBUAPAC) . 299.00 (UBUAPPRO) 201.99 (UBUAP) 67.30

Ienowvo LAPACT750PRO

» Maximum Data Rate: 1,750 Mbps @
» 802.3at PoE Compatible

Dual-Band Wireless Access Point
» 2.4 GHz [ 5 GHz Concurrent
» Cluster Management System —

» |EEE 802.11a/b/g/n/ac Network Standards
Frequencies Internal Antenna
(LIAC1750PR0) 229.99

alrer]ee WAP3TI Wireless-AC/N Dual
CISCO Radio Access Point
» 802.11a/b/g/n/ac Wi-Fi Bands

» 2.4 GHz and b GHz Frequencies

» 3x3 MIMO Technology i \
» Integrated 2 dBi Antenna

» 10/100/1000 Ethernet Jack
» Power over Ethernet

(CIWAP3T1AK) 178.95

88

lenowvo | APAC1200

Dual Band Wireless Access Point
» |EEE 802.11a/b/g/nfac Network Standards =

» Maximum Data Rate: 1,200 Mbps \
» 2.4 GHz [ 5 GHz Concurrent Frequencies

» Internal Antenna g
» §02.3at PoE Comaptible

» Gigabit Ethernet Port Speed

(LILAPAC1200) 146.99

EnGenius ECB1750 Dual Band Wireless AC
1750 Indoor Access Point / Client Bridge

» Dual Band 2.4 GHz / 5 GHz Compatible

» |EEE 802.11a/b/g/n/ac Standards

» Data Rate Up to 1300 Mb/s on 5 GHz |
» 128MB RAM e 2

» 16MB Flash Memory e (4 .
» 1x RJ-45 Gigabit Ethernet Port 1
(ENECB1750) Call or Log-on

amped|wireless > APA20 High Power
700mW Dual Band AC Wi-Fi Access Point
» 802.11a/b/g/n/ac Wireless Standards

» 2.4 GHz /5.0 GHz Dual Band

» 4x10/100/1000 M LAN Ports

» 1x10/100/1000 M Port to Router

» 1x USB 2.0 Port for USB Storage

» WEP/WPA/WPA2/WPA Mixed Security

(AMAPAZ0) 159.99

SonicWALL SonicPoint ACi Wireless Access
Point with 1-Year of SonicPoint Support

» 802.11b/g/n Network Standards

» Meets 802.11at PoE Power Requirement

» 6 x LED Status Indicators

» 2 x Gigabit Ethernet Ports W
» Wall or Ceiling Mountable ~

» § x Virtual Access Points per SonicPaint

(S0015SC0871) 381.99

800-947-5534 + 212-444-6740




WIRELESS NETWORKING

(J NBE-BAC-19 NanoBeam ac

» airMAX Technology e

» Atheros MIPS 74Kc, 720 MHz Processor .

» 128MB DDRZ, 8MB Flash Memory %‘_

» 1x10/100/1000 Ethernet Port -
(UBNBESAC19US) 91.00

() PBE-BAC-620 PowerBeam ac

» Atheros MIPS 74Ke, 720 MHz Processor

» 128 MB DDR?, 8 MB Flash Memory 2
» 450+ Mb/s Transfer Speed
» 19-+mi (30+ km) Range

» air0S v7 Operating System

(UBPBESAC620U) 199.00

WIRELESS BRIDGES

COMPUTERS

¢J NanoStation5 Broadband Outdoor

» Atheros AR2313 S 180 MHz MIPS Processor s
» 16MB SDRAM, 4MB Flash Memory
» 10/100 BASE-TX Ethernet Interface
» 2 x 14dBi Dual Polarity Antennas o5

(UBNSM5) 86.24

EnGen/?\us ENH5UU High-Powered, Long Range
5 GHz Wireless N300 Outdoor Client Bridge

» 600mW High Power Long Range Coverage

» Upto 1 mile Coverage » Wireless N300 Speed

» 2 Fast Ethernet Ports » Internal 13 dBi Directional Antenna

» |P55 Waterproof Housing » PoE & Mounting Kits Included ===

(ENENH500) Call or Log-on
Kit (ENNENH500KIT) 160.99

TP-LINK AC750
Wi-Fi Range Extender /
» Expand Wireless Coverage '
» Compatible with 802.11b/g/n and 802.11ac
» b GHz 433 Mbps Plus 2.4 GHz 300 Mbps

» Range Extender Button b
» WEP and WPA Wireless Security -
(TPRE200) 43.34

NETGEAR Netgear EX6200
AC1200 Wi-Fi Range Extender

» 802.11ac Wi-Fi Technology

» Dual Band 2.4 GHz and 5 GHz

» b x Gigabit Ethernet Ports

» 1xUSB 3.0 Port

» Powerful 800 MHz Dual Core Processor

(NEEX6200) 119.95

U NBE-M5-16 GHz 16dBi NanoBeam
» airMAX Technology ib
» Atheros MIPS 74Kc, 560 MHz Processor
» 64MB DDR2, 8MB Flash Memory
» 1x10/100 Ethernet Port

(UBNBEMS16) 67.00

']

EnGenius ENS202 High-Powered, Long-Range
2.4 GHz Wireless N300 Outdoor Client Bridge

» 400mW Power Delivers Long-Range Coverage

» Up to 300 Mb/s Wireless Speed

» Backward Compatible to 802.11b/g

» Dual Polarity 8 dBi Directional Antenna

» SSID-to-VLAN Tagging

(ENENS202) 66.99

TP-LINK TLWAS5RE

300 Mb/s Universal Wi-Fi Range Extender
» |EEE 802.11b/g/n Wi-Fi Network Standards /
» 2.4~1.483b GHz Frequency '

» 7 x Internal Antennas

» Up to 300 Mb/s Data Transfer Rate 0

» Plug & Play Configuration

(TPTLWABB4RE) 27.95

NETGEAR WN3000RP
Universal Wi-Fi Range Extender
» Extends Wireless Coverage ! ; 4
» Universal Compatibility '
» Easy Install - No CD Required

» Connect Your iPad, Smartphanes, and More

» Extends Range of Any Wireless Router

(NEWN3000RP) 52.95

TP-LINIK Wireless N Express Adapter
450 Mbps 2.4/5GHz Dual Band PCI Express
» Maximum Data Transfer Speed: 450 Mbps
» Dual Band 2.4 &5.0 GHz Channels

» Backward Compatible with 802.11a /b / g
» WPA / WPAZ Encryption Security

» Ad-Hoc Infrastructure Mode

(TPTLWDN4800)

TP-LINK AC600
Wireless Dual Band USB 2.0 Adapter

» Supports 802.11ac Wi-Fi -w
» Dual Band b GHz and 2.4 GHz Compatible .
» b GHz speed: up to 433 Mbps

» 2.4 GHz speed: up to 150 Mbps

» Backwards Compatible with 802.11a/b/g/n

» Wireless Security

(TPARCHERT2U) 29.95

www.BandH.com

TP-LINK TL-WA850RE

300 Mb/s Universal Wi-Fi Range Extender
» 10/100M Ethernet Port (RJ-45) Interface

» 2.4:t0 2.4835 GHz Frequency

» Flexible Deployment » 2 x Internal Antennas

» Easily Establish Encrypted Connection (o)

» Ethernet Bridge » 5 x Signal Indicator Lights —

(TPTLWAB50RE) 22.33

/I=SUS RP-N53 N600 Wireless

Dual-Band Range Extender -

» IEEE 802.11 a/b/g/n Network Standard
» Ethernet Interface

» 1 x On-Board PCB Antenna

» 2.4 &5 GHz Operating Frequency

» 80211 a/b/g/n Data Rate

[ASRPN53) 64.99

L

WIRELESS ADAPTERS

/=SS USB-ACH6 Dual-Band
Wireless-AC1200 USB 3.0 Wi-Fi Adapter
» |EEE 802.11a/b/g/n/ac Standards

» Supports 2.4 GHz & b GHz Frequencies
» Enhanced Wireless AC Performance

» Supports Data Rates up to 867 Mbps

» 2 x Internal 2 dBi Antenna

(ASUSBAC50) 69.99

amped|wireless§ UA230A
802.11ac Wi-Fi USB Adapter
» 802.11a/b/g/n/ac Wireless Standards

» 2.4 GHz & 5 GHz Dual Band Frequencies
» USB 2.0 Interface

» Up to 433 Mbps Data Transfer Rate

» Up to 20 dBm Wireless Output Power

» 1x High Gain Dual Band 3 dBi Antenna

(AMUA230A) 49.99

/iSU=S USB-AC51
Dual Band Wireless AC600 Wi-Fi Adapter
» 802.11ac USB Wi-Fi Adapter

» 1 x Internal 4.56 dBi Antennas

» 433 Mb/s Data Rates at b GHz Frequency
» 150 Mb/s Data Rates at 2.4 GHz Frequency
» 1xUSB 2.0 Port

[ASUSBACH1) 39.99

Enimax AC600
Wireless Dual-Band Mini USB Adapter

» 1xUSB2.0Type A 1 x Link/Activity LED
» Complies w/Draft IEEE 802.11ac Standard
» Compatible w/Wireless 802.11a/b/g/n

» Dual-Band Wireless Connectivity

» Maximum Wi-Fi speeds of 150/433 Mb/s

» Hardware WPS Button .

(EDEW7811UTC) 15.43
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COMPUTERS

TP-LINK TL-POE150S
Power Over Ethernet Injector

» |EEE 802.3, 3u, 3af Compliant
» 1x10/100/1000M LAN Port

» 1 x Power Socket (DC IN)

» 1x10/100/1000M PoE Port

» Power LED Indicator

TPTLPOE150S e 19.95

\( P veaurr INS-8023AF-I
802.3af Passive PoE to 802.3af
Indoor Adapter

» Transforms PoE devices into 48V
802.3af-compliant products

» Works with 802.3af switches

» Compatible with airMAX, airVision, UniFi,
and mFi PoE devices that use 100 Mb/s ports

UBINSBOZ3AFI e 19.95
INS-8023AF-0 Outdoor Adapter (UBINSBO23AF0) ............cc.c.... 21.99

@) mororora SURFhoard SB6141
DOCSIS 3.0 Cable Modem

» TCP/IP Data Protocol

» b4 or 256 OAM Modulation

» 1xRJ-45 MDIX Data Port

» Dual 96 MHz Capture Windows

» 75 () F-Connector Cable Interface

» 10/100/1000Base-T Network Interface
» Windows/Mac/UNIX Compatible

i “ERRININING, W

M0SB4141 e 89.95

E 5352
zoom DOCSIS 3.0 Cable Modem / Router
with Wireless-N

» |Pv4 & IPv6 Compatible

» Support for up to 8 SSIDs

» 20 dBm Transmit Power

» by RJ-45 Gigabit Ethernet Parts

» 802.11b/g/n Wi-Fi Networking Standards

» Support for up to 263 Wireless Devices

» Up to 300 Mb/s Wireless Data Rate

1053520000 O 139.95

isco” RVITOW

Wireless-N VPN Firewall Router
» 802.11b/g/n Wi-Fi

» IPvé Support

» Advanced Security

» hx Fast Ethernet LAN Ports

» Restricted Guest Access

» Mac and Windows Compatible

» Easy Browser-Based Configuration

» IPsec & PPTP VPN Remote Access Support
CIRVI10WANA e 65.30

90

TP-LINK TL-POE10R

PoE Splitter

» Auto Sensing Algorithm

» Plug & Play Compatible

» Power LED Indicator

» 1 x Power Socket (DC OUT

» |EEE 802.3, 3u, 3af Standards Compliant

» 1x 10/100M Auto-Negotiation PoE Port
» 1x10/100M Auto-Negotiation LAN Port)

TPTLPOETOR .. 13.74

\(J veiourr POE-24-12W-6

PoE Adapter (24 VDC, 12W)
» Gigabit LAN port

» Remote reset capability

» Protection against surge, clamping,

maximum surge discharge, peak pulse current
» Provides protection against ESD attacks
» Powers airFiber, airMAX, airVision, UniFi,
and mFi Ubiquiti PoE devices
» Compatible with airGateway Access Points
UBPOE2412WG6 14.95

m mororora SURFboard SBG6580
DOCSIS 3.0 Wireless Cable Modem
& Wi-Fi Router

» Download speeds up to 343 Mbps
» 8 download & 4 upload channels
» Supports IPv4 and IPvg

» §02.11n Wi-Fi®

» Switchable 2.4/5.0 GHz Dual-band
» 2x2 omni-directional antenna

» 4-Port Gigabit Ethernet Router

MOSBG6580... 129.99

D-Link DCM-301
DOCSIS 3.0 Cable Modem
» Compatible with DOCSIS 1.0/1.1/2.0

» CATV-Coaxial WAN Port
» Upload Speeds up to 150 Mbps

» Meets DOCSIS 3.0 Specifications

» Download Speeds up to 343 Mbps

» 10/100/1000 Base-TX Ethernet Port
» Supports IPvé Internet Addressing
DLDCM301...... 79.95

NETGEAR ProSafe FVS318G-200NAS
8-Port Gigabit VPN Firewall Router

» SSLand IPsec VPN Remote Access
» 250 Mb/s Firewall Throughput
» 300 MHz Processor Speed

» 128MB RAM and 32MB Fla

» DoS Attack Protection

» 6000 Maximum Concurrent Connections

» Stateful Packet Inspection (SPI) sh Memory
» b6-Bit DES, 168-Bit 3DES Encryption
NEFVS318620S

119.95

POWER OVER ETHERNET (POE), CABLE MODEMS AND FIREWALLS

AXISa. 18120
Power over Ethernet Midspan
(15W, 1-Port)

» 15.4 W of Maximum Power

» |EEE 802.3af Compliant \ \

» Power PoE enabled products

AX6026204 e 57.99

Linksys LACPI30
Gigabit High Power PoE Injector

» Transfers at Gigabit Ethernet Speeds

» 5 Gigabit Ethernet Auto-Sensing Parts

» 1 Data/PoE Port /1 Data Port

» Quality of Service (QoS) Prioritization

» |EEE 802.at and IEEE 802.af Supported

» Access Points and IP Cameras Supported
» Up to 328" Range

» Up to 30W at 10/100 Mbps via CATH

LILACPI30 e 58.99

TP-LINK TC-7610
DOCSIS 3.0 Cable Modem
» Compatible with Most Major ISPs

» Eliminate Monthly Fees

» DOCSIS 3.0, 2.0, 1.1, & 1.0 Compatible
» Channel Bonding 8 Downstream

» Channel Bonding 4 Upstream

» |Pvé4 & IPv6 Dual Stack

» LEDs Display Device & Network Status

TPTC7610

Call or Log-on

Actiomtec GTT01DNF

DSL Modem

» ADSL 2/2+
» Ethernet
ACGT701DNF O £49.95

» Routing Capabilities
» Energy Efficient Design

‘dises” RV 120W
Wireless-N VPN Firewall

» High-Speed 802.11n
Wireless Connectivity
» 4-Port 10/100 Switch 1

» Enhanced Voice, Video

& Data Traffic
» Cisco FindIT Network Discovery Utility
» Highly Secure Wireless Guest Access

CIRVIZOWANA

Call or Log-on

800-947-5534 + 212-444-6740




NETWORK SWITCHES, NETWORK ADAPTERS, POWERLINE ADAPTERS

NETGEAR ProSafe 65105
5-Port Gigabit Desktop Switch
» Full Duplex Support

» Autosensing MDI/MDI-X Ports
» Compact Form Factor

NEGST05NA
FS105 5-Port 10/100 Desktop Switch (NEFSTOBNA) ... 19.80

disco’ $6300-10

10-Port 10/100/1000
Gigabit Managed Switch
» 8x10/100/1000 Ports

» 2x Combo mini-GBIC Ports

» 00S & IPvé / IPv8 Support

» Advanced Security Management
» Mac, Windows, Linux Compatible
CISG30010

169.00

TP-LINK TL-561005D

5-Port Unmanaged Gigabit Desktop Switch
» b Gigabit Ethernet Ports

» Auto MDI/MDIX on All Ports

» 802.3x Flow Control

» Supports 8K MAC Address Table
» Plug-and-Play Installation

» Windows, Mac, Linux Compatible
TPTLSG1005D

17.99

@ Authorized Reseller MC704LL/A
USB Ethernet Adapter

» USB 2.0 to 10/100BASE-T Fast Ethernet
» For MacBook Air

» Mac 0S X v.10.4.8 or later

APMCT04LLA 21.99

TP-ULINK TL-WPA4220KIT

300 Mbps Wi-Fi Range Extender
AV500 Powerline Edition

» 128-bit AES Encryption -\*‘\%% \\

» IEEE 802.3/3u Ethernet Standards b \,

» IEEE 802.11b/g/n Wi-Fi Standards , N
» 2x10/100 Mbps Ethernet Ports y
WPA4220KIT Call or Log-on
TL-WPA&4220KIT Wi-Fi Range Extender (TPTLWPA4220K).......... 55.95

Aetiortec PWRST1KO01
500Mbps Powerline Adapter Kit

» 1-68MHz Frequency

» 1x10/100 BaseT Ethernet LAN

» 1x 500 Mbps Powerline =
» HomePlug 1.0 Compatible g
» 128-bit AES Link Encryption

» HomePlug AV 200/500Mbps Interoperability

ACPWR511KD1

49.99

www.BandH.com

NETGEAR' ProSafe F5108P
8-Port 10/100 Switch with 4-Port PoE

» Full Duplex Support

» Compact Form Factor

» Power over Ethernet Support
» Autosensing MDI/MDI-X Ports

~
b
o
L2

NEFST08PNA

alraln
cisco

S6100D-08

Unmanaged Small Business Switch

» §x RJ-4510/100/1000 Ports

» 166bps Switching Capacity

» 11.9mpps Forwarding Capacity
» Status LEDs

» 802.3 10/100/1000 Standards Compliant

CISG100DOBPN

\(J veou TOUGHSwitch TS-5-POE
5-Port Advanced PoE Controller
» §4MB System Memory

» 8MB Code Storage

» MIPS 24K, 400 MHz Processor
» 24V Configurable Passive PoE
» 5x10/100/1000 Ethernet Data Ports
» 1x10/100 Ethernet Management Port
UBTS5POE

StarTechcom USB31000S

USB 3.0 to Gigabit Ethernet NIC Network
Adapter (Black)

» Gigabit Ethernet Port

» Meets IEEE 802.3/u/ab Standards

» USB Powered

» Crossover Detection & Auto-Correction
STUSB31000S
TG-3468 Gigabit PCI Express Network Adapter (TPT63468)......... 11.64

N
o
=3
-

TP-LINK AV500 TL-PA4010KIT
Nano Powerline Adapter
» Plug-and-Play
» HomePlug AV standard compliant
» High-speed data transfer rate
up to 500 Mb/s
» Suitable for HD video or 3D video streaming and online gaming
TPTLPA4OT0K 39.95
TL-PA4010 AV500 Nano Powerline Adapter (TPTLPA4010) ... $22.44

LINKSYS'by Cisco - Powerline AV PLSK400-NP
4-Port Network Adapter Kit

» High Speed of up to 200 Mbps

» 128-bit Encryption Security

» Connects to Any Device with Ethernet

» Pairs with Any Linksys E-Series Router

» 7 Ethernet Cables Included

» Plug and Play

LIPLSK400NP

COMPUTERS

NETGEAR' ProSafe FS728TP-100NAS
24-Port 10/100 Smart Switch with PoE
2 Gigabit and 2 Combo

» Flexible Connectivity

» Power over Ethernet Support
» Smart Management Features
» Rackmount Design

NEFS728TP100

asco. §6102-24

24-Port Gigabit Unmanaged
Small Business Switch
» 24 x RJ-4510/100/1000 Ports

» 2 x Combo Mini-GBIC Slots

» 486hps Switching Capacity

» 802.3 10/100/1000 Standards Compliant
» HOL Blocking Prevention

CISG10224NA

) vsiurrt EdgeSwitch

\ o=

341.32

N g

146.99

24 Port 250 Watt Managed PoE+ Gigabit

Switch with SFP

» 24 x Gigabit Ethernet Ports

» 2x1Gbps SFP Ethernet Ports
» 250 Watt Max. Power Consumption
» Non-Blocking Throughput Switching
» Auto-Sensing IEEE 802.3af/at PoE
UBESZ4250W

PROMISE" SANLink2

TECHNOLOGY, INC.
20 Gb/s Thunderbolt 2 to 10GBase-T

Ethernet Bridge Adapter
» Full Duplex @ 10 Gb/s

» Auto-Negotiate with 1 Gb/s

» Daisy-Chain Support

» Dual 20 Gb/s Thunderbolt 2 Ports

» Dual 106Base-T Ethernet External Ports
PRSL2TB210E

TP-LINK TL-PA6010KIT AV600
Gigabit Powerline Adapter

» Up to 984 ft / 300 m Range

» 128-bit AES Encryption

» Plug & Play Functionality |
» HomePlug AV Compatible i
» Supports IEEE 802.3/3u/3ab Protocols

» 1 x Gigabit Ethernet Port per Adapter
TPTLPAGO1OKI

393.99

519.99

59.99

D-Link Powerline AV2 DHP-701AV
2000 Gigabit Network Extender Kit

» Gigabit Ethernet Interface

» Plug-and-Play Installation

» 128-bit AES Link Encryption

» |EEE 802.3 / 3u Network Standards

» Power/PowerLine/LAN LED Indicators

» HomePlug AV & HomePlug 2 Compatible
DLDHP701AV

123.23
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COMPUTERS

;’xceuon IrPOl'(
USB 3.0 Hub

» 4x USB 3.0 Ports
» Up to 5Gbps Transfer Speed Per Port
» Windows & Mac Compatible

[XCUSBAPPH) ..o 16,98

& Transcend” 4-Port
USB 3.0 Hub

» USB 3.0 Interface

» 4x USB 3.0 Ports

» USB v1.2 Charging Specification
» Integrated LED Indicator

[TRUSBPH) ..o 19.99)

sasrenT<_ 4-Port

USB 3.0 Travel Hub
» Thin, Lightweight Design

» Plug-and-Play; No Drivers Required
» Windows & Mac Compatible

[SAHBSBAR)..... e 9.9

®roeears )-Port USB Cable

KVM Switch with Audio & Mic

» Bus-Powered

» Plug-and-Play

» Mic and Audio Out Support

» KVM Cables Built Into Unit i
» 2048 x 1536 Resolution Support

» Works With ALl Major Operating Systems

» Manage 2 Computers From Single Station

[IOKZPCSAM) . 21,98

RF-ILimfc 2PortHDMIUSB
KVM Switch with Cables

» 2 Extra Sets of Built-in USB 2.0 Ports
» Supports High Level Audio Formats

» Video Resolution up to 1920 x 1200

» Na Software Installation Required -
» Front Panel LED Indicators

» Auto Scan Feature -

» Metal Case Design
(RFHUKT020) ..o 89.00

HUBS & KVM SWITCHES

;excmon ll'Port
Powered USB 3.0 Aluminum Hub

» 4xUSB 3.0 Ports

» AC Powered

» 1x LED Indicator per Port

» Up to bGbps Transfer Speed Per Port
» Heat-Dissipating Aluminum Hub

» Windows / Mac Compatible

BLACK (XCUSB4PHV2) 34.95
SILVER (XCUSBAPHSVD) ... 34,9

Lexar  HR1 Hub

Professional Workflow

» Four-Bay USB 3.0 Reader Hub

» Modular and Configurable Design

» High-Speed USB 3.0 Transfer Rates

» Optional XOD & CFast 2.0 Readers

» Optional SDHC/SDXC Reader

» Optional CompactFlash Reader

» Optional microSDHC/microSDXC Reader
» Transfer from Four Cards Simultaneously

(LEWFUH0)

i 99,95

Gracean L-Port
USB 2.0 Hub

» Plug-and-Play; No Drivers Required
» Windows & Mac Compatible
» USB 2.0 Interface
» Compact Size

(10GPUSBZH) ..o 9D

Groeears 2x4USB 2.0
Peripheral Sharing Switch

» 2 Computers Share up to 4 USB Devices
» Data Transfer Rates up to 480Mbps

» USB 2.0 Compliant

» LED Indicators ‘
» Hot Pluggable

» Molded In-Cable Design

(106USADD) .o

i 28,99

StarTechcom USB VGA KVM
Console Extender over CAT5 UTP

» Supports Combo Keyboard & Mouse
» 2% USB Type A PC Interface
» RJ-45 Ethernet Interface
» Supports Auto-Switching
» Intuitive Hot-Key Commands
» CE, FC, and RoHS Compliant

(STSVBBUTPU) . 189,99

;’xceuon IrPOl'(
Aluminum USB 3.0 Wedge Hub

» 4 x External USB 3.0 Ports

» Up to 5 Gb/s Data Transfer Rate

» Windows / Mac / Linux Compatible
» Heat-Dissipating Aluminum Housing
» USB 2.0/ 1.1 Backwards Compatible

[XCUSBAPFHS) ... 26,9

5, KW-HUB-9U3

Multi-Port USB 3.0 Hub with IQ Charging
» Total of 9 x USB 3.0 Ports

» 2x USB 3.0 1Q Charging Ports

» 2.4A Output Current on each 1Q Port

» Transfer Rates up to 5 Gb/s

» Compatible with USB 2.0/1.1

» 900mAh Output Current on each USB 3.0

» Power Adapter and USB 3.0 Cable Included

» Plug & Play » Windows and Mac Compatible

(KIKWHUBBUS). ...
PRO-77U 5.25"

ﬂl: Hub/Reader with USB 3.0

» SuperSpeed USB 3.0 Interface
» Adds 4 USB 3.0 Ports to PC
» & Media Slots
» CF UDMA-7 & SDXC
UHS-1 Card Support
» Plug and Play

e h0,95

[ATPROTTUIRH) .. 99,98

e mcears 6051104 4-Port USB
DVI KVMP Switch with Audio & Cables

» Asynchronous Hotkey Switching

» USB-Based Keyboard/Mouse Support

» Hotkey/Front Panel Switching

» Manage 4 Computers

ey [
» LED Status Indicators

» DVI Monitor Support

» Resolutions Up to 1920 x 1200

(106CSTI0A) o 169,95

Smart-Avi pVYN-16Pro 16-Port DVI-D
KVM Switch with USB 2.0 Sharing

» Simplified management of up to 16 computers
with DVI-D, audio, and USB 2.0 outputs
» Controlled remotely using keyboard hotkeys or RS-232
communication channel commands,
as well as directly using the
easy-to-read front panel

[SMDVNT6PROS) . 1,217.94

800-947-5534 - 212-444-6740




@0 Authorized Reseller USB SuperDrive
External CD/DVD Drive

» Slim and Portable E 1
» External 8x SuperDrive
» MacBook Pro w/ Retina, MacBook Air
» Mac mini, Mac Pro (Late 2013)
» DVDA=R DL/DVDA+RW/CD-RW

APMMDB64ALLA 76.99

™ SE-506CB/RSBD

Slim External Blu-ray Writer Drive
» USB 2.0 Powered Interface

» Blu-ray 200ms Access Time

» Write Speeds up to 8x for DVD
» Write Speeds up to 24x for CD
» Write Speeds up to 6x for BD Discs

» Supports Single/Dual/Triple and Quad BD

SASEB06CBRSB 74.73

Proneer BDR-XD05B
6x Slim Portable USB 3.0 Writer

» Blu-Ray, DVD & CD Writer

» Reads BD-ROM

» Reads & Writes BD-R and BD-RE
» Reads & Writes BD-XL TL 100GB Discs
» Reads & Writes BD-XL QL 12868 Discs

PIBDRXD05B 89.00

LG BE14NU40 14x External Blu-ray
Life's Good Disc Rewriter
» Blu-ray, VD & CD Writer
» Supports BDXL 12868 Discs —
» 1hx Blu-ray Disc Write Speed )
» 16x DVD Write Speed
» 48 CD Write Speed
» 4MB Buffer Capacity
LGBE14NUAD 114.99

" EZD3TDVDLGB
™" 3 Target 24X DVD/CD Duplicator

» Burns Approximately 30 DVDs / Hour
» SATA Internal Interface

» Up to 24X Read Speed

» 3 x DVD Writers

» 1 x DVD-ROM Drive

» No Cool Down Period

EZD3TDVDLGB 298.57

mesoeoos - CopyWrriter Pro
1:10 CD/DVD Duplicator

» Stand Alone Operation

» USB 2.0 Connectivity

» 500GB Internal Hard Drive
» 2bx DVD Burning

» 48x CD Burning

MIDVDPP1016 849.00

www.BandH.com

OPTICAL DRIVES & DUPLICATORS

/iSU= SDRW-08D2S-U/B
8X Slim External DVD+RW Optical Drive

» Up to 8X DVD Read / Write Speeds -

» Up to 24X CD Read / Write Speeds

» 160 ms DVD Access Time

» 140 ms CD Access Time

» Windows & Mac Compatible

ASDRW08D2S 27.99

< SE-208DB/TSBS

Slim Portable DVD Writer

» USB 2.0/3.0 Interface Connector
» 150ms Random Access Time

» 1MB Buffer Memory

» Mac Compatible

» Horizontal Drive Installation

» Slim Design

SASE208DBTB 23.89

>

Proneer BDR-XU03 _

6x Slim USB 3.0 Writer ’ ’

» 128 6B Quad Layer Support

» Auto Quiet Mode

» 6x BD-R Max Write Speed

» Supports BDXL, Blu-ray, DVD, and CD

» Magnesium Body for Added Strength

PIBDRXUO3 164.95

LG  GP6ONBSD

Lifes Good  8X Multi Portable DVD Rewriter

<

» M-Disc Support

» Max 8X DVD+ Write Speed

» Max 24X CD Write Speed

» 0.75MB Memory Buffer

» Supports Dual Layer DVD-R Discs

» Supports Double Layer DVD+R Discs
LGGPAONBSO 24.49

PRIMERA. Bravo SE

Disc Publisher
» 20-Disc Capacity

» USB 2.0 =

» 4800 DP! Printing

» AccuDisk Robotic Arm

PRBSE 1,325.00

To view a full listing of all
Optical Drives & Duplicators

or visit our website BandH.com/w1593

COMPUTERS

NsUsS BW-12D1S-U
12x Blu-Ray Writer with USB 3.0
» Write Speed of 12x: BD Discs
» Write Speed of 16x: DVD-R & DVD+R
» Write Speed of 40x: CD-R
» USB 3.0 Interface
» Blu-Ray 3D Support with Software

ASBW12D15UB 114.18

< SH-224BSB

24x SATA DVD-Writer Internal Optical Drive
» Burst Transfer Rate: SATA 1.5Gbps

» Buffer Memory: 0.75MB
» 48X CD-R

SASH224FBSB 19.91

roneer BDR-2209
16x Internal Blu-Ray / DVD Writer

» 4MB Data Buffer “ =
» Serial ATA Interface _
» Wide Blank Media Support

» Up to T6x Write Speeds on BD-R Discs
» Up to 14x Write Speeds on BD-R DL Discs

PIBDR2209 88.49

LG WHI6NS40

LifesGood 16X Internal Multi Blu-ray Rewriter
» 16x BD-R Write Capability %
» 4 MB Buffer Under-Run Prevention
» Maximum 16X DVD+/-R Write Speed

» 30 Blu-Ray Title Playback

» Supports M-Disc / BDXL Compatible

» Read & Write Blu-ray, DVD and CD Discs

L6WH16NS40 58.95

PRIMERA. Bravo 4051
Disc Publisher

» DVD+R/CD-R

» Mac and PC Compatible

» Fast Six Second Printing

» Prints up to 50 Discs at a Time
» Individual CMYK Ink Cartridges
» High-resolution 4800 DPI Inkjet Printing

PRBA4051 1,825.00

Blu-ray 1:1 Standalone
/USB 2.0 Duplicator

» Standalone or USB 2.0 Operation
» 8X Blu Ray burning

» PrassiTech ZuluZ Software

MIBD121 399.00




COMPUTERS 3D PRINTERS & SCANNERS

&Dsdlee 3D Printing Pen
With ABS & PLA Filament

» Draw with Plastic Filament

» Draw on Paper or in the Air

» Personalize & Decorate Plastic ltems

» Repair Household Plastics & 3D Prints

» Compatible with ABS & PLA Filament

» “Highlighter” ABS Filament Pack Included
» "The Essentials™ PLA Pack Included

(3030000V2US) 98.99

€ FLASHFORGEUSA (reator Pro
3D Printer

» Build Volume: 8.9x5.7x b.9”

» 100 Micron Layer Resolution

» Dual Extruders for 2-Color Printing

» Uses ABS, PLA, & Dissolvable Filament

» Print from SD Card or USB » Integrated LCD Screen

» Sturdy Metal Frame » Blue Tape, 2 Spools of Filament Included
» Mac, Windows, & Linux Compatible

» Acrylic Cover to Protect Filament

[FL3DPRNTRCP)

1,199.00

€ FLASHFORGEUSA Dreamer
3D Printer

» 9.1x5.9x5.5" Build Volume

» Dual Extruders for 2-Color Printing

» Compatible with ABS, PLA, & PVA Filament

» Print from SD Card, USB, or Wi-Fi

» Mutli-Language LCD Touchscreen

» Multiple User-Defined LED Pixel Strips

» 2 Spools Filament & 4GB SD Card Included

» 100-Micron Resolution » Self-Calibrating Build Platform

(FL3DPRINTERD) 1,099.00
> da Vinci 2.0
”~ p -
A«Zf"ﬁ 3D Printer

» Build Volume: 7.8 x 7.8 x 7.8"

» Print via USB 2.0 Connectivity

» STL, 3w File Formats Supported

» Partially Enclosed Build Chamber

» Windows & Mac Compatible

» Single Extruder » 2.6” Display Panel

» Uses 1.7bmm ABS Filament » 100-Micron Layer Resolution

499.99

Single Extruder (XY3F10AXUSOA)

Dual Extruder (XY3F20AXUS0B) 649.00
), da Vinci Junior 1.0
”~ p -
ﬂ*yzﬂﬁ 3D Printer

» Build Volume: 5.9 x5.9x 5.9”

» 100-Micron Layer Resolution

» Uses 1.75mm PLA Filament

» Print via USB 2.0 Cable & SD Card

» STL, .3WFile Formats Supported

» Single Extruder » 2.6” Display Panel

» Auto Calibration, Enclosed Build Chamber
» Windows & Mac Compatible

(XY3F1J0XUS00)

339.00

CRER 3D Pen
With Cool Ink

» Uses Light-Sensitive Photopolymer Inks
» Charges via USB

» Operates Cordlessly After Charging

» No Hot Parts; Safe for Children

» Accepts Wide Variety of Inks

» Includes 3 Ink Cartridges

(CRSKU001) 129.99

€ FLASHFORGEUSA (reator
3D Printer

» Build Volume of 300 Cubic Inches z
» Uses PLA & ABS Plastic Filaments
» USB and SD Card Connectivity

» 100-Micron Layer Resolution

» Integrated LCD Screen

» Dual-Extrusion 3D Printing » Integrated LCD Screen L
» Heated Build Platform » Laser-Cut Wood Case
» Built-in Touch-Responsive Keypads

(FL3DFFGCREWO)

— — — =C

= DRI
3D Printer

» Build Volume: 10x 9 x 8

» 100-Micron Layer Resolution

» Uses 1.75mm Filament

» ABS, PLA, Glass, Woad, Flexible Material
» Print via USB Cable or SD Card

» Mac, Windows, Linux Compatible

» Includes 300g of RoBo Blue Filament

» Single Extruder » Heated Build Plate

(ROROBOR1001)

) da Vinci 1.0 All-in-One
-~ i
Wpﬂ 3D Printer & Scanner
» Build Volume: 7.9 x 7.9 x 7.5"
» 100-Micron Resolution
» Scan Volume: 5.9 x5.9”
» 250-Micron Scan Resolution
» Uses 1.75mm ABS & PLA Filament
» STL, .3W, .DAS File Formats Supported
» 2.6” Four-Line Display Panel
» Windows & Mac Compatible

(XY3ST0AXUSOC)

649.99

[] | u All-in-One 3D Printer

Robotics Scanner, Copier, & Fax

» Build Volume: 8.0x 6.0x 5.7

» 80 Micron Resolution

» Scan Volume: 5" Height x 9" Diameter

» Scan and Print to Copy

» Enlarge & Reduce When Duplicating

» Fax from One ZEUS to Anather

» Uses PLA Filament » 7" Color Touchscreen
» Standalone - No Computer Required

(AIZEUS3D)

800-947-5534 + 212-444-6740




AR somrerae Cube 3
3D Printer

» Dual Extruders for 2-Color Printing

» Compatible with ABS & PLA Filament

» Smart, Moisture-Lock Cartridges

» Cubify Software » USB & Wi-Fi Printing Capability

» 6x6x 6" Build Volume » 70-Micron Resolution

» 25 Free Designs Included » 2 Filament Cartridges Included
» Windows & Mac Compatible

White (30C30PW) 999.99
Gray (30C30P6) 999.00

A1 ===~ CubePro Duo
3D Printer

» Dual Extruders for 2-Color Printing

» Compatible with PLA, ABS, Nylon Filament
» Smart, Moisture-Lock Cartridges

» CubePro Software & Cubify Invent

» USB & Wi-Fi Printing Capability |
» 2 ABS Filament Cartridges Included

» 9x10.75 x 9.5” Build Volume > 70-Micron Resolution

» USB Stick & 25 Free Designs Included » Windows & Mac Compatible

(30CPD3DP) 3,399.00

@ makerBot: Fifth Generation Replicator
Desktop 3D Printer

» 9.9%7.8x5.9" Build Volume

» 100-Micron Layer Resolution

» Uses MakerBot PLA Plastic Filament

» MakerBot Replicator Smart Extruder

» Onboard Camera with 640 x 480 Resolution
» USB, Ethernet, Wi-Fi

» 3.5” Full-Color LCD Display

» MakerBot Desktop & Mobile Apps » Mac, Windows, & Linux Compatible

(MAMP05825) Call or Log-on

s so==r=v=_Gapse
3D Scanner

» Portable, Full Color 3D Scanner

» Maximum Scan Volume: 118 x 118 x 118"

» Minimum Scan Volume: 8 x 8 x 8

» Working Distance: 15-60"

» Two Cameras for Capturing Information

» Compatible with 3D Printers

» Class 1 Certified Laser Product

» 7°USB 3.0/2.0 Cable » Compatible with Windows and Mac

(30S8) Call or Log-on

) 3D Capture Stage

For Sprout
» Automates 3D Scanning with HP Sprout I @
» Rotates 360° &Tilts 15° g;‘-‘_‘_—— _
| —

» Maximizes Scan Surface Area Coverage
» Connects via Included USB Cable
» 4.4 b Weight Capacity; 7.5 Max Height
» Compatible with Windows 8 & 10

(HEMZRO7AA) 299.99

www.BandH.com

3D PRINTERS & SCANNERS ~ COMPUTERS

AR -ommrenen CubePro
3D Printer

» 11.2%9.1x10.6” Build Volume

» 70-Micron Resolution

» Compatible with PLA, ABS, Nylon Filament
» Smart, Moisture-Lock Cartridges

» CubePro Software & Cubify Invent

» USB & Wi-Fi Printing Capability

» 1 ABS Filament Cartridge Included

» USB Stick & 25 Free Designs Included » Windows & Mac Compatible

(30CP3DP)

Call or Log-on

7% CreatrHS
teries 3D Printer

» High Speed Printing - Up to 300 mm/s

» 1 Extruder Print: 11.4x 10.6x 7.1"

» 7 Extruder Print: 11.4x 9.4x7.1"

» 20-Micron Resolution

» Heated Glass Build Plate

» Uses 1.75mm Filament

» ABS, PLA, PVA, Nylon, Wood, Brick

» Standalone Printing from USB » Windows, Mac, & Linux Compatible

(LECHSDE3DP)

2,999.00

@ makerBot: Replicator 2X Experimental
3D Printer

» 9.7x6.0%6.1" Build Volume

» 100-Micron Layer Resolution

» Dual-Extrusion 3D Printing

» Uses MakerBot ABS Plastic Filament

» USB and SD Card Connectivity

» Heated, Black Anodized-Aluminum Platform
» STL, OBJ, THING File Formats

» MakerBot MakerWare Software » Mac, Windows, & Linux Compatible

(MAMP05927)

& sosvsTEMS isEnse
3D Scanner

» Snaps On and Turns iPad into 3D Scanner
» Maximum Scan Volume: 9.8 x 9.8 x 9.8

» Class 1 Certified Infrared Laser

» Object Recognition & Optimized Settings
» Minimum Scan Volume: 8 x 8 x 8" » Operating Distance: 1.7 to 4.2

» Free iSense App with Image Editing Tools » Creates STL, 0BJ, and PLY Files
» Upload Images to Cube 3D Printer » Compatible with i0S 7 and Later

iPad Mini Retina (3DIS3DSIPMR)
TPad AIr (3DISIDSIPAIR) ...

499.00
- 99.00

MATTEI ard FOMM Scanner

3D Scanner

» Quick, Color Scans

» Rotating Platform

» Real-Time Scanning

» Sleek, Foldable Design

» Fully Assembled & Tested

» One Click Watertight Meshes

» STL, 0BJ, PLY File Formats Supported

» High Resolution Camera with Dual Lasers

[MAMFS1V1)

€5




COMPUTERS

EPSON' Perfection V600

Photo Scanner

» Optical Density: 3.4 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi
» Max Resolution: 12800 x 12800 dp.
» Scans Prints, 35mm & Medium Format Film
» Maximum Scan Area: 8.5 x 11.7

» DIGITAL ICE Scratch & Dust Removal

EPPV00

Call or Log-on

FUjitsu ScanSnap $1300i

Document Scanner

» Compact Size

» Scan Speed: 12ppm

» Scan Resolution: 600dpi

» Automatic Duplex Scanning
» USB-Powered For Increased Portability
» Scan Directly To The Cloud

» Scan To Commonly Used Programs

FUS13001 2464.99

Canon CanoScan LiDE220
Color Image Scanner

» Optical Resolution: 4800 x 4800 dpi

» Max Resolution: 19200 x 19200 dpi

» Max Document Size: 8.5 x 11.7"

» Five EZ Buttons & Scan to Cloud

» Letter-Size Scan Speed, 300 dpi: 10 sec
» Color Depth: 48-bit Internal/External

» Advanced Z-Lid & Upright Scanning

CAL220 78.95

brother ADS-1500w

Color Image Scanner

» Wi-Fi 1
» 18 ppm -
» 600 x 600 dpi ] g

» Auto Duplex Scanning

» Scan to Mabile Device, Cloud Sites

» Scan Documents up to 8.5 x 34"

» Business Cards, Embossed Plastic Cards

BRADS1500W 269.99

7 Scanjet 63110

Flatbed Scanner

» Batch Scanning

» Scan 3D Items :
» EnergyStar Compliant - —— =y
» 4800 x 9600dpi Resolution

» Scan Photos Slides & Negatives

» Scan Letter Size Documents

» 4 One-touch Scan Buttons

HESJG3110 99.99

96

SCANNERS

EPSON Perfection V850

Pro Scanner

» Scans Prints, Film, and Slides

» Optical Resolution: 6400 dpi

» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Maximum Scanning Area: 8.5x 11.7

» DIGITAL ICE Scratch & Dust Removal

» SilverFast SE Plus 8 & X-Rite i1 Scanner

EPV850 Call or Log-on

Fujitsu ScanSnap iX500
Wireless Desktop Scanner

» Color Scan Speed: 25 ppm

» Create Searchable PDFs

» Maximum Scan Area: 8.5 x 34"

» Optical Resolution: 600 x 600 dpi
» b0-Sheet Automatic Document Feeder

» Scan to Mobile Devices & Cloud Services
» Double-Feed Detection

419.95

FUX500DSW

Canon CanoScan 9000F Mark Il

Film & Document Scanner

» Optical Resolution: 9600dpi

» Optical Resolution: 4800dpi

» Scan Medium Format Film

» Scan 3bmm Negatives & Slides

» Scan Film, Slides, Documents, Photos

» Color Depth: 48/24-Bit Internal/External
» Programmable 1-Touch Scanning Buttons

CACS900FM2S 169.95

brother ImageCenter ADS-2000
High-Speed Document Scanner
» Speed: Z4ppm

» Automatic Duplex Scanning

» Multi-Feed Detection

» Batch Scanning Via 50-Sheet ADF

» Scan Business Cards & ID/Credit Cards
» Optical Resolution: 600 x 600 dpi

» Automatic Blank Page Removal

BRADS2000 299.99

7 Scanjet Enterprise Flow 5000 s2

Document Scanner

» Optical Resolution: 600 dpi

» Daily Duty Cycle: 2,000 Pages

» Letter-Sized Scans at 25 ppm/50 ipm
» b0-Sheet Automatic Document Feeder
» Scan Documents up to 8.5 x 122

» Duplex Scanning

» Scan to Network and Cloud Storage

HESJ5000S2 539.95

EPSON WorkForce DS-510

Color Document Scanner

» Resolution: 600 dpi

» Create Searchable PDFs

» Scan Speed: 26 ppm/52 ipm

» Scan Documents Up to 8.5 x 36"

» Document Feeder: 50 Sheets

» Scan Directly to Cloud Services

» 30 Programmable Scanning Settings

EPDS510

Call or Log-on

Fujitsu fi-7160

Document Scanner

» Duplex Scanning

» Qutput Color Depth of 24-bit

» Optical Resolution: 600 dpi

» Scan Speeds of 60 ppm & 120 ipm

» 80-Sheet Automatic Document Feeder
» Maximum Document Size: 8.5 x 220"
» PaperStream IP and PaperStream Capture

854.00

FUFI7160DS

Canon imageFORMULA DR-C225

Office Document Scanner

» Scan Documents and Cards

» Optical Resolution: 600 dpi

» Scan Speed: 25 ppm /50 ipm
» Color Depth: 24-bit

» Duplex Scanning

» Maximum Scan Area: 8.5 x 14"
» Long Document Mode: 118.1”

CAIFDRC225SC 374.99

plustelc OpticPro A320
Tabloid Flatbed Scanner

» Scan A3 Size Documents

» 1600 dpi Resolution

» Fast Scan Time

» 7 Programmable 1-touch Buttans
» PC and Mac (with limitations) Compatible
» Includes Powerful Software

497.80

PLOPA320

plustelc OpticSlim 1180

Scanner
» Scan Area: 12 x 177

» Optical Resolution: 1200 dpi . )‘
» Daily Duty Cycle: 2,500 Pages =

» Color Scan Speed: 15 Seconds ey

» Grayscale Scan Speed: 9 Seconds

» Color Depth: 48-Bit Internal

» Scan Art, Documents, and Other Items

PLOST180 199.00

800-947-5534 + 212-444-6740




PORTABLE SCANNERS, LABEL PRINTERS & OPTICAL PRINTERS

EPSON' WorkForce DS-30

Portable Scanner

» USB-Powered:
No Qutlet Required

» Scan Embossed
Plastic Cards

» Lightweight Design Ideal For Travel

» Scan Directly To Popular Cloud Services

» Includes OCR Software For Windows/Mac

» Mac & PC Compatible » Includes Travel Case

(EPDS30) S 149.95
< ScanSnap iX100
FU]lTSU Wireless Mobile Scanner

» 600 dpi Optical
Resolution

» Min Document Size: 1x 1"
» Max Document Size: 8.5 x 34"
» Scan Speed: 5.2 Seconds per Page
» Automatic Stitching of Two-Page Spread
» USB Rechargeable Li-lon Battery » Battery Life: 260 Scans
» Dual Scan Mode » USB 2.0 and Wi-Fi Connectivity

(FUIX100WMS) e 190.00

Canon imageFORMULA P-2151l Scan-tini
Personal Document Scanner
» 600 dpi Optical
Resolution
» Color Scan Speed:
10 ppm /20 ipm
» Color Depth: 24-Bit
» Min Document Size: 2.0 x2.8" » Max Document Size: 8.5 x 39.4”
» 20-Sheet Automatic Document Feeder » Duplex Scanning
» Built-In Card Scanner » Power Over USB » USB 3.0 Connectivity

(CAP21511) S 259.99

brother PT-H100
Easy Handheld Label Maker

» Portable, Handheld Design

» Runs On AAA Batteries

» Uses “TZe" Tape Up To 0.5” Wide

» Easy Access To Text Formatting

» Pre-Formatted Label Designs

» Store Up To 9 Labels

» Cable Labeling Feature

» Split-Back Labels For Easy Application

[BRPTH100)

DY IIO Executive Scanner

Business Card Scanner

» Extract Contact Info From Business Cards

» Send Data To Contact
Management Program

» Corrects US Addresses
&IP Codes

(DYEV9) 220.99

www.BandH.com

DYMO LabelWriter 450 Turbo
USB Label Printer

» Thermal Printing Technology
» Prints 71 Labels/Minute Ailid
» Windows & Mac Compatibility (

(DYLWA50T) 78.99
LABELWRITER 450 with Appointment Card, File Folder, Shipping.
and Medium Multipurpose Label Roll (DY1957331)................. 99.99

DYIVIO LabelWriter 4XL
Label Printer

» No Ink or Toner Required
» Labels up to 4”
(10.16cm) Wide
» Windows XP, Vista
and Mac Compatible

P i

239.99

(DYLWAXLB)...

brother PT-D200
Easy-To-Use Label Maker '\

» Quickly Access Fonts, Symbols, Designs
» Preview Label Before Printing
» Print Up To 2 Lines Of Text
» Remembers Up To

30 Label Designs
» Vertical & Mirror Printing
» 8 Fonts, 10 Font Styles, 617 Symbols
» Uses TZe Laminated Tapes Up To 12mm Wide

(BRPTD200) ... 36.99

brother PT-9700PC
Desktop Bar Code Printer

» Prints 360 dpi Text, Graphics, Bar Codes
» High Quality Thermal Transfer Labels
» Fast 3.1 ips Printing

» Prints from Multiple Devices

» Includes PT-Editor Design Software
» Built-In Automatic Cutter
» Mac and Windows Compatible T
» USB and Serial Connectivity » Uses HG and TZ Tapes

(BRPT9700PC)

306.00

EPSON' LabelWorks LW-400
Label Printer

» Print 3/4” Wide Labels
» Print 4 Lines 0f Text
» Wide Variety Of Fonts/Symbols/Frames
» Barcode Printing » Backlit Display
» Shorter Lead Margin
For 60% Less Waste
» Split Back For Easy Peeling
» Quiet Operation » Built-In Memory For Commonly Used Labels

(EPLWA00)..... 36.39

COMPUTERS

Bravo 4100
TECHNOLOGY, INC. CD/DVD Inkjet Printer
» Automatically Prints CDs and DVDs
» Print Only, No Drives
» 100 Disc Capacity
» 4800 dpi Inkjet Printing

Bravo 4100 (PRBA100USI) oo 1,595.00

Bravo SE
TECHNOLOGY, INC. AutoPrinter
» 20-Disc Capacity
» USB 2.0
» 4800dpi
» Prints labels upto
20 discs at a time 5

[PRBSEAP)

Q meromoaros G4

Disc Auto Printer

» 4800 dpi

» HP Ink & Inkjet Technology

» 50 Disc Auto-Feeder

» 3 Discs/Minute

» Label Creation Software
for Windows, Mac

(MIG4AP) ..1,095.00

mcrosoaros PE-Pro Autoprinter
Optical Disc Printer |
» 100-Disc Capacity
» 4800dpi
» USB 2.0
» Mac & Windows
Compatibility

[MIPFP1000) 2,195.00

EPSON Discproducer

Autoprinter

» Windows Compatible

» 100-Disc Capacity

» Print Up to 95 Discs an Hour

» Max Printing Resolution:
1440 x 1440 dpi

» 6 Ink Cartridges with Low-Ink Sensors

» All-In-One Software » USB Interface

» Reliable Media Handling Tech » Compact Rugged Construction

(EPPPT00AP) 1,950.00




COMPUTERS

7 LaserJet ProP1102w
Wireless Laser Printer
» 600 x 600 dpi » 19 ppm
» Wi-Fi. ePrint, AirPrint,
Wireless Direct
» Input Capacity 160 Pages
» 266 MHz Processor Speed
» USB 2.0 & WiFi 802.11b/g
Connectivity

[HEPTTOZW). ... 89,99

) LaserJet Pro M476dw

All-in-One Color Laser Printer

» Print, Scan, Copy, Fax
» Print Resolution: 600 x 600 dpi
» Print Speed: 21 ppm
» Automatic Duplexing
» 800 MHz Processor Speed
» Hi-Speed USB2.0,
Ethernet 10/100Base-TX,
& Wireless 802.11b/g/n

(HEMATODW) ...

brother HL-L23400W

Monochrome Laser Printer
» Max Resolution: 2400 x 600 dpi » Max Document Size: 8.5 x 14

» Print Speed: 27 ppm » First Print Out Speed: 8.5 Seconds
» Automatic Duplex Printing
» One-Line LCD Display

» One-Sheet Manual Bypass

» Monthly Duty Cycle: 10,000 Pages
» USB 2.0 and Wi-Fi Connectivity

» Input Capacity: 260 Sheets
(BRHLL2340DW) 127.99

brother MFC-L2700DW

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax » Print Resolution: 2400 x 600 dpi
» Max Print Size: 8.5x 14" » Print Speed: 27 ppm

» 3b-Sheet ADF & 250-Sheet Input Tray
» Automatic Duplex Printing

» Optical Scan Res.: 2400 x 600 dpi

» Flatbed Max Scan Size: 8.5 x 11.7
» Monthly Duty Cycle: 10,000 Pages
» USB 2.0, Ethernet & Wi-Fi

(BRMFCL2700DW)

Canon imageCLASS MF6160dw

Wireless Monochrome All-in-One
» Print, Scan, Copy, Fax with Auto Duplex » Print Res 600 x 600 dpi

» 35 ppm Simplex, 17 ppm Duplex —

» Input Capacity 300 Sheets ———

» Print and Scan with USB Drive ‘
» Scan Res. 600 x 600 dpi

» Monthly Duty Cycle 50,000 Pages =

» Internal Memory 256 MB _—————
» Ethernet, Wi-Fi, AirPrint, Cloud Print ™ | —
(CAMF6160DW) 339.99

LASER PRINTERS

" LaserJet Pro 400 M&25dn

Multifunction Printer
» Print, Copy, Scan, Fax, Walk-up USB
» Print Resolution: 1,200 x 1,200 dpi
» Print Speed up to 35 ppm
» Monthly Duty Cycle of 50,000 Pages
» 800 MHz Processor Speed
» Hi-Speed USB 2.0, Gigabit Ethernet,

&RJ-11 (1 Fax & 1 Phone only)

(HEM425DN) 339.99

" LaserJet Pro 400 M&51dn

Network Color Laser Printer

» 600 x 600 dpi » 21 ppm
» HP ePrint, Apple AirPrint™
» Automatic Duplex Printing
» 600 MHz Processor Speed
» Hi-Speed USB 2.0 port,
Ethernet 10/100Base-TX

(HEM451DN)

brother HL-3170CDW

Wireless Color Laser Printer

» 600 x 2400 dpi » 23 ppm Black & Color

» Wi-Fi, Ethernet, AirPrint, Cloud Print

» Mabile Device Printing

» Automatic Duplex Printing

» Input Capacity 250 Sheets

» Monthly Duty Cycle
30,000 Pages

» Internal Memory 128 MB

(BRHL3170CDW)

259.99

brother MFC-L8850CDW

Wireless Color All-in-One Laser Printer

» Print, Copy, Scan, Fax » Print Resolution: 2400 x 600 dpi
» Max Print & Scan Size: 8.5 x 14 -
» Print Speed: 32 ppm -

» Auto Duplex for Al Functions !

» Optical Scan Res.: 1200 x 2400 dpi |
» b0-Page Auto Document Feeder !
» Supports Mobile Device Printing

» Wi-Fi 802.11b/g/n, USB 2.0, & Ethernet

(BRMFCL8850CD) 549.00

RICOH Aficio SP 6330N

Network Monochrome Laser Printer

» 1200 x 1200 dpi — -

» 35 ppm

» Ethernet

» Print from USB Drive

» Print Sizes up to 11 x 17
» Input Capacity 600 Sheets

- L))

» Internal Memory 256 MB I [;

» Multiple Security Features : o
(RISP6330N) 729.99

" LaserJet Pro 400 M401n

Network Monochrome Laser Printer

» 1200 x 1200 dpi

» 35 ppm (1S0)

» Ethernet, AirPrint, ePrint

» Manual Duplex Printing

» 800 MHz Processor Speed

» Hi-Speed USB 2.0 &
Gigabit Ethernet

(HEM40IN) 169.99

7 LaserJet Pro M127fn

Monochrome All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution:
600 x 600 dpi

» Print Speeds up
to 21 ppm

» Scan Resolution:
1200 x 1200 dpi

(HECZ181ABG.) 119.99

brother HL-L8350CDW

Wireless Color Laser Printer

» Print Resolution: 2400 x 600 dpi w_,_

» Print Speed: 32 ppm

» Paper Capacity: 300 Sheets

» First Print Out Time: < 15 Sec.

» Automatic Duplex Printing X
» Maximum Print Size: 8.5 x 14

» Front-Access USB Direct Printing

» Wi-Fi 802.11b/g/n, USB 2.0, and Ethernet

(BRHLL8350C0DW) 348.21

brother DCP-L2540DW

All-in-One Monochrome Laser Printer

» Print, Copy, Scan » Print Resolution: 2400 x 600 dpi
» Print Speed: 30 ppm » Automatic Duplex Printing

» Optical Scan Resolution: 600 x 2400 dpi
» Flatbed Scan Size: 8.5x 11.7"

» 35-Sheet Auto Document Feeder
» Input Capacity: 260 Sheets

» Monthly Duty Cycle: 10,000 Pages
» USB 2.0, Ethernet, & Wi-Fi

(BRDCPL2540DW)

WXpress C1860FW
Color All-in-One Laser Printer

» Print, Scan, Capy, Fax » Print Res 9600 x 600 dpi
» Max Print Size: 8.5 x 14"

» Print Speed: 19 ppm

» Optical Scan Res: 1200 x 1200 dpi
» Scan Speed: 20 ipm

» Input Capacity: 261 Sheets

» Duty Cycle: 40,000 Pages

» USB 2.0, Ethernet, & Wi-Fi with NFC

[SAC1860FW) Call or Log-on

800-947-5534 - 212-444-6740




Canon PIXMA MX922
Wireless Color All-in-One Inkjet Office Printer

» Print, Scan, Copy, Fax » 9600 x 2400 Color dpi

» 15 ipm Black, 10 ipm Color » Wi-Fi, Ethernet, AirPrint, Google Cloud

» Print & Scan with Apple, Android Device » Auto []uplex Print, Scan,
Copy, Fax » 2400 x 4800 dpi
Optical Scan Resolution

» ADF for Multipage Scan,
Copy, Fax

» Print on CD, DVD, Blu-ray

(CAMX922)

Somme  gunans
—_

179.99

Officejet Pro 8610

e-All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax
» Print Resolution:
4800 x 1200 dpi
» Printat 19 ppm
Black & 14.5 ppm Color
» Automatic Duplex
Printing

[HEOJP810) 199.99

EPSON' WorkForce WF-3620

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax » Print Resolution: 4,800 x 2,400 dpi
» Monochrome Print Speed: 19 Pages/Minute

» Max Document Size: 8.5 x 14"
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» 250-Sheet Tray

» Wi-Fi & Ethernet Connectivity

(EPWF3620) Call or Log-on

EPSON' WorkForce WF-7110

Wireless Color Inkjet Printer

» PrecisionCore Printhead » Print Resolution: 4,800 x 2,400 dpi
» Monochrome Print Speed: 18 ppm

» Color Print Speed: 10 ppm

» Automatic Duplex Printing

» Max Document Size: 13 x 19"
» Two 250-Sheet Paper Trays

» 2.27 LCD Screen

» Wi-Fi & Ethernet Connectivity

(EPWF7110)

Call or Log-on

brother MFC-J450DW
Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax » 12 ppm Black, 10 ppm Color (ISO)
» 6000 x 1200 dpi » Optical Scan Resolution 1200 x 2400 dpi
» Automatic Duplex Print
» Print & Scan to Cloud,
Mobile Device
» Wi-Fi, AirPrint,
Google Cloud Print
» Scan to Email, OCR

(BRMFCJ4500W) 99.99

www.BandH.com

INKJET PRINTERS

Canon PIXMAMG6620
Wireless Photo All-in-One Inkjet Printer
» Print, Scan, Copy
» Max Resolution:

4800 x 1200 dpi
» Print Speed:

4 x 6" Photo in 44 Sec.
» Borderless Printing

up to 8.5” Wide

(CAMGAB20B) . 136,29

Officejet Pro 8620

e-All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax » Print Resolution: 4800 x 1200 dpi
» Print 21 ppm Black & 16.5 ppm Color
» Copy 14 cpm Black & 13 cpm Color
» Auto Duplex Printing

» 1200 dpi Optical Scan ResRes

» Max. Document Size: 8.5 x 14"

» 802.11 b/g/n Wi-Fi Connectivity

» b0-Sheet ADF & One 250-Sheet Input Tray

(HEQJP8620)

299.99

EPSON' WorkForce WF-3640

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax » Print Resolution: 4,800 x 2,400 dpi
» Monochrome Print Speed: 19 Pages/Minute
» Max Document Size: 8.5 x 14"
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» Two 250-Sheet Trays

» Wi-Fi & Ethernet Connectivity

(EPWF3640)

EPSON WorkForce ET-4550
EcoTank All-in-One Inkjet Printer

» Print, Scan, Copy, Fax » Print Resolution: 4,800 x 1,200 dpi
» EcoTank Refillable Ink Tank System
» Max Print Size: 8.5 x 47.2"

» Speed: 13 ppm Black/7.3 ppm Calor
» Automatic Duplex Printing
» Flatbed Scan Area: 8.5x 11.7"
» 11,000 Black/8,500 Color Pgs
» USB 2.0, Ethernet, & Wi-Fi

(EPC11CE71201)

499.99

brother MFC-J870DW

Work Smart Series All-in-One Inkjet Printer

» Print, Scan, Copy, Fax » Print Resolution: 6000 x 1200 dpi
» Print Speed: 12 ppm Black / 10 ppm Color
» Optical Scan Res: 1200 x 2400 dpi
» Max Document Size:
8.Hx14"
» Duplex and Disc Printing
» USB 2.0, Ethernet,
and Wi-Fi with NFC

(BRMFCJ870DW)

142.00

COMPUTERS

Canon PIXMAMG7720

Wireless All-in-One Inkjet Printer

» Print, Scan, Copy

» Max Resolution: 9600 x 2400 dpi

» Max Printable Area:
8.5x 14"

» Print Speed:15 ipm
Black / 10 ipm Color

Available in Black or White

199.99

(CAMG7720B) .

Officejet Pro X576dw

All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax » HP PageWide Technology
» 50% Lower Usage Cost than Laser Printers » 1200 dpi Scan Res

» 2400 x1200 dpi Color Print Res E
Envy 4500

» Max Document Size: 8.5 x 14
» Print Speed: Up to 42 ppm (IS0)
» Auto Duplex Print, Scan, & Copy
» Print & Scan with USB Drive
» Wi-Fi, USB 2.0 & Ethernet
(HEXS760W).......ococ Call or Log-on

e-All-in-One Wireless Color Inkjet Printer
» Print, Copy, Scan » 4800 x 1200 Optimized dpi
» 8.8 ppm Black, 5.2 ppm Color (1S0)
» Wi-Fi, Ethernet, Mobile Print & Scan
(HEE4500) . ! ..99.99
EPSON Expression Premium XP-820
Small-In-One Inkjet Printer
» Print, Scan, Copy, Fax » Max Resolution: 5760 x 1440 dpi

» Max Print Size: 8.5 x 14" » Auto Duplex Printing & Copying
» Print Speed: 14 ppm Black / 11 ppm Color

» Scan Resolution: 4800 dpi 6

» Five-Color Claria
199.99

Premium Ink Set
» Memory Card Slot & USB Port
» USB 2.0, Ethernet, & Wi-Fi

(EPXP820)

brother MFC-J69200W

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax up to 11 x 17" and Auto Duplex
» Print Res 6000 x 1200 dpi » 22 ppm Black, 20 ppm Color (IS0)

—

» Print & Scan with

USB Drive, Memory Card
» 2400 x 2400 dpi

Optical Scan Resolution
» Wi-Fi, Ethernet,

Mobile Print & Scan

[BRMFCIB920DW) ..o




COMPUTERS

Canon PIXMAPR0-100

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi » Print 8 x 10" in 51 Seconds
» 8 Ink Cartridges Including 3 Monochrome
» Wi-Fi, Ethernet, AirPrint, PictBridge
» Print Sizes up to 13 x 197
» (D, DVD, Blu-ray Printing
» Print Studio Pro for
Photoshop, DPP

(CAPP100) 399.99

Canon PIXMAiP8720

Wireless Inkjet Photo Printer

» Print Resolution: 9600 x 2400 dpi » Up to 13 x 19" Print Size

» 14.5 Black ipm & 10.4 Color ipm » 6-Color Ink System with Gray

» Prints Borderless 4 x 6" Photo in 36 sec

» Can Print on CD, DVD,
and Blu-ray Discs

» Auto Power On
and Off Settings

» Wi-Fi 802.11 b/g/n

(CAIP8720)

EPSON Artisan 1430

Wireless Color Inkjet Printer

» 5760 x 1440 Optimized dpi » 2.8 1S0 ppm Black and Color

» Borderless Prints up to 13 x 19"

» Print from Mobile Device

» Wi-Fi » PictBridge

» Print Directly on
CD&DVD

» Individual Ink
Cartridges

(EPA1430)

EPSON Expression Photo XP-860

Small-In-One Inkjet Printer

» Print, Scan, Copy, Fax » Max Resolution: 5760 x 1440 dpi
» Max Print Size: 8.5x 14" » Six-Color Claria Photo HD Ink Set
» Print Speed: 9.5 ppm Black / 9 ppm Color
» Auto Duplex Printing & Copying
» Scan Resolution: 4800 dpi
» Max Scan Size: 8.5 x 11.7"
» Memory Card Slot & USB Port
» USB 2.0, Ethernet, & Wi-Fi

(EPXP860)

PHOTO PRINTERS

Canon PIXMAPRO-10

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi » Print 8 x 10" in 3 Minutes, 35 Seconds
» Wi-Fi, Ethernet, PictBridge » Print Sizes up to 13 x 19"
» 10 Ink Cartridges Including 3 Monochrome

» CD, DVD, Blu-ray Printing

» Chroma Optimizer
Reduces Branzing

» Print Studio Pro for
Photoshop, DPP

(CAPPIO)............ 699.99

Canon PIXMAiPT7220
Wireless Color Photo Printer
» 9600 x 2400 Color dpi

» 15 ipm Black, 10 ipm Color

» Borderless Photos up to 8.5 x 11"

» Wi-Fi & AirPrint

» Auto Double-Sided Printing
» CD &DVD Printing

» Full HD Movie Print

(CAIP7220)......... 99.99

EPSON' SureColor P600

Inkjet Printer

» Max Resolution: 5760 x 1440 dpi » Max Printable Area: 13 x 129"
» Borderless Prints up to 13 x 19" » Fits Roll Media up to 13" Wide

» 9 UltraChrome HD Pigment-Based Inks
» Auto-Switching Black Ink Technology
» Tilting 3.5” Color Touchscreen
» Advanced Media Handling

and Disc Printing
» USB 2.0, Ethernet, & Wi-Fi

(EPSP60D)........ Call or Log-on

EPSON Stylus Photo R2000

Wireless Color Inkjet Printer

» 5760 x 1440 Optimized dpi » Prints Up to 13x 19", 13" Rolls

» § UltraChrome Hi-Gloss 2 Ink Cartridges

» Media up to 59 mil,
1.5 mm Thick

» CD & DVD Printing

» Ethernet, Wi-Fi,
PictBridge

» Epson Connect Mobile Printing

(EPSPR2000).......

Call or Log-on

Toner for Laser Printers

Ink for InkJet Printers

Canon PIXMAPRO-1

Network Professional Inkjet Photo Printer

» 4800 x 2400 dpi » Print 8 x 10" in 2 Min., 10 Sec.
» Chroma Optimizer Enhances Black Density

» 12 Ink Cartridges Including 5 Monachrome

» No Black Ink Swapping Required

» Ethernet, PictBridge

» Print Sizes up to 13 x 19"

» CD, DVD, Blu-ray Printing

» Easy-Phato Print Pro for Photoshop, DPP

(CAPP1)

Canon PIXMAiP110
Mobile Inkjet Photo Printer
» Max Res: 9600 x 2400 dpi » Max Print Size: 8.5x 23
» Print Speed: 9 ipm Black /5.8 ipm Color
» Borderless 4 x 6" Phato 53 Sec.
» Borderless Printing up to
8.5" Wide » USB 2.0 & Wi-Fi
» Wireless PictBridge &
Mobile Printing
» 50-pg Auto Document Feeder

(CAIPT10)

Canon SELPHY CP910

Wireless Compact Photo Printer

» Dye Sublimation » Resolution: 300 x 300 dpi
» Borderless 4 x 6" Photo in 47 Sec.

» Connect Wi-Fi & Access Point Mode
» Water-Resistant Archival Prints

» Mabile Device Printing

» 2.7" Tilting LCD Display

» Direct Print Capable » SD Card Slot and USB Port
Black (CACP9108) S 85.99
White (CACP910W) e 86.90

EPSON' PictureMate PM-400

Personal Photo Lab

» 5760 x 1440 dpi » Print 4.0 x 6.0” Photo in 36 Seconds
» Print from Memory Cards

» Borderless Prints

» 2.7" Color LCD Preview Display
» Capacity: 50 Sheets Plain Paper
» Support for SD Cards

» USB 2.0 and Wi-Fi Connectivity

By L
P

(EPPM400)

INK, TONER & CARTRIGES

Ink for Large Format Printers

To view a full listing of all
Ink, Toner & Cartriges

or visit our website
BandH.com/w15100

800-947-5534 + 212-444-6740




EPSON' SureColor P800

Inkjet Printer

» Max Resolution: 2880 x 1440 dpi » Max Print Size: 17 x 22" (Sheet Media)
» Print Speed: 8 x 10 in 113 Secondsdpi » Borderless Printing up to 17" Wide
» Epson MicroPiezo AMC Print Head

» 9 UltraChrome HD Pigment-Based Inks

» Auto-Switching Black Ink Technology

» Advanced Black & White Mode

» Optional Adapter for 17" Wide Roll Media
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSCPO0SE)

EPSON Stylus Pro 9900
44” Large Format Inkjet Printer

» Gallery Quality Printing

» UltraChrome HDR Pigment Inks
» 11 Individual Ink Tanks

» Long Life Prints

» Easy-to-Use Menu System

» Network Capable

» Spindle-Free Roll Media Loading
» Rotary Cutting System

(EPSP9900P)

") Designjet T120
24” Color Inkjet ePrinter

» Resolution: 1200 x 1200 dpi

» Print Speed: 40 A1 Prints/Hour

» Ethernet, Wi-Fi, AirPrint, ePrint

» Print Sizes Up To 22x34” (D)

» Roll Printing Up To 24" Wide

» Compatible With Media Up To 280gsm

Canon imagePROGRAF iPF6400
24” Wide Format Inkjet Printer

» Print Resolution: 2400x1200dpi

» Ethernet Connectivity

» Ink: 12-Cartridge Lucia Ex Ink System

» On-The-Fly Ink Replacement

» Plug-In For Photoshop, Digital Phato Pro
» Plug-In For Microsoft Office

» Supports Heavy Media Up To 59 Mil Thick
» Internal Memory: 384 MB

(CAIPF6400)

Call or Log-on

Canon imagePROGRAF iPF8400
44” Large Inkjet Printer

» Resolution: 2400x1200dpi

» Roll & Cut-Sheet Media

» Borderless Printing

» Uses 12 Individual Ink Cartridges
» Print Up To 44.0"%59.0°

» Ethernet Connectivity

» Internal Memory: 384MB

» Hard Disk Capacity: 25068

(CAIPF8400)

Call or Log-on

www.BandH.com

LARGE FORMAT PRINTERS =~ COMPUTERS

EPSON Stylus Pro 4900
Inkjet Printer

» Accepts Media up to 17° / 432mm Wide
» UltraChrome HDR Ink Technology - 11 Inks
» Wide Color Gamut-PreciseColor Technology
» Automatic Black Ink Cartridge Switching

[EPSPAGO0) ..o 1,7199.00

EPSON Stylus Pro 7900
24” Wide Format Inkjet Printer

» Gallery Quality Printing

» UltraChrome HDR Pigment Inks
» 11 Individual Ink Tanks

» Long Life Prints

» Easy-to-Use Menu System

» Network Capable

» Spindle-Free Roll Media Loading
» Rotary Cutting System

(EPSP7900P)

3,995.00

" Designjet 25200
PostScript 44” Printer

» Automatic Calibration & Media Profiling

» Batch Print Files W/o Loading Programs

» Large Print Job Won't Slow Down Computer
» Save Print Jobs For Easy Reprinting

» Large 300 ml Cartridges

» Track Jobs By Customer, Cost, or Job

» Low Supply Alerts, Built-In Reordering

» Consistent & Accurate Color » Built-In PostScript Support

(HEZ5200)

4,495.0

Canon imagePROGRAF iPF760
36” Large Format Inkjet Printer

» Resolution: 2400x1200dpi

» Ethernet Connectivity

» On-The-Fly Ink Replacement

» Print Sizes Up To 36x63”

» Roll Printing Up To 59.0" Long

» Plug-In For Microsoft Office

» Supports Heavy Media Up To 34Mil Thick
» Internal Memory: 384 MB

[CAIPF760)

Canon imagePROGRAF iPF670
24” Large Format Inkjet Printer with Stand

» Max Resolution: 2400 x 1200 dpi » Max Printable Width: 24"
» Print Speed: 23.4 x 33.1" from 28 sec

» High-Density Print Head Technology

» Five-Color Dye/Pigment Reactive Ink Set
» Sub-Ink Tank System

» MS Office Plug-In & AutoCAD Module

» PosterArtist Lite Software

» USB 2.0 and Ethernet Connectivity

[CAIPF470S)

1,595.00
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Photo Paper Plus

Semi-Gloss
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Surface Finishes
Glossy

Instantly recognizable by its reflective, smooth appearance, a glossy
finish is most commonly thought of as the go-to paper for printing
_ photographs. This is due to the paper’s ability
SO o display deep blacks with saturated,
w3 vibrant colors that make images pop. The
coatings used on these kinds of papers
also provide a water resistant quality that
Py can make sure your prints will last for
a years after your make them. Along with
these benefits, glossy papers generally provide a
sharp, crisp image that will benefit phatographs and graphics with
fine details.

Basic Information & Specifications
Weight & Thickness

When looking for paper, basis weight and thickness are related
specifications that tie into a paper’s overall feel and quality. Weight
refers to the heft of a paper and demonstrates a paper’s feel and
strength over time. A heavier paper is less prone to buckling when
hung for long periods of time. Thickness plays a part in this; though
thickness can vary depending on the paper making process. Itis

important to know as not all printers can accept thick fine art paper.

Other Considerations
Opacity

Important for display purposes, opacity tells users how transparent
a sheet of paper or banner material is. This plays a role in deciding
what types of material are best suited to your specific application.
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Introduction to Inkjet Paper

Matte

On the opposite end of the spectrum from glossy, matte papers offer
an appearance that more closely resembles that of traditional art
papers. Many matte papers feature a textured
appearance that can add anather layer of
artistry to your final print. The texture
can be subtle or extremely obvious, as
in the case of mould-made cotton-based
% papers, which allows users to choose
the ideal surface for presenting their

work. Additionally, the matte surface is less
susceptible to showing fingerprints and marks during handling,
making it a somewhat easier paper type to work with.

Materials and Coatings

The material the paper is made of, which could be: wood fiber,
canvas, cotton rag, vinyl, rice, bamboo, or others, plays a large part
in how the printed images will look, due to how it holds the ink and
the physical characteristics of each. In order for these paper types
to be completely compatible with modern inks, a special coating
must be applied to at least one side of the paper. These coatings
can have their own effect on the print as well, giving each combina-
tion a unigue look.

Roll / Sheets

Many papers are found in both sheets and rolls, with each offering
its own benefits. Rolls allow for long panoramas and work wonder-
fully with large format printers for high volume printing. Sheets, on
the other hand, offer convenience for smaller formats.

Luster

Known by names such as satin, semi-matte/gloss, silk, pearl, and
more; luster offers a surface in-between glossy and matte, usually
with a fine tooth and texture, and a slight
, reflective quality. This type of surface gives
the paper an excellent range from white
to black, outstanding color reproduction,
and, depending on the specific paper, the
tooth or texture to further accentuate your
art's content. Luster balances the benefits of
both glossy and matte papers, and as is a very
popular aption for many professional printers.

Brightness, Whiteness, & Tone

These specifications indicate the overall appearance of a paper;
each characteristic will have a significant effect on print quality.
The brightest part of your image is limited by the brightness of the
paper itself, while the overall color and tone is determined by the
whiteness, which is usually listed as a warm (natural), neutral,

or cool color. Additionally, the specifications are generally stated
as percentages; which provides an easy way to compare different
varieties of paper in order to get an idea of how your work will look.

Single / Double-Sided

Due to the necessity of coatings on modern papers, most are not
coated on both sides in order to save an casts. If you require double-
sided printing for a book or other application, you will need to make
sure your selected paper is optimized for two-sided printing.

800-947-5534 + 212-444-6740




B&H’s Excellent Selection

Brands

Epson, Canon, Itford, Hahnemuhle, and more can be found at B&H,
with each brand offering their own unique paper styles, materials,
and technologies. Check back often to find the latest manufacturers
and papers, thanks to our ever-expanding paper stock.

PAPER AND INKJET MEDIA

Selection

Canvas, metallic, cotton rag, vinyl, and more are among the papers
types you'll find at B&H. With practically any type of paper for nearly
any situation, and more and more varieties being added all the time,
we have a vast selection of papers to suit your needs.

COMPUTERS

Sizes

Find everything from your standard 4 x 6" photo paper to large 72"
wide rolls for epic panoramas. Available in sheets and rolls, you can
be assured that no matter how large or small your project is you will
be able to get the paper you need at B&H.

Canon EPsoN Kodak wrorp (/)

S

MUSEO MOAB

CRANEELCD.

HARMAN &

Uses
Fine Art

Designed for archival purposes and display, so
called fine art paper offers classic materials
and coatings that will lend their own qual-
ity to the print. This can include prints of
artwork, phatos, or even important docu-
ments that require the utmost in quality
and preservation. In addition, a variety of

different materials are available to dial in the
exact look required for this demanding application.

Office

Found in practically every workspace and
home, office printing paper is optimized
for documents, bath large and small. It
is generally lightweight, bright white,

and has a coating designed to handle

the speedy inkjet printers available today.
Much of this type of paper is available for
dual-sided printing and can handle everything from
black & white documents to full color images.

ICC Profiles

Even with the best paper in the world, digital printing still relies heavily on computing to turn your digital
images and graphics into physical prints. This is where ICC profiles come in handy. Many manufacturers
offer profiles to download alongside their different papers that will help tell the printer how to manipulate
the ink and colors, so that you will have a final print that Looks as close as possible to the screen that you
are viewing it on. These are optimized for specific printer and paper combinations to ensure you get the

best print possible.

www.BandH.com
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ADVANCED INKJET MEDIA

Canvas

While not a paper, per se, canvas offers

a well-known aesthetic. It lends a
sense of gravitas to your prints and
the ability to display your artwork in a
more creative fashion. Also, recently
developed coatings, such as metallic,

are breathing new Life into this classic

art surface.

Specialty

Users with very specific purposes and
applications require uncommon styles
and types of printing materials to
accomplish their goals. Luckily, B&H
carries many unigue options such as
clear film, adhesive viny, rice paper, and
more that will assist you in getting your
job done. Experimental printers may also want to

venture into this section in order to realize their latest ideas and
projects, or to find inspiration.

& Hahnemihle

cAnson’

Inkjet Media

Photographic Prints

A staple of modern inkjet printing, photographs
are perhaps the most popular reason people
will print at home, and as such, photo-
| graphic paper is one of the widest paper
v selections there is. This includes the vast
array of standard glossy paper most people
are accustomed to, as well as heavyweight
textured papers suitable for gallery exhibitions.
Even people with an affinity for B&W darkroom printing will find
many options that emulate the look and feel of traditional prints.

Proofing

Making sample prints no longer has to cost
anarm and a leg with the availability of
many different proofing papers on the
market today. This lightweight paper
type offers surfaces that are similar to
higher-end papers, in order to provide

a comparably less expensive option for B
performing tests and making changes to see how a

final print will turn out.

N

\
Carolina Cover \

To view a full listing of all

Inkjet Media and Paper

or visit our website BandH.com/w15103




COMPUTERS

APC BES506 Back-UPS 550

8 Outlet Surge Protector & Battery Backup

» Output: 330 W/ 550 VA
» Input: 120V
» & x Battery-Powered,

4 x Surge Protector
» Recharge Time 24 Hours
» 50/60 Hz +/- 3 Hz Qutput Frequency

[APBES506) 59.95

CyberPower CP1000AVRLCD
Intelligent LCD UPS

» 1000VA / 600W Simulated Sine Wave UPS
» 9 Outlets / USB and Serial Ports

» AVR & GreenPower UPS

» EMI/RFIFilters » Audible Alarms

» Multifunction LCD Display

» Low Sound Emission » USB Connectivity
(CYCP1000AVRL)

109.95

CyberPower SE4256
Uninterrupted Power Supply

» & x Battery and Surge Protected Outlets
» 120V AC Nominal Input Voltage
» 50/60 Hz + 3 Hz

» Simulated Sine Wave Form

» 8 Hours Typical Recharge Time
» Integrated Power Switch
(CYSE4256) 44.95

LUXXOR 12-Tablet
Wall/Desk Charging Box

(LULLTMW126) 174.99

APC SurgeArrest

Performance

APC P1IVT3 SurgeArrest

11-Outlet Surge Protector

UNINTERRUPTIBLE POWER SUPPLY (UPS)

ANAPC Pro1500

Power-Saving Back-UPS

» Qutput: 865W/1500VA

» Input: 120V » NEMA b-15R

» bx Battery Backup, bx Surge Protection
» Recharge Time: 8 Hours

» Audio Alarms » RJ-45 Connector

» LCD Status and Control Console

(APBR15006)

173.95

CyberPower (CP1500AVRLCD
Uninterrupted Power Supply

» 1500VA / 900W Simulated Sine Wave UPS
» Line-Interactive Topology

» AVR and GreenPower UPS

» Tower Form Factor

» Integrated Mutti-Function LCD Display

» RJ11/RJA5 and Coax RG6 Protection

(CYCP1500AVRL) 139.95

CyberPower BRG1000AVRLCD Intelligent
LCD Series Uninterrupted Power Supply

» 1000VA/600W Simulate Sine Wave UPS
» Line-Interactive Topology

» Automatic Voltage Regulation (AVR)

» 10 Outlets / USB Port / RJ11 Protection
» Two USB 2.1A/ 5 VDC Charging Ports

» Multifunction LCD Panel

(CYT000AVRLCD)

114.95

MOBILE CHARGING STATIONS

“#'belkin Store & Charge Station

(BETSCSAC) 144.51

POWER STRIPS (W/ DATA PROTECTION)

APC P8T3 SurgeArrest
120V 8-Outlet Surge PDU
Protector

APC Switched Rack

—

APC Smart-UPS

1500VA with LCD

» Qutput: 1000 Watts / 1440 VA

» Input: 120V » 8 x NEMA 5-15R
» § x Battery Powered Outlets

» Recharge Time: 3 Hours

» LCD Status and Console Control
» Audio Alarm » Smart-Slot / USB Connections

(APSMT1500)

459.95

APC Smart-UPS 1500VA 2U
RackMount with LCD

» Output: 1000W/1500VA —— _ e
» Recharge Time: 3 Hours -
» 6x Battery-Powered Outlets

» Input: 120V » 6x NEMA 5-15R

» Audio Alarm » SmartSlot, USB Ports

» Cold Start/Hot Swappable Batteries

[APSMT1500RM2) 599.95

CyberPower CP1500PFCLCD
PFC Sinewave UPS System

» 1500VA / 900W Pure Sine Wave UPS

» 10 Outlets with USB and Serial Ports

» EMI/RFI Filters » Audible Alarms

» Resettable Circuit Breaker

» AVR & GreenPower UPS

» LCD Diagnostic Display

(CYCP1500PFCL)

214.95

@criFFIN Technology PowerDock 5
Charging Station

(GRNA388362) Call or Log-on

#5555 Outlets To Go
Power Strip - 4 Outlets

[APPTIUNT) e 32.95

" velkin Surge Protector
12-Outlet Home/Office

» 12 Outlets » 900 Joule Energy Rating

» § Power Cord » Prevents Voltage

» For Home & Office Use Fluctuations/Surges

» 3780 Joule Energy Rating » 2 USB Ports (1.6 A

» Cord Management Clip

(BESSHOT2) oo 17.99 (BEBV106050CW) ...
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[APPTIVT3).oo 24.95

“# pelkin USB Charging

6-Outlet Surge Protector

[APPBT3)..coc 19.99

‘' velkin  8-Outlet
Home/Office Surge Protector
» 3390 Joule Energy Rating
» 3-Line AC Protection
» 8, 14-Gauge Heavy-Duty

Power Cord

(BET0820008)......cccoccc 14.99

» 1U Rackmount » 8 Qutlets
» 230V Input » 2300VA Load Capacity
(APAPT920) . 421.99

“# belkin Mini Surge Protector
USB Charger

» 2 x USB Charging Ports
» 3x Outlets

» 360° Rotating Plug

» Portable Design

Pvie I
- - -
N —

—_
o1
(23]
=2

(BEBZ1030500T)....oocccc

» |lluminated Power Indicator
» Integrated Circuit Breaker
(MOMPOTGAO0BK) ... 9.49

CyberPower CSHT1208TNC2

Surge Protection

» Home Theater Surge Protection

» 12 Surge
Protected Outlets .

» Built-In Automatic 4
Shutdown .

(CYCSHTIZ08TN) .o 27.99

800-947-5534 + 212-444-6740




Computer Cables

CABLES

COMPUTERS

After countless hours of researching and comparing, you've finally purchased the computer you wanted. Whether it was a laptop or a desktop
computer, you'll want to use the full advantage of all the ports. It can be quite daunting to know which cables to use. For starters, most ports
on your computer will have female connectors. Female connectors are ports that you plug into. Cables will usually have male connectors,
which plug into the female connectors on your computer.

There are also different types of ports. Thunderbolt and USB are used to transfer data while DisplayPort, DVI, and VGA ports are used to output
video to an external display, such as a monitor or an HDTV.

Q

Thunderbolt

Access high-speed peripherals and high-resolution displays via
one simple port and cable that carries both DisplayPort and PCI
Express data. Thunderbolt gives you two channels on the same
connector with 10 Gbps of throughput in both directions. Thun-
derbolt 2.0 pushes that to 20 Gbps by bonding the two channels
together. You also have the bandwidth to daisy-chain multiple
high-speed devices without using a hub or switch. Thunderbolt and
mini DisplayPort share the connector type. Thunderbolt ports are
usually found on Mac computers.

DisplayPort / Mini DisplayPort

DisplayPort and mini DisplayPart are usually found on Mac com-
puters, but can be found on some PC computers as well. Display-
Port is a digital display interface that supports video, audio, and
other forms of data in a single cable. DisplayPort is the older,
bigger version while mini DisplayPort is the smaller version that
shares the same design as Thunderbolt.

PEARSTONE

Authorized
Reseller

UsB

USB stands for Universal Serial Bus and it lives up to its name since
it can be found on practically every modern computer. You'll notice
that USB will usually have a number next to it. This number is the re-
lease name, but can also be associated with the data transfer speed
they support. For example, USB 2.0 supports up to 480 Mbps while
USB 3.0 supports up to b Gbps. USB 3.1 supports up to 10 Ghps.
Most computers use the USB Type-A port while the USB Type-B port
can be found on computer peripherals, such as printers. USB Type-C
is becoming more popular, thanks to its reversible connector.

DVI

DVI stands for Digital Visual Interface. It transmits uncompressed
digital video. The DVI connector is given one of three names, de-
pending on which signal it uses. DVI-I means it integrates both
digital and analog signals into the same connector. DVI-D means
it only supports a digital signal, single or dual link. DVI-A means it
only supports an analog signal.

Comprehensive

A Division of Wl Vcom International Multimedia Corporation
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Hosa Technology
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Ethernet

Most laptops have given up the Ethernet jack in favor of Wi-Fi,
but desktop computers and workstations still embrace the wired
Internet connection. Most computers utilize the RJ-45 LAN jack,
which plugs into your computer and your router. The Ethernet jack
usually supports 10/100 Mbps Fast Ethernet or 10/100/1000 Mbps
Gigabit Ethernet. If you have a 10/100 Mbps Fast Ethernet jack, a
Catb cable should be good enough. Catbe is an enhanced version of
Catb and supports 10/100/1000 Mbps. Cat6 further improves upon
Catbe and supports 10 Gigabit Ethernet in certain cases.

VGA

Known as Video Graphics Array, VGA has been around since the 1980s.
While most computers now use more modern technologies, like HOMI
and DisplayPort, certain laptops still sport the analog interface as
an addition, which is useful for backwards compatible with older
projectors and monitors. VGA is usually seen as a 15-pin connector.
On laptops and smaller devices, a mini-VGA connector can be found.

To view a full listing
of all Computer Cables

or visit our website
BandH.com/w15105






